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P

Preface 

The EnviroLab Forms 3.0 application is next in the series of Thermo Scientific GC-MS 
analytical software.

To suggest changes to documentation or to Help

Complete a brief survey about this document by clicking the link below. 
Thank you in advance for your help.

Related Documentation
The EnviroLab Forms documentation includes Help that you can access from the application 
and also includes the EnviroLab Forms User Guide and three quick reference guides as PDF 
files that you can access from the Start menu.

To view the EnviroLab Forms user guide or quick reference guides

Go to Start > All Programs > Thermo EnviroLab Forms 3.0 > Manuals and choose one 
of the following documents:

– EnviroLab Forms User Guide

– EnviroLab Forms Administrator Quick Reference Guide 

– EnviroLab Forms Production Quick Reference Guide 

– EnviroLab Forms Data Review Quick Reference Guide 

Contents

• Related Documentation

• Special Notices

• System Requirements

• Contacting Us
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Preface
To open EnviroLab Forms Help

From the EnviroLab Forms window, choose Help > EnviroLab Forms Help. 

To find a particular topic, use the Help Contents, Index, or Search panes.

For more information, including upcoming application notes, visit www.thermo.com.

Special Notices
This guide includes the following types of special notices:

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.
vi         EnviroLab Forms  3.0 User Guide Thermo Scientific
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Preface
System Requirements
Your system must meet these minimum requirements.

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. 

To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

To contact Customer Service for ordering information

System Requirements

PC • 2.33 GHz processor dual core with 2 GB RAM
• CD/R-ROM drive
• Video card and monitor capable of 1280 × 1024 resolution (XGA)
• 75 GB available on the C: drive
• NTFS format

Instruments 
(supported or 
required)

Autosamplers:
• Triplus™
• AS3000

GC Devices:
• Focus GC™
• Trace GC Ultra™

GC-MS mass spectrometers

Software • Microsoft™ Windows™ XP Professional SP3
• Microsoft Office 2007 SP2 or Excel™ 2007 SP2
• Microsoft .NET Framework 3.5 SP 1
• Thermo Foundation™ 1.0.1 (available on the Xcalibur 2.1.0 CD)
• Xcalibur™ 2.1 and Xcalibur 2.1.QF 

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
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Preface
To copy manuals from the Internet

Go to mssupport.thermo.com and click Customer Manuals in the left margin of the 
window. 

To suggest changes to documentation or to Help

• Fill out a reader survey online at 
http://www.surveymonkey.com/s.aspx?sm=R7gKOvhLXn3NTkpK2BefHQ_3d_3d.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.
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1

Introduction

This chapter describes the general features of EnviroLab Forms 3.0 quantitative software.

About the EnviroLab Forms Application
The EnviroLab Forms application is next in the series of Thermo Scientific GC-MS analytical 
software. The application focuses on environmental markets, creating the workflows that 
laboratories use.

In a single software package, the EnviroLab Forms application supports a focused workflow 
for specific non-bioanalytical laboratory use, instrument control, and method development 
functionality. The EnviroLab Forms application is the primary application for the ISQ single 
quadrupole and the TSQ Quantum™ XLS triple quadrupole mass spectrometers.

The EnviroLab Forms application can export SRM data in .xml format so that other 
applications can import the files into their databases. 

The EnviroLab Forms application can import the following file types:
• Sample lists in .csv or .xml format
• Processing (.pmd) and instrument (.meth) method files from the Xcalibur data system 
• Compounds from .xml files that use the datastore format
• Batches or methods from the LabForms 2.5 application or later versions

The EnviroLab Forms application checks the accuracy and precision of data against systems 
that have previously been certified against a standard processing program, such as the 
Statistical Analysis System (SAS).

Contents

• About the EnviroLab Forms Application

• EnviroLab Forms Feature Summary

• Reporting Features
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1  Introduction
About the EnviroLab Forms Application
Supported File Types

The EnviroLab Forms application supports the following file types:

• Comma-separated values (.csv): A textual representation of value fields that are denoted as 
separated from a stream of alpha-numeric values that may be associated by a comma.

• Extensible Markup Language (.xml): A generic framework for storing any amount of text 
or any data whose structure can be represented as a tree. The only indispensable 
syntactical requirement is that the document has exactly one root element (also called the 
document element). This means that the text must be enclosed between a root start-tag 
and a corresponding end-tag.

• Instrument method (.meth): A proprietary file format for the Xcalibur software suite that 
contains specific instructions that let connected scientific instruments perform data 
acquisition.

• Processing method (.pmd): A proprietary file format for the Xcalibur software suite with 
specific instructions about how to process data that was acquired through the instruments 
attached to the system.

• Raw data (.raw): A file type used for acquired samples on the system.

EnviroLab Forms Directory Structure

The EnviroLab Forms application creates folders for projects/subprojects/batches, and 
templates in the ..\Thermo\EnviroLab Forms directory. Within each batch folder, the 
application creates folders for data, methods, and reports.

IMPORTANT  You cannot rename or move the folders created by the EnviroLab Forms 
application.
2         EnviroLab Forms 3.0 User Guide Thermo Scientific



 1  Introduction
EnviroLab Forms Feature Summary
EnviroLab Forms Feature Summary
The EnviroLab Forms system provides a workflow-oriented approach to high-throughput 
quantitation. The system uses a batch-centric approach and tools to automate and speed up 
the processes of method creation, loading samples, automatically generating data, manually 
reviewing and editing results, and finalizing the data review and reporting process. 

The EnviroLab Forms software package includes data acquisition, processing, reviewing, and 
reporting capabilities designed to assist analysts in environmental and food safety applications. 
The application has a fully automated acquisition mode and a manual review mode.  You can 
use the data acquisition system to create and submit batches and monitor real-time review of 
results. 

The EnviroLab Forms application uses a comprehensive processing method to provide 
improved handling of ion ratio calculations, reviewing, and reporting. In addition, the 
application provides a mass spectral comparison capability and an integrated connection 
between the processes of data review and reporting. 

Key features include the following: 

• Role-based authorization for Manager, IT Administrator, Supervisor, Technician, and 
QAQC (quality assurance) roles

• Configuration mode with user administration, project administration, datastore 
administration, and application administration

• Method Development mode with instrument method editor, processing parameters, 
QAQC parameters, and reporting options

• Production mode with batch views, data review, local method views, and report views

• Database-capable method development

• Quantification workflows, supporting capabilities present in the LCquan and LabForms 
2.5 applications

• Customized report formats

Features of the common workflow core include the following:

• Acquisition and processing

• Peak detection

• Quantification to include calibration

• QAQC analysis and flag setting

• Reporting

• Data persistence

• Raw data file handling
Thermo Scientific EnviroLab Forms  3.0 User Guide         3



1  Introduction
Reporting Features
Reporting Features
The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The EnviroLab Forms application can produce both standard reports and custom 
reports. The following types of reports meet the requirements of various methods and 
worldwide regulatory agencies and are designed to help track the performance of the GC 
system and method. The reports are divided into two groups: Standard and Custom.

Standard Report Types
• Batch Report 
• Blank Report 
• Breakdown Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Confirmation Report 
• Confirmation Report  2
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2  Long 
• High Density Sample Report 3 
• High Density Sample Report 3  Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report 
• Manual Integration Report 
• Method Detection Limit Report 
• Method Report 
• Method Validation Report
• MSMSD Report 
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report 
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 
• Tune Report

Example PDFs of standard report formats are located in the following folder:

C:\Thermo\Shared\ExampleReports
4         EnviroLab Forms 3.0 User Guide Thermo Scientific



 1  Introduction
Reporting Features
Custom Report Types
• AltCalibrationReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• DCCReport
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long
• HighDensitySampleReport4
• HighDensitySampleReport5
• QuantitationReport

For additional information about custom and standard reports and a sample of each standard 
report type, see “Reports” on page 261.
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2

Getting Started

This chapter describes the basic EnviroLab Forms workflow and the procedures for getting 
started with the EnviroLab Forms application.

EnviroLab Forms Workflow
The EnviroLab Forms application is structured with a typical laboratory workflow in 
mind—the user creates a batch and the system injects samples into the instrument, runs the 
samples, analyzes the data, and generates a report. You can set up a master method for specific 
compound groups or assays you expect to run in your lab. When you are ready to run a 
particular type of sample, select the appropriate method and you are ready to start. 

When using the EnviroLab Forms application, follow these basic steps:

1. Create and save a master method in the Method Development mode. 

A master method combines the instrument method and processing method that define 
how the raw data is acquired and processed, how the QAQC information evaluates the 
results, and how the results appear in reports. 

2. Create and submit a batch in the Production mode. 

A batch lists samples for processing and reporting using a specified method. Each row of a 
batch represents a unique sample. 

3. Monitor the status of the batch in the Real Time Status view. 

The real-time display is visible from the dashboard and all the EnviroLab Forms modes. 
You can begin another batch while you watch the real-time display of the currently 
acquiring batch.

Contents

• EnviroLab Forms Workflow

• Installing the EnviroLab Forms Application

• Installing the QED and NIST Libraries

• Choosing a Mode
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4. Evaluate the data in the Production mode. 

The Production mode includes views where you can review batches, batch data, reports, 
and local methods.

5. View and print reports in the Report View of the Production mode. 

Use the Report View to view or print the reports for the currently selected batch.

Installing the EnviroLab Forms Application
Follow these instructions to install, start, and log on to the EnviroLab Forms application.

To install the EnviroLab Forms application

1. Follow the instructions on the included CDs to install the Xcalibur 2.1 data system and 
your instrument drivers.

2. Install the driver for your GC device and autosampler.

3. Insert the EnviroLab Forms 3.0 CD in the drive, and follow the on-screen instructions.

If the install windows do not automatically open, navigate to the Xinstall.exe file and 
launch it.

To start the EnviroLab Forms application

1. Configure your instruments.

You cannot configure your instruments while the EnviroLab Forms application is 
running.

2. Double-click the EnviroLab Forms 3.0 application icon on your desktop, or go to Start > 
All Programs > Thermo EnviroLab Forms 3.0 > Thermo EnviroLab Forms 3.0. 

By default, user security is not enabled and the application does not require a password. 
To enable user security, follow the instructions “To enable user security” on page 36.

IMPORTANT  If you are the administrator logging on for the first time with user 
security enabled, use Administrator/Password as the username/password. 

To log on to the EnviroLab Forms application (when user security is enabled)

1. Enter your assigned user name.

Before you can log on to the EnviroLab Forms application, a system administrator must 
set up a user account for you. The administrator assigns you a user name and password 
and gives you permission to access specific modes. 
8         EnviroLab Forms 3.0 User Guide Thermo Scientific



 2  Getting Started
Installing the EnviroLab Forms Application
2. Enter your password.

If your user name and password do not match, the system reports this error:

Correct the user name or password, or contact your system administrator.

3. Click Login.

The EnviroLab Forms dashboard opens. See “EnviroLab Forms Dashboard” on page 14. 

4. To exit the EnviroLab Forms application without logging on, click Exit EnviroLab 
Forms.

IMPORTANT  If you are the administrator logging on with user security enabled, use 
Administrator/Password as the username/password. 

Figure 1. EnviroLab Forms logon screen

Table 1. Logon screen parameters

Parameter Description

Username The user’s assigned user name.

Password The assigned password for the user name.

Login Verifies the user name and password, and displays the dashboard.

Exit EnviroLab Forms Quits the EnviroLab Forms application.
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Installing the QED and NIST Libraries
When you are using triple quad instruments, follow these instructions to install the NIST and 
QED libraries.

To install the NIST library

1. Launch the XInstall executable file.

2. Click the NIST button.

The NIST 08 MS Search and AMDIS Setup wizard opens.

3. Follow the instructions in the setup wizard.

4. When the wizard prompts you to select a program folder, select C:\Thermo.

To install the QED library

1. On your desktop, double-click the Xcalibur icon, .

The Thermo Xcalibur Roadmap opens.
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2. Select Tools > Library Manager.

The Thermo Library Manager dialog box opens. The NIST library is displayed in the 
NIST Libraries list.

3. Click Add.

The Add Library dialog box opens.

4. Click Browse, and locate your QED library in the C:\Thermo folder.

5. Click OK.

The Xcalibur application reports that it has added the library to the NIST software.

6. Click Dismiss to close the message box.

The application adds the QED library to the NIST Libraries list in the Library Manager 
dialog box.
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7. Click Exit in the Thermo Library Manager dialog box.

8. Start the EnviroLab Forms application.

9. Go to the Method Development mode.

10. Click Method View in the navigation pane.

11. Choose File > New > Method template from the main menu.

The QED NIST Library is listed in the Use These Libraries list on the Method Template 
Editor.

Choosing a Mode
When user security is enabled, the dashboard provides the current user with options 
applicable to the role assigned to that user. The following table shows the available modes for 
each user role.
 

Table 2. User roles and permissions

User role Method 
Development Production Configuration

Manager × × ×
IT Administrator ×
Supervisor × ×
Technician ×
QAQC ×

Note  When user security is not enabled, all modes are available to all users.
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To choose a mode

1. From the dashboard, click the mode in which you want to work.

Your dashboard shows only the modes that you have permission to use. See “EnviroLab 
Forms Dashboard” on page 14. 

2. To change modes from within any of the EnviroLab Forms application modes, click a 
mode button in the lower left corner of the window.

To watch the real-time display from the dashboard

Click Real Time Status.

The real-time status is displayed at the bottom of the dashboard.

For descriptions of all the features of the real-time display, see “Real-time Display” on 
page 185. 
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EnviroLab Forms Dashboard

A dashboard for a Manager, who has permission for all modes, looks like this:

Table 3. EnviroLab Forms dashboard parameters  

Parameter Description

Real Time Status Opens the real-time display for the current acquisition. The 
acquisition progress is displayed within the current mode window. 

Help Opens the EnviroLab Forms Help.

Log Off Logs off the current user and displays the logon screen. This 
function is available only when user security is enabled. See 
“Specifying the General Configuration” on page 35.

Production Opens the Production mode where you can create and review 
batches, batch data, reports, and local methods. See “Using the 
Production Mode” on page 169.

Method Development Opens the Method Development mode where you can create a 
master method, an instrument method, or a development batch. 
See “Using the Method Development Mode” on page 47.

Configuration Opens the Configuration mode where you can set permissions, 
assign users to roles, configure available reports and import new 
reports, and maintain the various databases, including the 
Compound Datastore. See “Using the Configuration Mode” on 
page 15.
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This chapter discusses the configuration tasks assigned to the IT Administrator and Manager 
roles.

If your role is that of an IT Administrator or Manager, you are responsible for the following:

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

• Creating projects and subprojects

• Maintaining compounds in the compounds datastore

To access the Configuration mode

Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens.

Contents

• User Administration

• Project Administration

• Compound Datastore

• Application Configuration
Thermo Scientific EnviroLab Forms 3.0 User Guide         15



3  Using the Configuration Mode
Figure 2. Configuration navigation pane

Table 4.  Configuration navigation pane functions  (Sheet 1 of 2)

Function Description

User Administration Opens the User Administration view where you can add, 
remove, or edit user accounts and permissions. See “User 
Administration” on page 18.

This task pane is available only when you have selected Enable 
User Security on the General page of the Application 
Configuration view. See “Application Configuration” on 
page 35.

Project Administration Opens the Project Administration view where you can create 
and manage projects and subprojects. See “Project 
Administration” on page 26.
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Compound Datastore Opens the Compound Datastore view where you can manage 
the definition of compounds in the current datastore. See 
“Compound Datastore” on page 28. 

This task pane is available only when you have selected Enable 
Compound Datastore on the General page of the Application 
Configuration view. See “Application Configuration” on 
page 35.

Application Configuration Opens the Application Configuration view where you can 
specify a compound datastore to use for the gas 
chromatography technology and specify defaults to use for 
laboratory name, instrument name, and mass precision. See 
“Application Configuration” on page 35. 

Table 4.  Configuration navigation pane functions  (Sheet 2 of 2)

Function Description
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User Administration
In the User Administration view of the Configuration mode, in the role of Manager or IT 
Administrator, you can add, remove, or edit user accounts and permissions. 

For detailed descriptions of each user role and the permissions and responsibilities for each 
role, see “User Roles” on page 23.

Follow these procedures:

• To open the User Administration view

• To add a user

• To edit user information

• To remove a user

To open the User Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

Note  The User Administration view is available only when you enable user security. 
Follow the instructions “To enable user security” on page 36.

2. Click the User Administration task pane.

The User Administration view opens. See “User Administration view” on page 21.

To add a user

1. Click the Add User icon, .

The parameters in the User area at the bottom of the view are enabled. 

2. Enter a unique name in the Username field.
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3. Select a role from the Role list.

All users must be assigned to one of these defined roles. For detailed information about 
the permissions allowed for each role, see “User Roles” on page 23.

4. Enter the user’s password.

There is no confirmation for the encrypted password you enter, so carefully type it and 
make sure to communicate it to the user.

5. (Optional) Enter the user’s full name, account number, phone number, and E-mail 
address.

6. To enable this user logon, select the Enabled check box.

You can disable a user logon without deleting the user’s information. Follow the 
instructions “To edit user information” on page 19. 

7. Do one of the following:

• When all the user information is correct, click the Save Changes icon, .

The EnviroLab Forms application adds the new user to the User Listing table, and 
the parameters in the User area are unavailable.

–Or–

• To discard all information and not create a new user from the parameter values  
 
you entered, click the Cancel Changes icon, .

All information is discarded and the parameters in the User area are unavailable. 

To edit user information

1. In the User Listing table, select a user.

Note  Clicking anywhere in the row selects the user.

The user information populates the parameter fields in the User area. 

2. Click the Edit User icon, .
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The parameters in the User area are enabled.

3. Edit any of the parameter values.

If you are editing your own user name, the Enabled check box is unavailable because you 
cannot make your own account unavailable.

4. Do one of the following:

• When all the user information is correct, click the Save Changes icon, .

The EnviroLab Forms application adds the new parameter values to the User Listing, 
and the parameters in the User area are unavailable.

– Or–

• To discard all changes and not save the edits, click the Cancel Changes icon, .

All changes are discarded, and the parameters in the User area are unavailable.

To remove a user

1. In the User Listing table, select a user.

Note  Clicking anywhere in the row selects the user.

The user information populates the parameter fields in the User area.

2. Click the Remove User icon, .

If you select your current user name, the Remove User icon is unavailable. You cannot 
remove yourself.

3. When prompted, confirm that you want to remove this user. 

If the user is currently logged on to the EnviroLab Forms application, the user’s current 
session is not affected.

4. Click OK.

Note  Rather than completely removing the user, you can disable a user logon without 
removing all the user information from the system. Follow the instructions “To edit user 
information” on page 19. 
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Figure 3. User Administration view

Table 5. User Administration parameters  (Sheet 1 of 2)

Parameter Description

Security Groups
All permission levels defined in the EnviroLab Forms 
application. For detailed descriptions of user permissions, see 
“User Roles” on page 23.

User Listing

Username User logon names.

Role The security group that defines user permissions.

Account Number User account numbers.

Phone Number User telephone numbers.

Email Address User e-mail addresses.

Enabled Available or unavailable status for the user account.

User

Username Logon name for this user.

Role Security group that defines this user’s permissions.

Password Logon password for this user.

Full name The user’s actual name.

Account number Optional account number for this user.
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Phone number Optional telephone number for this user.

Email address E-mail address for this user. Used to notify user of a randomly 
generated password.

Enabled Allows or disallows access for this user. When this user is 
currently logged on, disallowing takes effect after the user logs 
off.

Icon            Function

      Add user Enables the fields in the User area where you can enter 
information for a new user.

      Remove user Deletes all information for the selected user.

      Edit user Enables the User area where you can edit any of the parameters 
for the selected user.

      Save changes Adds the new parameter values to the User Listing table and 
disables the parameters in the User area.

      Cancel changes Discards all new or edited information.

Table 5. User Administration parameters  (Sheet 2 of 2)

Parameter Description
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User Roles 
This section describes the responsibilities for five different types of users: Manager, IT 
Administrator, Supervisor, Technician, and QAQC.

User Permissions

A Manager or an IT Administrator assigns you to a role that gives you permission to access 
specific modes of the EnviroLab Forms application. When you log on, the dashboard displays 
links to only the modes that you can access.
 

Manager

As a user in the role of Manager, you review graphically applicable data and manipulate data, 
batches, methods, and instruments. 

A manager is responsible for these tasks:

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Running samples and reviewing data collected by others

• Reporting the data

• Understanding the results and giving final approval of the released data before archiving

IT Administrator

As a user in the role of IT Administrator, you set security, manage users into roles, and 
manipulate the various databases. You are responsible for adding compounds into the various 
compound databases. 

An IT administrator is responsible for these tasks: 

• Handling the databases

• Applying roles to users

• Understanding security, users, and groups

• Creating local users and network groups

Table 6. User roles and permissions

User role Method 
Development Production Configuration

Manager × × ×

IT Administrator ×

Supervisor × ×

Technician ×

QAQC ×
Thermo Scientific EnviroLab Forms 3.0 User Guide         23



3  Using the Configuration Mode
User Administration
Supervisor

As a user in the role of Supervisor, you are responsible for putting samples on the instrument 
and using previously built sequences and methods for processing and acquiring data. You also 
develop and edit methods for processing and acquiring data, review the data, and distinguish 
between the need to rerun samples or pass reports up to the lab manager or QAQC technician 
for final review. On a daily basis, you establish the priority for a list of samples to run and 
create the sequence of events.

A supervisor is responsible for these tasks: 

• Submitting samples 

• Creating and submitting batches

• Reporting the data to management

• Creating or editing methods for new levels of detection or adding new compounds to the 
existing database

• Reviewing data from the mass spectrometer

• Understanding the results, who ran the batch, and who passed along the results before 
giving intermediate approval and sending the data to management

• Modifying new compounds or adjusting methods for specific result sets

Technician

As a user in the role of Technician, you are responsible for putting samples on the instrument 
and using previously built sequences and methods for processing and acquiring data. You also 
edit existing methods for processing and acquiring data and are responsible for reviewing 
collected data and distinguishing between the need to rerun samples or pass reports up to the 
supervisor. On a daily basis, you are responsible for gathering the list of samples to run and 
creating the sequence of events. 

A technician is responsible for these tasks:

• Submitting samples 

• Creating and submitting batches

• Creating data to be reviewed by management

• Receiving instructions for new sets of samples for the EnviroLab Forms application to 
analyze after finishing the current analysis

• Reviewing data from the mass spectrometer

• Understanding the resulting data, making integration changes, and passing those changes 
up for further approval.
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QAQC

As a user in the role of a QAQC technician, you review graphically applicable data and 
interpret the data, but you do not manipulate the data.

A QAQC user is responsible for these tasks: 

• Reviewing data from the mass spectrometer

• Understanding the results and who ran and passed along the results before giving 
intermediate approval and sending the data to management

• Receiving instructions for new sets of samples for the EnviroLab Forms application to 
analyze after finishing the current analysis

Note  A user in the role of a QAQC technician cannot submit batches for acquisition from 
the Production mode.
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In the role of Manager or IT Administrator, you can create and manage projects and 
subprojects in the Project Administration view of the Configuration mode.

Follow these procedures:

• To open the Project Administration view

• To create projects or subprojects

• To delete projects or subprojects

To open the Project Administration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. In the Configuration navigation pane, click Project Administration.

The Project Administration view opens.

All projects are created under a main Projects folder on the C: drive:

C:\Thermo\EnviroLab Forms\Projects
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To create projects or subprojects

1. Select the top-level project.

You can select the main Projects folder and create a new project under it, or you can select 
one of your existing projects and create a subproject under it.

When you select a project folder, the application enables the plus sign icon, , 
indicating that you can create a folder within the selected folder.

2. Click the plus sign.

The EnviroLab Forms application creates a new, unnamed project folder under the 
selected project.

3. While the new project is still highlighted, type a new name.

Project names can contain spaces and special characters, except for the following special 
characters: \ / : * ? “ < > |

Note  After you add a subproject to a project, you cannot rename the project.

4. To save the new name, press ENTER or click anywhere in the view.

To delete projects or subprojects

1. Select the project or subproject you want to delete.

You can delete any project that contains no subprojects. You can delete any subproject 
that contains no batches. When the selected project or subproject is available for deletion, 
the application enables the minus sign icon, . 

2. Click the minus sign, or right-click and choose Remove Project or Remove Subproject 
from the shortcut menu.

3. At the prompt, click Yes to remove the selected project or subproject.
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Compound Datastore
In the role of Manager or IT Administrator, you can manage compounds definitions in the 
current datastore in the Compound Datastore view of the Configuration mode.

The current default datastore is the datastore specified for the current technology in the 
Application Configuration view. See “Application Configuration” on page 35.

Follow these procedures:

• To open the Compound Datastore editor

• To open a compound datastore

• To create a new compound datastore

• To import compounds

• To add a single compound

• To save a datastore

• To save a datastore to a new name

• To remove a compound or a compound’s transition information

• To filter the compound list

To open the Compound Datastore editor

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click the Compound Datastore task pane.

The current datastore opens in the Compound Datastore view.
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To open a compound datastore

1. Click Load Compound Datastore in the Compound Datastore task pane. 

The Open Compound Datastore dialog box opens.

2. To expand the folder, click the plus sign before the folder name.

3. Double-click the name of the datastore you want to open.

The selected datastore opens in the Compound Datastore view. See “Compound 
Datastore view” on page 33.

To create a new compound datastore

Click New Compound Datastore in the Compound Datastore task pane.

A new, empty datastore opens in the Compound Datastore view. You can import a file of 
compounds into the new datastore (following the instructions, To import compounds), 
or you can manually add compounds one at a time (following the instructions, To add a 
single compound).

To import compounds

1. Click Import Compounds in the Compound Datastore task pane.

2. Browse to a .csv or .xml compounds file and click Open.

The EnviroLab Forms application imports the compounds from the imported file, adds 
them to any compounds already in the datastore, and alphabetically sorts them.
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When the application imports a compound that contains multiple quan peaks, it lists all 
the peaks under a single compound name, as in this example for Cocaine:

To add a single compound

1. To add a single compound to the datastore, click the Add Compound icon, ,  
or right-click the compounds list and choose Add Compound from the shortcut menu.

A new empty compound row is added to the bottom of the compounds table. 

2. Click the first table cell, and enter the required Compound Name parameter.

3. (Optional) Enter values for the Category, Ionization, or Chemical Formula columns. 

4. To add a transition to the compound, do the following:

a. Select the compound.

b. Click the Add Transition Information icon, , or right-click and choose Add 
Transition Information from the shortcut menu. 

A new empty transition row is added to the compound. A transition includes quantitative 
values for the compound. Each compound requires at least one transition.
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5. Enter all required parameters. 

For a list of required and optional parameters, see the list of “Compound Datastore 
parameters” on page 33.

Tip  You cannot add another new compound or save the compound datastore until 
you enter all required transition parameters or remove the transition from the 
compound. To remove a transition, right-click the row and choose Cancel.

6. To save the new datastore, click Save Compound Datastore in the Compound Datastore 
task pane.

To save a datastore

1. Click Save Compound Datastore in the Compound Datastore task pane.

The database is stored as

..\Thermo\EnviroLab Forms\Databases\foldername\filename.xml

If the datastore contains any compounds that do not have an associated transition, the 
Compounds That are Missing Quans dialog box opens, listing the compounds.

2. Do one of the following:

• To remove the listed compounds from the datastore and save the datastore, click 
Continue.

–Or–

• To keep the listed compounds and return to the datastore, click Cancel.

Note  You cannot save a compound that does not have an associated transition.

To save a datastore to a new name

1. Click Save As Compound Datastore in the Compound Datastore task pane.

The Save Compound Datastore dialog box opens. See “Save Compound Datastore dialog 
box” on page 32.

2. Enter a file name for the new compound datastore.
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3. (Optional) Click Add Folder and enter the name for a new folder to be created in the 
..\Thermo\EnviroLab Forms\Databases folder.

4. Click Save.

The database is stored as

..\Thermo\EnviroLab Forms\Databases\foldername\filename.xml

Figure 4. Save Compound Datastore dialog box

To remove a compound or a compound’s transition information

1. In the Compound Datastore view, select the row you want to delete.

You can remove either of the following:

• An entire compound, including all associated transition information

• A row of transition information

2. Click the Remove Transition icon, , or right-click and choose Remove Transition 
from the shortcut menu.

3. If you are sure you want to delete the selected row, at the prompt, click Yes .

The selected row and all items within it are deleted.

Tip  If you add a row of compound or transition information and do not complete all 
the required values, you can right-click and choose Cancel to remove the entire row. 
You can cancel only incomplete compound or transition rows. 

Table 7. Select Compound Datastore parameters

Parameter Description

Compounds Lists the datastores you have created for this technology.

Default The default datastore defined for this technology.

File Name File name for the new datastore.

Save Writes the new datastore to the specified folder.

Add Folder Adds a new folder where you can save the datastore.

Cancel Closes the dialog box and makes no changes to the datastore.
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To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

For each column, filterable criteria is displayed in a list. In all lists, you can choose to filter 
by All, Blanks, NonBlanks, or by custom filter criteria. Other filter criteria are specific to 
the individual columns.

2. To create a custom filter based on column values, choose Custom from the list.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.”  

Figure 5. Compound Datastore view

 

Table 8. Compound Datastore parameters  (Sheet 1 of 2)

Parameter Description

Function icons

  Adds a compound transition to the datastore. 

 Adds a quantitation items row to the selected compound 
transition, or adds a confirming items row to the selected 
quantitation item. 

 Deletes the selected compound transition. 

Compound parameters

Compound Name Alphanumeric name assigned to the compound.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier.  
Valid values: ESI, APCI, EI, CI, APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.
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Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the 
center of a target precursor-ion peak in mass-to-charge ratio 
(m/z) units.  
Default: 0.0 
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the 
center of a target quan-ion peak in mass-to-charge ratio (m/z) 
units.  
Default: 0.0 
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas.  
Range: –250.00 to 250.00

Lens (Optional) Range: –400 to 400

Polarity + (positive) or –(negative)

RT (min) Retention time. The application uses RT and Window values to 
determine the start and stop time for the acquisition.  
Range: 0.00 to 999.00 
Start time = RT – (Window/2) 
Stop time = RT + (Window/2) 
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. The application uses RT and Window 
values to determine the start and stop time for the acquisition.  
Range: 0.00 to 499.50 
Start time = RT – (Window/2) 
Stop time = RT + (Window/2) 
Start and stop range: 0.00 to 999.00

Energy Ramp (Optional)  
Range: 0.00 to 200.00

Color coding • Blue indicates a compound.
• Yellow indicates a quantitative transition.
• Green indicates a confirming transition.
• Pink fields are editable when you import new transitions 

into the datastore from the method editor.

Table 8. Compound Datastore parameters  (Sheet 2 of 2)

Parameter Description
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This section includes instructions for the following groups of tasks:

• Specifying the General Configuration

• Specifying the Reports Configuration

Specifying the General Configuration

In the role of Manager or IT Administrator, you can specify a default compound datastore 
and specify defaults to use for laboratory name, instrument name, and mass precision in the 
Application Configuration view of the Configuration mode. 

Follow these procedures:

• To open the General page of the Application Configuration view

• To enable user security

• To specify a datastore to use in method development

• To specify a default laboratory name, instrument name, and mass precision

• To specify a default chromatogram intensity display

To open the General page of the Application Configuration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click Application Configuration.

The General page of the Application Configuration view opens. See “General page” on 
page 38.
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To enable user security

In the User Security area, select the Enable User Security check box.

When checked, all users are required to log on to the EnviroLab Forms application and 
have access to only those modes assigned to their user role. See “User Roles” on page 23.

When cleared, users are not required to log on to the EnviroLab Forms application. 
When they start the application, the dashboard is the first screen the users see and all 
modes are available to them. However, the User Administration view in Configuration 
mode is hidden and cannot be edited. 

IMPORTANT  If you are the administrator logging on with user security enabled, use 
Administrator/Password as the username/password. Immediately create an account 
with Manager or IT Administrator permissions for yourself. 

Note  By default, user security is not enabled. 

To specify a datastore to use in method development

1. In the Compound Datastore Selection area, select the Enable Compound Datastore 
check box.

Note  By default, the Enable Compound Datastore option is not selected.

2. Click Select.

The Select Compound Datastore dialog box opens.

3. Select a compound datastore from the list.

4. Do one of the following:

• To use the selected datastore for all methods, click Select.

–Or–

• To close the Select Compound Datastore dialog box and keep the currently specified 
datastore, click Cancel.

5. In the Application Configuration view, click Apply.
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6. When you are prompted to restart your application, click Yes.

When the application restarts, the following changes are implemented:

• The application displays the Acquisition List page on the Compounds page in the 
Master Method View. See “Editing the Compounds Page” on page 77.

• The application displays the Compound Datastore task pane on the Configuration 
mode navigation pane. See “Compound Datastore” on page 28.

• The application enables the Export SRM Data command in the Method 
Development mode. See “Exporting SRM Data” on page 156.

To specify a default laboratory name, instrument name, and mass precision

1. In the Defaults area, type the name of your laboratory in the Lab Name box.

When you create a method, this default laboratory name is used for the Laboratory Name 
value on the General page of the Master Method View. This laboratory name is also used 
in the headings of reports.

Note  This default laboratory name is not applied to previously created methods. By 
default, the laboratory name is ThermoFisher Laboratory.

2. In the Defaults area, type the name of your instrument in the Instrument Name box.

When you create a batch, this default instrument name is used for the Instrument Name 
value. This instrument name is also used in the headings of reports.

Note  This default instrument name is not applied to previously created batches. By 
default, the instrument name is ThermoFisher Instrument.

3. In the Defaults area, in the Display Mass Precision box, set the mass precision decimal 
places value to an integer from 0 through 5.

The default mass precision is 2. The EnviroLab Forms application uses this mass 
precision value in the following locations:

• Reports:
– Confirmation report (data spectra, library spectra, quan ion display, and qual ion 

display)
– High Density reports (m/z values)
– Ion Ratio Failure Report (quan ion and qual ion)
– Manual Integration Report (m/z value)
– Quantitation Report (QIon)

• All peaks on the Detection pages in the Method Development mode

• The spectrum display in the Data Review view in the Production mode

• The spectrum display in the Method Forge dialog box

4. In the Application Configuration view, click Apply. 
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To specify a default chromatogram intensity display

In the Defaults area, select Relative or Absolute from the Chromatogram Intensity Scale 
list.

This sets the default display type for both quan and qual chromatograms displayed in 
data review and reports. 

Figure 6. General page

Table 9. General configuration parameters  (Sheet 1 of 2)

Parameter Description

User Security Enables application level security.

Technology selection Defaults to Gas Chromatography (GC).
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Compound Datastore 
selection

Enable compound datastore: Enables the Acquisition List page 
on the Compounds page in the Master Method View and 
displays the Compound Datastore task pane on the 
Configuration mode navigation pane.

Select: Opens a browser where you can select a saved datastore 
.xml file.

Defaults

Lab name Specifies the default laboratory name used for methods. 
Default: ThermoFisher Laboratory

Instrument name Specifies the default instrument name used for batches. 
Default: ThermoFisher Instrument

Display mass precision Specifies the number of decimal places used to display mass 
precision.  
Valid values: any integer between 0 and 5, inclusive.

Chromatogram Intensity 
Scale

Specifies the type of chromatogram display in data review and 
reports.

Table 9. General configuration parameters  (Sheet 2 of 2)

Parameter Description
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Specifying the Reports Configuration

In the Application Configuration view of the Configuration mode, as a user in the role of 
Manager or IT Administrator, you can configure a list of reports that are available to users 
when they generate reports from the Method Development or Production modes. From the 
Reports page, you can configure standard reports or custom reports.

This section includes configuration instructions for the following reports:

• Standard Reports

• Custom Reports

To open the Reports page of the Application Configuration view

1. Click Configuration from the dashboard or the navigation pane.

The Configuration navigation pane opens. 

2. Click Application Configuration.

The General page of the Application Configuration view opens.

3. Click the Reports tab.

The Reports page of the Application Configuration view opens. 
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Standard Reports

The EnviroLab Forms application supplies standard reports. Example PDFs of standard 
report formats are located in the following folder:

C:\Thermo\Shared\ExampleReports

Follow these procedures:

• To specify which standard reports are available

• To import new standard report types

To specify which standard reports are available

1. Click the Standard Reports tab.

The Standard Reports page opens. This page is the default when you first open the 
Reports page. See “Standard Reports page” on page 42.

2. Use the directional arrows to move reports from the Installed Reports pane to the 
Displayed Reports pane.

Tip  Use the CTRL or SHIFT keys to select multiple reports.

All reports in the Displayed Reports pane are available to users in the Method 
Development and Production modes.

3. Do one of the following:

• To return the report selections to their original state (when you first opened this 
page), click Undo Changes.

–Or–

• To apply the current selections, do the following:

a. Click Apply.

A message reminds you that you must restart the EnviroLab Forms application 
before your report selections are reflected in the reports available for the Method 
Development and Production modes.

b. To restart the EnviroLab Forms application now, click Yes, or to remain on the 
Reports page, click No.

To import new standard report types

1. Click Import.

2. In the browser, locate a Crystal Reports .dll file and open the file.

The application writes the imported report to the EnviroLab Forms installation directory.

The Installed Reports pane displays the new report.
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Figure 7. Standard Reports page

Table 10. Standard Reports parameters  (Sheet 1 of 2)

Parameter Description

Standard Reports Displays all available standard reports. 

Custom Reports Displays all available custom reports. 

Installed reports All reports listed in the Installed Reports pane are potentially 
available for this application but are not selected for the Method 
Development or Production modes.

Displayed reports All reports listed in the Displayed Reports pane are selected for 
the Method Development and Production modes. By default, 
the application displays all reports.

>> Moves all reports from the Installed Reports list to the Displayed 
Reports list.

> Moves the selected reports from the Installed Reports list to the 
Displayed Reports list.
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< Moves the selected reports from the Displayed Reports list to the 
Installed Reports list.

<< Moves all reports from the Displayed Reports list to the Installed 
Reports list.

Import Opens a browser where you can choose a report file to add to the 
Installed Reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this page).

Apply Applies the current selections, and reminds you that you must 
restart the application before the report selections are available 
for the Method Development and Production modes.

Table 10. Standard Reports parameters  (Sheet 2 of 2)

Parameter Description
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Custom Reports

Use the EnviroLab Forms application to configure and import custom reports.

Follow these procedures:

• To specify which custom reports are available

• To import new custom report types

To specify which custom reports are available

1. Click the Custom Reports tab.

The Custom Reports page opens. See “Custom Reports page” on page 45.

2. Use the directional arrows to move reports from the Installed Reports pane to the 
Displayed Reports pane.

Tip  Use the CTRL or SHIFT keys to select multiple reports.

All reports in the Displayed Reports pane are available to users in the Method 
Development and Production modes.

3. To create a single report for an entire batch (rather than separate reports for each sample), 
select the Batch Level Report check box for the report type.

Rather than creating separate reports for each sample, the application uses data from only 
the last sample to create a single report for the entire batch. Batch-level reports are 
prepended with a B to differentiate them.

4. Do one of the following:

• To return the report selections to their original state, click Undo Changes.

–Or–

• To apply the current selections, do the following:

a. Click Apply.

A message reminds you that you must restart the EnviroLab Forms application 
before your report selections are reflected in the reports available for the Method 
Development and Production modes.

b. To restart the EnviroLab Forms application now, click Yes, or to remain on the 
Reports page, click No.

To import new custom report types

1. Click Import.

2. In the browser, locate a Custom Reports .xltm file and open the file.

The application writes the imported report to the following folder:

..\Thermo\EnviroLab Forms\Templates\Reports

The Installed Reports pane adds the new report to the list.
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Figure 8. Custom Reports page

Table 11. Custom Reports parameters  (Sheet 1 of 2)

Parameter Description

Standard Reports Displays all available standard reports.

Custom Reports Displays all available custom reports.

Installed reports All reports listed in the Installed Reports pane are potentially 
available for this application but are not selected for the Method 
Development or Production modes.

Displayed reports All reports listed in the Displayed Reports pane are selected for 
the Method Development and Production modes. By default, 
the application displays all reports.

>> Moves all reports from the Installed Reports list to the Displayed 
reports list.

> Moves the selected reports from the Installed Reports list to the 
Displayed Reports list.
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< Moves the selected reports from the Displayed Reports list to the 
Installed Reports list.

<< Moves all reports from the Displayed Reports list to the Installed 
Reports list.

Batch level report Creates a single report for the entire batch by using data from 
only the last sample, rather than creating separate reports for 
each sample. Batch-level reports are prepended with a B to 
differentiate them.

Import Opens a browser where you can choose a report file to add to the 
Installed Reports list.

Undo changes Returns the report selections to their original state (when you 
first opened this view).

Apply Applies the current selections, and reminds you that you must 
restart the application before the report selections are available.

Table 11. Custom Reports parameters  (Sheet 2 of 2)

Parameter Description
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This chapter includes method development tasks assigned to the Supervisor or Manager roles.

From the Method Development mode, you can create a master method or an instrument 
method, and you can create a development batch to test your instrument method with a 
sample batch.

To access the Method Development mode

Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

Contents

• Working with Master Methods

• Working with Instrument Methods

• Working with Development Batches
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Figure 9. Method Development navigation pane

Table 12. Method Development navigation pane functions  (Sheet 1 of 2)

Function Description

Method View See “Working with Master Methods” on page 50.

Create method Opens the Create Master Method dialog box where you can 
choose the process you want to use to begin your master method. 

Open method Opens the Open Master Method dialog box where you can choose 
a master method to open.
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Export SRM data Writes the selected reaction monitoring (SRM) table to the 
following file:

..\Thermo\EnviroLab Forms\Methods\methodname.xml

You can use the data in this file in the instrument method editor 
when you open the TSQ 2.1 application. This command is 
available only when you have selected Enable Compound 
Datastore on the General page of the Application Configuration 
view. See “Application Configuration” on page 35.

Recent Files Displays recently saved master methods.

Instrument View See “Working with Instrument Methods” on page 157.

New instrument 
method

Opens the Instrument View where you can specify instrument 
settings for your configured instruments.

If the instrument you want to use is not configured, close the 
EnviroLab Forms application, configure the instrument, and then 
reopen the EnviroLab Forms application. You cannot configure an 
instrument while the EnviroLab Forms application is running.

Open instrument 
method

Opens a browser where you can choose an instrument method to 
open.

Development Batch See “Working with Development Batches” on page 161.

Select batch location Specifies a location to store temporary development batch raw data 
files.

New sample list Removes acquired samples from your development batch so you 
can begin a new sample list.

Open Qual Browser Opens the Qual Browser where you can monitor the acquisition of 
your samples.

Table 12. Method Development navigation pane functions  (Sheet 2 of 2)

Function Description
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Working with Master Methods
The EnviroLab Forms application uses a master method to specify the nature and types of 
acquisition, processing, and reporting that occur with a batch of samples. When you are 
testing for compounds in an assay, you can create a method designed specifically for that type 
of application. 

When you create a master method, the EnviroLab Forms application uses the method to 
determine how the software works with a set of samples to provide a set of meaningful results. 
The application uses an instrument method to define how raw data is acquired. The rest of 
the master method defines how the raw data is processed, how the flags information evaluates 
the results, and how the reporting functionality defines the way your data and results are 
output into reports. 

The EnviroLab Forms application applies your master method to a batch, which is a list of 
one or more samples to be processed and reported. Together, the master method and batch 
provide a workflow-oriented approach to the processing of data and the reporting of 
information for small and large sets of samples. 

To speed up the creation of master methods, you can create a method template. Using a 
method template helps you to develop methods faster because all of your commonly used 
method settings, such as number of confirming ions, are saved in a template. 

This section includes instructions for the following tasks:

• Creating a New Master Method

• Editing a Master Method

• Creating a Method Template

• Exporting SRM Data
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Creating a New Master Method

You can use any of four different procedures to begin a master method:

• Creating a Method with Method Forge

• Importing an Xcalibur Method

• Associating a Raw Data File

• Selecting Compounds from the Compound Datastore

Each procedure lets you begin the method in a specific way and then use the common features 
of the Master Method View to complete and save your master method.

Creating a Method with Method Forge

With Method Forge, you can create a new master method by manually selecting peaks, 
selecting multiple compounds, renaming peaks, or comparing mass spectra from the library 
searches. You can also choose to let the EnviroLab Forms application automatically create a 
master method for you. 

When the EnviroLab Forms application automatically creates a master method for you, it 
performs the following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign compound names and CAS numbers.

• Uses mass spectral information to select potential quantification and confirming ions and 
a reference mass spectrum for the compound. 

A master method contains a list of compounds and an initial set of information for detecting, 
processing, and reporting those compounds. 

Follow these procedures:

• To automatically select compounds to create a new method

• To manually select compounds to create a method

To automatically select compounds to create a new method

1. From the Method View task pane, click Create Method.
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The Create Master Method dialog box opens.

2. Select Use Method Forge.

3. Click OK.

The Method Forge dialog box opens. See “Method Forge” on page 58.

Use the Method Forge to create a master method from an existing raw data file or to 
create a new raw data file to use for the master method. 

4. In the Method Forge dialog box, do one of the following:

• Select the Use the Default Template option. 

–Or–

• Select the Select a Custom Template option and highlight your custom template in 
the Method template table.

For detailed instructions on creating a custom method template, see “Creating a 
Method Template” on page 147.

5. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw file used to create the 
method.

6. Select the Automatically Create the Master Method check box.
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7. Do one of the following:

a. In the Raw File Selection area, choose Use an Existing Raw Data File.

b. Click the browse button and locate a raw data file to use for the method.

–Or–

a. In the Raw File Selection area, choose Acquire a New Raw Data File.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

c. In the Raw Filename box, type the name of the file where the EnviroLab Forms 
application will write the raw data.

d. In the Path box, type a path or click the browse button and locate a folder where the 
application will save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

8. If you chose to acquire a new raw data file, do one of the following:

• Choose Manual Injection.

–Or–

• Do the following:

a. Choose Use Autosampler.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

The minimum injection volume value allowed is 0.05 μL.

9. To automatically create the master method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status:

Note  When you have a compound datastore enabled, the Method Forge process 
searches the library and displays the identified compound names instead of peak times.
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When the acquisition completes, Method Forge performs peak detection, datastore 
searching, and characteristic ion and reference spectrum identification. Method Forge 
then loads this information into a new master method. This process occurs immediately if 
you selected a previously acquired raw file.

If the compounds in the raw data file you used to create the method are not in the 
Compound Datastore, the EnviroLab Forms application displays the compounds in the 
Edit Compound Dependent Parameters dialog box.

10. (Optional) Select the compounds that you want to add to the compound datastore and 
click Add to CDS.

The selected compounds are added to the current compound datastore.

Note  To add these compounds to the datastore, you must use the Add to CDS 
command before you continue to the method.

11. To use these compounds in your method and close the dialog box, click Continue to 
Method.

All compounds found in the raw data file are used in your method. The EnviroLab Forms 
application displays the General page of the Master Method View.

12. From the Instrument Method list on the General page, select an instrument method.

13. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

14. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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To manually select compounds to create a method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. Select Use Method Forge.

3. Click OK.

The Method Forge dialog box opens. See “Method Forge” on page 58.

4. In the Method Forge dialog box, do one of the following:

• Select the Use the Default Template option. 

–Or–

• Select Select a Custom Template and highlight your custom template in the Method 
Template table.

For detailed instructions about creating a custom method template, see “Creating a 
Method Template” on page 147.
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5. Select the Name the Master Method check box and type a name for your master method.

You can enter an existing method name and overwrite it when you create the method. If 
you do not specify a name, the method is named for the raw file used to create the 
method.

6. Ensure that the Automatically Create the Master Method check box is not selected.

7. To select a raw data file, click the browse button and locate the file.

8. To manually create the master method, click OK (or Overwrite).

The Master Method View displays a list of possible matches in the Library Results pane. 
The EnviroLab Forms application displays the best match in the Compound Name list 
and displays the peak spectrum for that compound.
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9. To use a compound other than the compound chosen by the EnviroLab Forms 
application, scroll to the spectrum for that compound and select the compound name in 
the header of the spectrum pane. 

Select 
compound

10. After you manually select your compound, click Create to create the master method. 

All compounds found in the raw data file are used in your method. The EnviroLab Forms 
application displays the General page of the Master Method View.

11. From the Instrument Method list on the General page, select an instrument method.

12. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

13. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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Figure 10. Method Forge

Table 13. Method Forge parameters  (Sheet 1 of 2)

Parameter Description

Method template 
selection

Use the default 
template

Creates a new method with the default template.

Select a custom 
template

Lists all the available method templates.

For detailed instructions about creating a custom method 
template, see “Creating a Method Template” on page 147.

Name the master 
method

The name for the new master method.

Automatically create 
the master method

When the acquisition completes, Method Forge performs peak 
detection, library searching, and characteristic ion and reference 
spectrum identification. This information is loaded into a new 
master method. This process occurs immediately when you specify 
an existing raw data file.
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Raw file selection

Use an existing raw 
data file

Enables the Raw Filename box where you can select a raw data file 
to use to create the master method.

Acquire a new raw data 
file

Enables functions to acquire data to create a raw file to use to 
create the master method.

Instrument 
method

The saved method (.meth) file to use for acquiring the data.

Raw filename The file name where the EnviroLab Forms application will write 
the raw data.

Path The location where the EnviroLab Forms application will save the 
raw data file.

Sample comment (Optional) Comment about the acquired sample or the data file.

Manual injection Performs a manual acquisition.

Use autosampler Performs an autosampled acquisition.

Vial position The tray vial number used for the autosampler acquisition.

Injection amount The volume (in milliliters) injected by the autosampler 
acquisition.

Function button

Overwrite Overwrites the specified master method name. This function is 
enabled only when the specified master method name already 
exists.

OK Creates a master method using the data and parameters you 
specified.

Cancel Closes the Method Forge and does not create a master method.

Table 13. Method Forge parameters  (Sheet 2 of 2)

Parameter Description
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Importing an Xcalibur Method

You can create a new master method from an existing Xcalibur processing method.

To import an Xcalibur method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. Select Import Xcalibur Processing Method.

3. Click OK.

The Import an Xcalibur Method dialog box opens.
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4. To select an Xcalibur processing method file to import, click the browse button for the 
Xcalibur Method to Import box.

5. Browse to the Xcalibur processing method file and open the file.

The EnviroLab Forms application imports the compound information from the Xcalibur 
method file.

6. To associate a raw data file with this method, click the browse button for the Rawfile to 
Associate box.

7. Browse to the raw data file and open the file.

8. (Optional) Change the number of decimal places in the Mass Precision box.

You can set the mass precision decimal places to any integer between 0 and 5, inclusive.

9. Click OK.

If the compounds in the imported Xcalibur method file are not in the Compound 
Datastore, the EnviroLab Forms application displays the compounds in the Edit 
Compound Dependent Parameters dialog box.

10. (Optional) Select the compounds you want to add to the Compound Datastore and click 
Add to CDS.
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The selected compounds are added to the current compound datastore.

Note  To add these compounds to the datastore, you must use the Add to CDS 
command before you continue to the method.

11. To add these compounds to your method and close the dialog box, click Continue to 
Method.

All compounds found in the imported Xcalibur method are added to your method. The 
EnviroLab Forms application displays the General page of the Master Method View.

12. From the Instrument Method list on the General page, select an instrument method.

13. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

14. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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Associating a Raw Data File

You can use the compounds in a previously acquired raw data file to create a new master 
method.

Follow these procedures:

• To associate a raw data file with the method

• To add compounds to the method

To associate a raw data file with the method

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. Select Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.
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3. Click the browse button and locate a raw data file to associate with the method.

4. To update the target ion ratio values when you associate this raw data file, click Yes.

5. To set a reference spectrum, do one of the following:

• Click Yes.

– Or –

• Click Yes, with Background Subtraction.

This feature is available only when you have set background subtraction values on the 
General page of the Master Method View. See “Editing the General Page” on 
page 70.

6. Click OK.

All compounds found in the raw data file are added to your method. The EnviroLab 
Forms application displays the General page of the Master Method View.

7. From the Instrument Method list on the General page, select an instrument method.

8. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

9. To save the new method, choose File > Save from the main menu.

If the compounds in the associated raw data file are not found in the Compound 
Datastore, the EnviroLab Forms application will not let you save the method. Follow the 
instructions “To add compounds to the method” on page 65.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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To add compounds to the method

1. Click the Compounds tab.

The Detection page is selected by default.

The Detection page shows an empty Compound list and displays the chromatographic 
data for the compounds in the raw file.

2. Select a filter from the Filter list.

3. Click the peak in the chromatogram that represents the compound you want to add to 
the method. 

4. Right-click and choose Add this Peak as New Compound from the shortcut menu.

The EnviroLab Forms application adds the new compound and displays the quantitation 
peak information for the compound. 

5. Repeat these steps for each compound you want to add to the method.

For a detailed description of all parameters on the Detection page, see “Editing the 
Compounds Page” on page 77. 

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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Selecting Compounds from the Compound Datastore

You can select compounds from the compound datastore to create a new master method.

To select compounds from the datastore

1. From the Method View task pane, click Create Method.

The Create Master Method dialog box opens.

2. Select Select Compounds from CDS.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore specified for the gas chromatography technology.
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3. Select the check box for each compound you want to add to the method and click Apply.

The EnviroLab Forms application adds the selected compounds to the Master Method 
View. 

4. From the Instrument Method list on the General page, select an instrument method.

5. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

6. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a master method, see “Editing a Master 
Method” on page 68. 
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Editing a Master Method

You can open a master method to view or edit the compounds, method instructions, and 
reporting options in the method.

This section includes instructions for the following tasks:

• Opening a Master Method

• Editing the General Page

• Editing the Compounds Page

• Editing the QAQC Page

• Editing the Groups Page

• Editing the Reports Page

Opening a Master Method

The EnviroLab Forms application lets you open a master method that was created and saved 
in the EnviroLab Forms 3.0 application or one that was created and saved in the EnviroLab 
Forms 2.5 application.

Follow these procedures:

• To open a saved master method

• To open a saved master method from the Recent Files list

To open a saved master method

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method View task pane, click Open Method, or choose File > Open > Master 
Method from the main menu.

The Open Master Method dialog box opens where you can select a master method.
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3. Select either Open ELF 3.0 Methods or Open ELF 2.5 Methods.

The EnviroLab Forms application displays all available methods for the specified version 
of the application. The list of EnviroLab Forms 2.5 methods can include any method 
created with EnviroLab Forms 2.5 or greater.

4. Select a master method and click Open.

The selected master method opens in the Master Method View.

When you open a LabForms 2.5 method, the EnviroLab Forms application copies all 
components of the selected method including its associated instrument method. 

• If the LabForms 2.5 master method does not have an associated instrument method, 
the Master Method View for the imported method indicates that you need to select 
an instrument method.

• If you open a LabForms 2.5 master method that uses an instrument method name 
already used in your Xcalibur\methods folder, you are prompted to overwrite the 
instrument method or use the method with the same name already in your methods 
folder.

To open a saved master method from the Recent Files list

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

When you save a method, it is added to the Recent Files list. The Recent Files list displays 
a list of your most recently saved master method files.
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2. Click the method name in the Recent Files list. Do not double-click.

The General page for the selected method opens in the Method View. See “General page” 
on page 74.

Editing the General Page

The General page defines basic information about the master method.

Follow these procedures:

• To specify general information for a master method

• To edit the instrument or tune/breakdown method parameters

• To set automated background subtraction options

• To specify a chromatogram reference sample

To specify general information for a master method

1. In the Lab Name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

The default name is ThermoFisher Laboratory.

2. In the Assay Type box, type the assay type to be targeted by the method.

3. From the Injection Volume box, select the injection volume (in μL) to be used for sample 
injection.

Use either the up/down arrows to change the volume in increments/decrements of 1 μL, 
or the keyboard to enter non-integer injection volumes. 

IMPORTANT  The EnviroLab Forms application uses the injection volume you specify 
here in the master method, not the injection volume from the instrument method.

4. From the Ion Range Calc Method box, select a method for calculating the ion ratio range 
windows.
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When you select Level, the EnviroLab Forms application displays an additional list box 
where you can choose a calibration level. To define the calibration levels on the 
Compounds page, see “Editing the Compounds Page” on page 77.

5. From the Qualitative Peak Processing Template box, select a template for performing 
peak detection on quantitative samples following target compound analysis.

To edit the instrument or tune/breakdown method parameters

1. From the Instrument Method list on the General page, select an instrument method.

2. From the Tune/Breakdown method list, select a tune/breakdown method (if different 
from your instrument method).

3. To edit the instrument or tune/breakdown methods for this master method, click Edit 
next to the appropriate box.

The Thermo Xcalibur Instrument Setup dialog box opens.

This example instrument setup shows multiple configured instruments.

4. Edit the values on the instrument page.
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5. From the main menu on the Thermo Xcalibur Instrument Setup dialog box, choose File 
> Save and then choose File > Exit.

The EnviroLab Forms application returns you to the General page.

6. To update any changes that were made to the instrument method, tune method, or 
breakdown method after you created this master method, click Update next to the 
appropriate box.

To set automated background subtraction options

1. Click Range Option and select how you want the subtraction range determined.

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans following the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

2. Click Number of Scans to Subtract, and use the spin box to select a number or type a 
number in the box.

After averaging, this is the number of scans that the EnviroLab Forms application 
subtracts from the background. If you specified to subtract scans from both sides of the 
peak, the application subtracts this number of scans from EACH side of the peak.

3. Click Stepoff Value, and use the spin box to select a number or type a number in the box.

This offset value lets the EnviroLab Forms application average and subtract scans that are 
not adjacent to the apex of the peak. 

For example:

If you have specified to subtract 3 scans before the peak and the Stepoff value is 5, the 
EnviroLab Forms application ignores the first 5 scans to the left of the peak and applies 
the averaging and subtraction to the 6th, 7th, and 8th scans to the left of the peak.
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To specify a chromatogram reference sample

1. Click Set Chromatogram Reference Sample and select External from the list.

2. Click Select File.

The Open Chromatograph Reference Sample dialog box opens.

Note  If you are using a EnviroLab Forms 2.5 method, you will not see any reference 
samples here. You must first create and save a batch using the EnviroLab Forms 2.5 
method.

3. Select a project from the list of projects.

4. Select a subproject from the list of subprojects.

5. Select a batch from the list of batches.

The EnviroLab Forms application displays only batches that were created using the same 
master method as the current batch. 

6. Select a sample from the list of processed samples.

The EnviroLab Forms application displays all the processed samples in the selected batch. 
To use a sample as a reference sample, it must have been acquired and processed with the 
current master method.

7. Click Open.

The selected sample is displayed as the chromatogram reference sample in the Master 
Method View.

Tip  To clear the reference sample from the master method, click Set Chromatogram 
Reference Sample and select None from the list.
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Figure 11. General page
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Table 14. General parameters  (Sheet 1 of 2)

Parameter Description

Lab name The laboratory name to be displayed on the top of each printed, 
saved, or exported report.  
Default: ThermoFisher Laboratory

To specify this default laboratory name, see “Specifying the 
General Configuration” on page 35.

Assay type The name for the analysis type to be targeted by the method. The 
assay type associates the method with the analysis of a compound 
or specific class of compounds (for example, an assay type of PAH 
might be used for the analysis of Polynuclear Aromatic 
Hydrocarbons). The EnviroLab Forms application uses this assay 
type in the batch template. 

Injection volume The system use the injection volume (in μL) for sample injection. 
Certain autosamplers, such as the AI/AS 3000, use the injection 
volume specified in the associated instrument method. For those 
autosamplers, the value entered in this field is ignored and the 
instrument uses a default method injection volume. Other 
autosamplers, such as the TriPlus, use the EnviroLab Forms 
application method injection volume for sample analysis and 
override the instrument method. For a more detailed explanation, 
refer to the documentation for the autosampler.

Ion range calc method The EnviroLab Forms application uses the selected ion range calc 
method to calculate the ion ratio range windows: Manual 
(default), Average, Level, or Weighted average.  When you select 
Level, an additional list box is displayed where you can choose a 
calibration level amount. To define these calibration levels on the 
Compounds page, see “Editing the Compounds Page” on page 77.

Instrument method Instrument method used for processing samples.

 Tune/Breakdown   Breakdown or tune method used for processing samples.

Edit Opens the Thermo Xcalibur Instrument Setup dialog box where 
you can edit the instrument method, tune method, or breakdown 
method.

Update Updates any changes to the instrument method, tune method, or 
breakdown method after you created this master method.

Qualitative peak 
processing template

The EnviroLab Forms application uses the qualitative peak 
processing template to perform peak detection on quantitative 
samples following compound analysis.
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Background 
subtraction range 
option

Valid values: None, Before Peak, After Peak, Both Sides of Peak 
Default: None

Number of scans to 
subtract

Valid values: Even numbered integers 
Default: 0

Stepoff value Offset from the selected peak to the first subtracted peak.

Set chromatogram 
reference sample 

Valid values: None, External 
Default: None

Set Reference sample This parameter is enabled only when Set Chromatogram 
Reference Sample is set to External. The Select button lets you 
choose a reference sample from the project folders.

Notes  Notes you add about the method.

Table 14. General parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Compounds Page

Use the Compounds page to set all parameters for the identification, detection, and 
quantification for the target compound list.  

From the Compounds page of the Master Method View, you can access the following pages:

• Acquisition List

• Identification

• Detection

• Calibration

• Calibration Levels

• QC Levels

Acquisition List

The Acquisition List page displays all compounds defined for the current method. From this 
page, you can add or delete compounds from the method. See “Acquisition List page” on 
page 79.

The Acquisition List page is displayed only when the Enable Compound Datastore option is 
checked on the General page on the Application Configuration view. See “Application 
Configuration” on page 35.

Follow these procedures:

• To filter the compound list

• To delete a compound from the list

• To add a compound transition to the list

To filter the compound list

1. To display a filtered list of compounds, click the funnel icon, , in the column header.

For each column, a list of filterable criteria is displayed in a list box. On all list boxes, you 
can choose to filter by All, Blanks, NonBlanks, or by custom filter criteria. Other filter 
criteria are specific to the individual columns.

2. Choose the type of compound you want to display.

For example, if you choose All in the Compound Name column, the EnviroLab Forms 
application displays all compounds; if you choose Blanks in the Compound Name 
column, the application displays only blank compound types.

3. (Optional) To create a custom filter based on compound values in a specific column, 
choose Custom from the column list box.

For detailed instructions about creating a custom filter, see Appendix C, “Using Filter 
Criteria.” 
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To delete a compound from the list

1. Select the compound to remove from the list.

2. Click the Remove Compound Transition icon, , or right-click and choose 
Remove Compound Transition from the shortcut menu.

A confirmation dialog box opens, listing the compound to be removed.

3. To confirm the deletion, click Yes.

The selected compound is removed from the acquisition list. 

To add a compound transition to the list

1. Click the Add Compound Transition icon, , or right-click and choose Add 
Compound Transition from the shortcut menu.

The Select Compounds to Add dialog box opens, listing all the compounds defined in the 
compound datastore specified for the gas chromatography technology.

2. Select the check box for each of the compounds you want to add to the method and click 
Apply.

The EnviroLab Forms application adds the compounds to the Acquisition List and 
Compounds pages of the Master Method View. 
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Figure 12. Acquisition List page

Table 15. Acquisition List parameters  (Sheet 1 of 2)

Parameter Description

Function Icon

 Opens the Select Compounds to Add dialog box that lists all the 
compounds defined in the compound datastore specified for the 
gas chromatography technology.

 Deletes the selected compound transition. The icon is 
unavailable when no row is selected.

If you have used the filters to display a subset of compounds, the 
selected compound might not be visible in the Acquisition List 
page. 

Compound parameter

Compound Name Alphanumeric name assigned to the compound.

Category (Optional) Alphanumeric identifier. 

Ionization (Optional) Alphanumeric identifier.  
Valid values: ESI, APCI, EI, CI, APPI

Chemical Formula (Optional) Alphanumeric chemical identifier.
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Precursor Mass The mass-to-charge ratio of a precursor ion. The location of the 
center of a target precursor-ion peak in mass-to-charge ratio 
(m/z) units.  
Default: 0.0 
Range: 10.000 to 2999.999

Product Mass The mass-to-charge ratio of the quan ion. The location of the 
center of a target quan-ion peak in mass-to-charge ratio (m/z) 
units.  
Default: 0.0 
Range: 10.000 to 2999.999

Collision Energy The energy used when ions collide with the collision gas.  
Range: –250 to 250

Lens (Optional) Range: –400 to 400

Polarity + (positive) or – (negative)

RT (min) Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

RT and Window values are used to determine the start and stop 
time for the acquisition.  
Range: 0.00 to 999.00 
Start time = RT – (Window/2) 
Stop time = RT + (Window/2) 
Start and stop range: 0.00 to 999.00

Window (sec) Acquisition window. RT and Window values are used to 
determine the start and stop time for the acquisition.  
Range: 0.00 to 499.50 
Start time = RT – (Window/2) 
Stop time = RT + (Window/2) 
Start and stop range: 0.00 to 999.00

Energy Ramp (Optional)  
Range: 0.00 to 200.00

Table 15. Acquisition List parameters  (Sheet 2 of 2)

Parameter Description
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Identification

The Identification page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values.

To filter the displayed compounds

From the Show list box, select the type of compounds you want to display in the 
compounds list.

Compound Type Description

Figure 13. Identification page

Quan compounds Displays only quan compounds, such as target 
compounds, internal standards, and surrogates. 

Non quan compounds Displays only non-quan compounds, such as native, 
breakdown, and tune compounds. 

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.
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Table 16. Identification parameters  

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

RT and Window values are used to determine the start and stop 
time for the acquisition.  
Range: 0.00 to 999.00 
Start time = RT – (Window/2) 
Stop time = RT + (Window/2) 
Start and stop range: 0.00 to 999.00

Compound A list of compounds that have been identified. To customize the 
compound names, click the cell and type a new name. To display a 
filtered list of compounds, use the Show list box.

Compound type Compound types are Target Compound, Internal Standard, 
Surrogate, Native, Breakdown, or MSTune.

The EnviroLab Forms application uses target compounds, internal 
standards, and surrogates in quantitative analysis, and it uses 
native, breakdown, and tune compound types in system 
evaluation, as defined on the Breakdown page.  See “Breakdown 
page” on page 125.

Active Identifies each compound to be included in data review and 
reporting. By default, all added compounds are set to active.

CAS No The Chemical Abstract Service (CAS) number that the EnviroLab 
Forms application matched with each compound. To change or 
add a number, click the CAS No cell and enter a new number.

Use as RT Reference  When performing peak detection with retention time standards, 
the EnviroLab Forms application first identifies those compounds 
identified as retention time standards and then uses their observed 
retention times to adjust any associated target compound.

Reference compound Reference compound to be used for retention time adjustment for 
a compound. This list includes all compounds that are selected in 
the Use as RT Reference column. 
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Detection

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

On the Detection page, you can configure how characteristic ions for targeted compounds are 
detected and integrated. You can also edit the list of characteristic ions for a specific 
compound. Refining these parameters in the master method for each compound and its ions 
can reduce the degree of manual integration that would otherwise be required. 

You can change the parameters used to identify a quantification peak, mass range, or 
confirming ion. The EnviroLab Forms application automatically assumes the first match it 
finds is the compound name, the base peak of the mass spectrum is the quan peak, and the 
second and third largest ions are the confirming ions. 

Follow these procedures:

• To filter the displayed compounds

• To add compounds to the method

• To change the compound reference spectrum

• To replace a quan mass

• To add a mass to the existing quan mass ranges

• To add a quan peak

• To add a mass as a new compound

• To replace a confirming ion

• To add a mass as a new confirming ion

• To save the new method

To filter the displayed compounds

From the Show list box, select the type of compounds you want to display in the 
compounds list.

Compound Type Description

Quan compounds Displays only quan compounds, such as target 
compounds, internal standards, and surrogates. 

Non quan compounds Displays only non-quan compounds, such as native, 
breakdown, and tune compounds. 
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To add compounds to the method

1. Click the Compounds tab.

2. Click the Detection tab.

The Detection page shows an empty Compound list.

3. From the main menu, choose Master Method > Associate a Raw Data File.

The Associate a Rawfile dialog box opens.

4. Browse to a raw data file to associate with the method and open the file.

5. To update the target ion ratio values when you associate this raw data file, click Yes.

6. To set a reference spectrum, do one of the following:

• Click Yes.

– Or –

• Click Yes, with Background Subtraction.

This feature is available only when you have set background subtraction values on the 
General page of the Master Method View. See “Editing the General Page” on 
page 70.

7. Click OK.

The EnviroLab Forms application displays the chromatographic and spectrum data for 
the compounds in the selected raw file.

Target compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Surrogates Displays only surrogate compounds.

Compound Type Description
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8. Select a filter from the Filter list.

9. Click the peak in the chromatogram that represents the compound you want to add to 
the method. 

10. Right-click and choose Add This Peak as New Compound from the shortcut menu.

The EnviroLab Forms application performs a library search for the selected compound. 
The application uses the first match it finds as the compound name, the base peak of the 
mass spectrum as the quan peak, and the second and third largest ions as the confirming 
ions. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens.
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11. (Optional) In the Add New Compound dialog box, do the following:

a. To use a compound other than the compound already in the library, scroll to the 
spectrum for that compound and select the compound name in the header of the 
spectrum pane.

Select 
compound

b. In the Type of Compound to Add list, select a compound type.

c. Click OK.

12. Repeat these steps for each compound you want to add to the method.

For a detailed description of all parameters on the Detection page, see “Editing the 
Compounds Page” on page 77. 
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To change the compound reference spectrum

1. In the raw file chromatogram pane, select a peak.

The EnviroLab Forms application displays the spectrum for the selected peak in the 
spectrum pane.

2. In the raw file spectrum pane, right-click and choose Use This Spectrum for Compound 
Reference Spectrum from the shortcut menu.

3. Choose either Update Spectrum Only or Update Spectrum and Ion Ratios.

The EnviroLab Forms application replaces the spectrum in the Spectrum page of the 
quan peak pane with this spectrum. If you choose to update the spectrum and the ion 
ratios, the application also replaces the ion ratios for the confirming peaks. You can see 
the updated ion ratios on the Ratios page for the confirming ions. See “Ratios” on 
page 109.

To replace a quan mass

1. Click the pane for the quan mass that you want to replace. 

2. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set This Mass as Quan Mass from the shortcut menu.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

You can see the updated ion ratios on the Ratios page for the confirming ions. See 
“Ratios” on page 109.

To add a mass to the existing quan mass ranges

1. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass to Existing Quan Mass Ranges from the 
shortcut menu.

3. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.
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The EnviroLab Forms application adds the selected mass to the existing quan mass ranges 
to increase the signal. 

If you chose to update the ion ratios, you can see the updated ion ratios on the Ratios 
page for the confirming ions. See “Ratios” on page 109.

To add a quan peak

1. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass as New Quan Peak from the shortcut menu.

A new quan peak is added to the compound.

You can use the shortcut menu on the spectrum pane for this new quan peak to perform 
any of the tasks you could perform on the original quan peak.

To add a mass as a new compound

1. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

2. Right-click and choose Add This Mass as New Compound from the shortcut menu.

The EnviroLab Forms application performs a library search for the selected compound. 
The application uses the first match it finds as the compound name, the base peak of the 
mass spectrum as the quan peak, and the second and third largest ions as the confirming 
ions. 

If the name of the first match is already in the library, the Add New Compound dialog 
box opens with the matching compound selected.
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3. (Optional) In the Add New Compound dialog box, make any of the following changes:

a. Change the name for the compound in the Name of New Compound box.

b. To use a compound other than the compound chosen by the EnviroLab Forms 
application, scroll to the spectrum for that compound and select the compound name 
in the header of the spectrum pane.

Select 
compound

c. Click the Type of Compound to Add list and select a compound type.

4. Click OK.
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To replace a confirming ion

1. Click the pane for the confirming ion that you want to replace. 

2. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Set this Mass as New Confirming Ion from the shortcut menu.

The EnviroLab Forms application replaces the confirming ion with the selected mass.

To add a mass as a new confirming ion

1. Click the pane for the quan mass to which you want to add a confirming ion. 

2. In the raw file spectrum pane, pause the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Add this Mass as New Confirming Ion from the shortcut menu.

The EnviroLab Forms application adds the confirming ion to the quan peak.

You can use the shortcut menu on the spectrum pane for this new confirming ion to 
perform any of the tasks you could perform on the original confirming ions.

To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Do one of the following:

• Type a new name for the master method and click OK.

–Or–

• Select a method name to overwrite and click Overwrite.

The EnviroLab Forms application saves the new method data in the following folder:

..\Thermo\EnviroLab Forms\Methods 
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Figure 14. Detection page
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Table 17.  Detection page parameters

Parameter Description

Compound list Lists all compounds in the master method.

Quan peak Displays a chromatogram for the quan peak and its confirming 
ions. The quan peak and confirming ion panes include additional 
pages for retention time, signal, detection, spectrum, and ratio 
parameters.

Filter Displays the filter used for the raw data file.

Reference 
chromatogram and 
spectra

Displays a reference chromatogram and spectra for the raw data 
file.

Additional pages

Times Defines the retention time and window for a quan peak.  
See “Times” on page 93.

Signal Defines the detector and its parameters used to display each 
chromatogram trace. See “Signal” on page 94.

Detect Defines the peak detection algorithm and its options.  
See “Detect” on page 96.

Spectrum Defines a reference mass spectrum for a quan peak or compound. 
See “Spectrum” on page 104.

Ratios Defines the criteria for evaluating, confirming, or qualifying ions. 
See “Ratios” on page 109.
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Times

Use the Times page to define the retention time and window for a quan peak. 

Figure 15. Times page

Table 18. Times parameters

Parameter Description

Expected RT (min) Expected retention time. The time after injection at which the 
compound elutes. The total time that the compound is retained 
on the GC column. 

Window (sec) Width of the window (in seconds) of how far around the expected 
retention time the system will look for a peak apex. 

View width (min) Viewable size of the ion chromatogram display. Changing the view 
width does not affect the process of peak detection; the EnviroLab 
Forms application uses it only for graphical display. 
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Signal

Use the Signal page to define the detector and its parameters as you display each 
chromatogram trace. 

Figure 16. Signal page

Table 19. Signal parameters  (Sheet 1 of 2)

Parameter Description

Detector MS: Mass spectrometers.  
Analog: Supplemental detectors (for example, FID, ECD).  
AD card: If you have a detector not under data system control, you can 
capture the analog signal and convert it to digital using an interface box (for 
example, SS420X) for storage in the raw file. 

Filter Represents a particular data acquisition channel. For example, the filter 
option + c Full ms [35.00-500.00] represents a positive ion centroid signal 
acquired in single-stage, full-scan mode from m/z 35 to 500.

Trace Represents a specific range of the data. In conjunction with the filter, the 
EnviroLab Forms application uses the trace to identify the characteristic 
ions for a compound. The options are: Mass Range, TIC, or Base Peak.
94         EnviroLab Forms 3.0 User Guide Thermo Scientific



 4  Using the Method Development Mode
Working with Master Methods
Ranges A range of ions for detection and integration. Entering a single value in the 
Start m/z cell defines a range of one amu centered on that value. To specify 
a range that is narrower or wider than this range, specify both a start and 
end value. Multiple ions are summed by adding rows to the Ranges grid. 

m/z The initial mass to charge ratio. 

Table 19. Signal parameters  (Sheet 2 of 2)

Parameter Description
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Detect

Use the Detect page to define the peak detection algorithm and its options and to determine 
the area under a curve. There are two different modes - Standard (Genesis) and High (ICIS). 
On this page, you can specify how you want each mode to run.

Figure 17. Detect page for Standard (Genesis)
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Table 20. Detect parameters for Standard (Genesis)  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the Standard (Genesis) peak detection algorithm.

Detection method Highest peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points 
Default: 1 

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks 
with signal-to-noise values greater than this value are integrated. 

Range: 0.0 to 999.0

Enable valley detection Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected width (sec) The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if 
valley detection is enabled.  
 
With valley detection enabled, any valley points nearer than the 
[expected width]/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the EnviroLab 
Forms application terminates the peak at that point. The 
application always terminates a peak when the signal reaches the 
baseline, independent of the value set for the expected peak width. 

Range: 0.0 to 999.0

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box enables the Peak Height (%) and Tailing 
Factor options.
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Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when the Constrain Peak Width check box is 
selected. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the EnviroLab Forms application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This text 
box is active only when the Constrain the Peak Width check box is 
selected. 

Range: 0.5 through 9.0

Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the EnviroLab Forms application ignores all 
chromatogram peaks that have signal-to-noise values that are less 
than the S/N Threshold value. 

Range: 0.0 (all peaks) through 999.0

Peak S/N cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the EnviroLab Forms application defines the right and left 
edges of the peak when the S/N reaches a value less than 200. 

Range: 50.0 to 10 000.0

Table 20. Detect parameters for Standard (Genesis)  (Sheet 2 of 3)

Parameter Description
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Valley rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). 

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the EnviroLab Forms 
application applies valley detection peak integration criteria. 

This test is applied to both the left and right edges of the peak. 

The rise percentage criteria is useful for integrating peaks with 
long tails.

Range: 0.1 to 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Range: 1.0 to 100.0 
Default: 2.0

# background scans Number of background scans performed by the EnviroLab Forms 
application.

Report noise as Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak to Peak.

Table 20. Detect parameters for Standard (Genesis)  (Sheet 3 of 3)

Parameter Description
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Figure 18. Detect page for High (ICIS)
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Table 21. Detect parameters for High (ICIS)  (Sheet 1 of 3)

Parameter Description

Sensitivity Specifies the High (ICIS) peak detection algorithm.

Detection method Highest peak uses the highest peak in the chromatogram for 
component identification. 

Nearest RT uses the peak with the nearest retention time in the 
chromatogram for component identification.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. 
The ICIS peak detection algorithm uses this value.

Range: Any odd integer from 1 through 15 points 
Default: 1 

Area noise factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Range: 1 through 500 
Default: 5

Peak noise factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 1000 
Default: 10

Baseline window The EnviroLab Forms application looks for a local minima over 
this number of scans. The ICIS peak detection algorithm uses this 
value.

Range: 1 through 500 
Default: 40

Constrain peak width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box enables the Peak Height (%) and Tailing 
Factor options.
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Peak height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when the Constrain Peak Width check box is 
selected. 

Range: 0.0 to 100.0%

Tailing factor A factor that controls how the EnviroLab Forms application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This text 
box is active only when the Constrain the Peak Width check box is 
selected. 

Range: 0.5 through 9.0

Min peak height (S/N) For the valley detection approximation method to use the Nearest 
RT Peak Identification criteria, this peak signal-to-noise value 
must be equaled or exceeded. For component identification 
purposes, the EnviroLab Forms application ignores all 
chromatogram peaks that have signal-to-noise values that are less 
than the S/N Threshold value. 

Range: 0.0 (all peaks) through 999.0

Noise method The options are INCOS or Repetitive.

INCOS uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Min peak width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Range: 0 to 100 scans 
Default: 3

Multiplet resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Range: 1 to 500 scans 
Default: 10 

Table 21. Detect parameters for High (ICIS)  (Sheet 2 of 3)

Parameter Description
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Area tail extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Range: 0 to 100 scans 
Default: 5

Area scan window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Range: 0 to 100 scans 
Default: 0 

RMS Specifies that the EnviroLab Forms application calculate noise as 
RMS. By default, the application uses Peak To Peak for the noise 
calculation. RMS is automatically selected if you manually 
determine the noise region.

Table 21. Detect parameters for High (ICIS)  (Sheet 3 of 3)

Parameter Description
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Spectrum

Use the Spectrum page to store a reference mass spectrum for a quan peak or compound.

Follow these procedures:

• To apply or remove the background subtraction

• To update confirming ion ratios

• To change the quantitation mass used for a quan peak

• To add ions together to get an accumulated signal

• To add a quan peak to an existing compound

• To add one or more confirming ions to an existing compound

• To zoom in the chromatogram or spectrum displays

To apply or remove the background subtraction

1. Right-click the Spectrum pane and choose Apply Background Subtraction to Peak and 
Set as Reference Spectrum from the shortcut menu.

The EnviroLab Forms application replaces the normal reference spectrum with a 
background subtracted reference spectrum.

2. To remove the background subtracted reference spectrum, right-click the Spectrum pane 
and choose Remove Background Subtracted Reference Spectrum from the shortcut 
menu.

The EnviroLab Forms application removes the applied background subtracted reference 
spectrum and returns to the normal reference spectrum. When there is no spectrum 
annotated at the beginning, the application displays “no data”.

To update confirming ion ratios

1. Click a peak in the quan peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. Right-click the Spectrum pane and choose Update Confirming Ion Ratios with this 
Spectrum from the shortcut menu.

To change the quantitation mass used for a quan peak

1. Click a peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the spectrum pane. 

2. In the spectrum pane, pause the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.
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3. Right-click to display the shortcut menu.

4. Pause the cursor over Set This Mass as Quan Mass and choose one of the following 
commands:

• Don’t Update Ion Ratios

• Update Ion Ratios Using this Reference Spectrum

Original quan peak mass

The EnviroLab Forms application replaces the original quan mass with the selected mass.

New quan peak mass
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To add ions together to get an accumulated signal

1. Pause the cursor over the m/z value for an ion in the Spectrum pane. 

A red box around the ion’s m/z value indicates that the ion is selected.

2. Right-click and choose Add This Mass to Existing Quan Mass Range from the shortcut 
menu.

You can now update the ion ratios to adjust the confirming ion comparisons to the new 
summed quan peak signal.

To add a quan peak to an existing compound

1. Click the peak in the Quan Peak chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, pause the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected.

3. Right-click and choose Set This Mass as New Quan Peak from the shortcut menu. 

The EnviroLab Forms application adds this ion as a new quan peak.

New quan peak mass
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To add one or more confirming ions to an existing compound

1. Click the peak in the chromatogram pane.

The mass spectrum for the peak is displayed in the Spectrum pane. 

2. In the Spectrum pane, pause the cursor over the m/z value for an ion.

A red box around the ion’s m/z value indicates that the ion is selected. 

3. Right-click and choose to Add This Mass as New Confirming Ion from the shortcut 
menu.

The EnviroLab Forms application adds the selected mass as a confirming peak for this 
quan peak.

To zoom in the chromatogram or spectrum displays

1. Drag the cursor to delineate a rectangle.

The display zooms into the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling from the shortcut 
menu.
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Figure 19. Spectrum page

Table 22. Spectrum shortcut menu functions  (Sheet 1 of 2)

Functions Description

Apply background 
subtraction to peak and 
set as reference spectrum

Applies the background subtraction values specified on the 
General page and uses this spectrum as the reference spectrum.

Update confirming ion 
ratios with this spectrum

Updates the confirming ion ratios using the selected peak.

Set this mass as quan 
mass

Adds the quan mass of the selected ion to the quantitation mass 
used for the quan peak. You can choose to update the ion ratios or 
not update the ion ratios using this reference spectrum.

Add this mass to 
existing quan mass range

Adds the selected mass to your existing quan mass range. You can 
choose to update the ion ratios to adjust the confirming ion 
comparisons to the new summed quan peak signal.
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Ratios

Use the Ratios page to define the criteria for evaluating the confirming or qualifying ions. The 
EnviroLab Forms application detects compounds that have confirming ion values outside 
their acceptable window and flags them in Production mode and on reports. 

To specify ion ratio criteria

1. Enable or disable the use of the particular confirming ion. 

2. In the Target Ratio box, select the theoretical ratio of the confirming ion’s response to the 
quantification ion’s response. 

3. In the Window Type box, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. In the Window (+/-%) box, select the acceptable ion ratio range. 

5. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

In the following example:

• The target ratio is expected to be 61.02% and the window is Absolute 20%, so the 
acceptable window for this confirming ion is 41.02% to 81.02%. 

• If, instead, the window type was Relative, the plus or minus value would be 20% of 
61.02% (or 12.20%), so the acceptable window for this confirming ion would be 
48.82% to 73.22%. 

Set this mass as new 
quan peak

Adds a new quan peak to an existing compound.

Add this mass as new 
confirming ion

Adds one or more confirming ions to an existing compound.

Reset scaling Returns the chromatogram or spectrum display to its original 
size. 

Table 22. Spectrum shortcut menu functions  (Sheet 2 of 2)

Functions Description
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Figure 20. Ratios page

Table 23. Ratios parameters

Parameter Description

Target ratio (%) The theoretical ratio of the confirming ion’s response to the 
quantification ion’s response. 

Window type The absolute or relative calculation approach for determining the 
acceptable ion ratio range. 

Window (+/-%) The acceptable ion ratio range.

Ion coelution (min) The maximum difference in retention time between a confirming 
ion peak and the quantification ion peak.
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Calibration

Use the Calibration page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Production mode 
when you view the results of an actual calibration batch. 

Figure 21. Calibration page

Table 24. Calibration parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Compound type Displays the compound type as an internal standard, an external 
standard, or a target compound.

Standard type Specifies Internal or External standards.

Response via The use of area or height.

Curve type Specifies Linear, Quadratic, or AverageRF curve types.

Origin The origin treatment as Ignore, Include, or Force. The Origin and 
Weighting columns are active only when you are using Linear or 
Quadratic curve types. 

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate 
if the standard type is set to Internal. If you set the standard type to 
External, this field is inactive.

Amount The amount of the internal standard for ISTD compounds. 
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Calibration Levels

On the Calibration levels page for a master method, you can define the standards for 
calibration. You can edit calibration levels and concentrations for master methods only. The 
contents of this page are read-only when you are editing a local method. 

To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations you want to define. 

2. In the Manage Calibration Levels area, type a value for the first calibration level.

The EnviroLab Forms application adds a new, empty calibration level row beneath the 
edited row.

3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
level for each compound.

4. To enter the concentrations to the table, do the following:

a. Select the first calibration level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat Step 4 for all calibration levels associated with the first compound.
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6. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click, and choose Copy Down from the shortcut menu. 

Figure 22. Calibration Levels page

  

Table 25. Calibration levels parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

cal1-caln User-defined calibration levels for the compound.

Manage Calibration 
levels

Defines values for each of the calibration level values for the 
selected compound.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 
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QC Levels 

Use the QC levels page for a master method to define the standards for QC levels. You can 
edit QC levels for master methods only. The contents of this page are read-only when you are 
editing a local method. 

To specify QC levels and concentrations

1. Select the compound whose QC levels, percentage test values, and concentrations you 
want to define. 

2. In the QC Levels area, type a name for the first QC level.

The EnviroLab Forms application adds a new, empty QC level row beneath the edited 
row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each QC level.

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 25. Calibration levels parameters  (Sheet 2 of 2)

Parameter Description
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4. Continue adding QC levels and values for percentage test.

When you finish adding QC levels, you can specify the concentrations for each level for 
each compound.

5. To enter the concentration values to the table, do the following:

a. Select the first QC level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

6. Repeat Step 5 for all QC levels associated with the first compound.

7. To specify the same concentration values for all compounds, select the value you want to 
copy, right-click, and choose Copy Down from the shortcut menu. 
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Figure 23. QC Levels page

Table 26. QC levels parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

QC1-QCn User-defined quality control levels for the compound.

QC levels

Level User-defined quality control level names.

% Test A value for the acceptable difference (as a percentage) between the 
known amount and calculated (measured) amount of each QC 
level.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
116         EnviroLab Forms 3.0 User Guide Thermo Scientific



 4  Using the Method Development Mode
Working with Master Methods
Editing the QAQC Page

Use the QAQC page to set limits and ranges so the EnviroLab Forms application can review 
the data and results as an aid to final approval.

From the QAQC page of the Master Method View, you can access these additional pages:

• Limits

• Calibration

• Chk Std

• Lab Control

• Meth Val

• Breakdown

• Blank

• ISTD

• Solvent Blank

• Surrogate

• Matrix Spike

• Tune

Limits 

Use the Limits page to define levels of review for quantified results. Quantified results appear 
on printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Figure 24. Limits page

Table 27. Limits parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.
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LOD (Detection limit) Limit of detection. The lowest amount that can be detected. 
Usually derived from a method detection limit (mdl) study.

LOQ (Quantitation 
limit)

Limit of quantitation. The lowest amount that can be confidently 
and accurately quantitated. This is usually the lowest calibrator 
amount.

LOR (Reporting limit) Limit of reporting. Also called cutoff in some industries. This is 
the highest amount that can be reported, as determined by each 
laboratory’s standard operating practices.

ULOL (Linearity limit) Upper limit of linearity. This is usually the highest calibrator 
amount.

Carryover limit The highest amount of a substance that does not leave a residual 
amount in the instrument. If a substance has a carryover limit of 5, 
amounts higher than 5 usually dirty the instrument and leave 
residue behind, tainting the following sample. A carryover limit of 
less than 5 does not leave any residual amounts of the substance.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 27. Limits parameters  (Sheet 2 of 2)

Parameter Description
118         EnviroLab Forms 3.0 User Guide Thermo Scientific



 4  Using the Method Development Mode
Working with Master Methods
Calibration 

Use the Calibration page to define acceptable criteria for initial calibration. The EnviroLab 
Forms application makes the evaluation by comparing the initial calibration results for each 
compound found in the sample to the values defined on this page. 

On the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Figure 25. Calibration page

Table 28. Calibration parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

R^2 threshold The minimum correlation coefficient (r2) for an acceptable 
calibration (when in linear or quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable 
calibration (when in average RF mode). 

Min RF The minimum average response factor (RF) for an acceptable 
calibration (when in average RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical 
concentrations of the calibration curve data points (when in linear 
or quadratic mode). 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Chk Std

Use the Chk Std page to review the calibration on an ongoing basis. The EnviroLab Forms 
application makes the evaluation by comparing the check standard results for each compound 
in the sample to the initial calibration using values defined on this page. 

On the Check Standard report, the EnviroLab Forms application flags the calculated values 
for internal standard compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the Chk Std sample versus the theoretical value is set on the QC levels page of the 
Compounds page.

Figure 26. Chk Std page

Table 29.  Chk Std parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
Chk Std sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the Chk Std sample (when in 
average RF mode). 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Lab Control 

Use the Lab Control page to view and edit QC values for lab control sample (LCS) and lab 
control sample duplicate (LCSD) analyses. The EnviroLab Forms application makes the 
evaluation by comparing the calculated concentration for each compound in the sample to 
the theoretical concentration and range defined on this page. 

You can prepare samples (typically known as clean matrices) as LCS or LCSD. These 
represent samples to which you have added known concentrations of target analytes. To define 
an LCS and its duplicate in a batch, select the appropriate sample type and a common sample 
ID. 

On the Lab Control report, the EnviroLab Forms application flags the calculated values for 
spiked compounds that exceed these limits.

Figure 27. Lab Control page

Table 30. Lab Control parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Theo Conc Values for each lab control compound that represent the expected 
theoretical concentration of that compound in the sample. 

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the EnviroLab Forms application 
can determine by comparing the observed calculated concentration in 
the analysis to the expected concentration. Each LCS or LCSD 
compound can have its own values for these fields, independent of 
other LCS or LCSD compounds. 

Max recovery (%)

Max RPD Specifies a maximum value for relative percent difference (RPD) 
between two spiked samples. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 
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Display retention 
time column

Displays or hides the RT column in the compound list.

Delete compound 
from method

Removes the selected compound from the current master method.

Table 30. Lab Control parameters  (Sheet 2 of 2)

Parameter Description
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Meth Val 

Use the Meth Val page to view or edit QC values for method validation reporting. The 
EnviroLab Forms application makes the evaluation by comparing the calculated 
concentration for each compound in the sample to the theoretical concentration and range 
defined on this page. 

You can use these parameters to evaluate the performance of your method. For this evaluation, 
prepare, analyze, and evaluate a number of samples (typically 4 to 10) to document method 
accuracy and precision as a comprehensive whole. To define a method validation sample in 
the batch, select the appropriate sample type. 

On the Method Validation report, the EnviroLab Forms application flags the calculated values 
for method validation compounds that exceed these limits. 

Figure 28. Meth Val page

Table 31. Meth Val parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Theo Conc Values for each compound that represent the expected theoretical 
concentration of that compound in the sample. 

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that the EnviroLab Forms 
application can determine by comparing the observed calculated 
concentration in the analysis to the expected concentration. Each 
method validation compound can have its own values for these 
fields, independent of other method validation compounds. 

Max recovery (%)

Max RSD (%) The maximum relative standard deviation of the set of observed 
concentrations for a component across the set of method 
validation samples. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 
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Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 31. Meth Val parameters  (Sheet 2 of 2)

Parameter Description
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Breakdown 

Use the Breakdown page to view and edit values used for the evaluation of breakdown and 
degradation reporting. The EnviroLab Forms application makes the evaluation by calculating 
the ratio of breakdown compounds to the native compounds.

To display the list of compounds in a group

Click anywhere in the group row.

To select a group for breakdown calculation

Select the Active check box in the group row.

You can select any group in the method for breakdown calculation, but the EnviroLab 
Forms application calculates and reports only those that contain breakdown and native 
compounds.

Figure 29. Breakdown page

Table 32. Breakdown parameters

Parameter Description

Groups Lists all groups created on the Groups page. See “Editing the 
Groups Page” on page 136.

Active Specifies which groups are used for analysis.

Max % breakdown The maximum allowable percentage of breakdown to native 
compounds. This value is calculated by summing the responses of 
the breakdown compounds and dividing them by the sum of the 
native compounds. 

On the Breakdown Report, the EnviroLab Forms application flags 
the calculated values for breakdown and native compounds that 
exceed these limits.

Compounds for group Lists all compounds in the selected group.
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Blank 

Use the Blank page to define acceptable levels of target compounds in blank samples. The 
EnviroLab Forms application makes the evaluation by comparing the calculated 
concentration for each compound in the sample to the maximum concentration defined on 
this page. You can enter the maximum concentration as a percentage of a flag value or as a 
specified value. 

On the Blank report, the application flags the calculated values for target compounds that 
exceed these limits. 

To specify the maximum concentration as a percentage

1. From the Method column list box, choose one of the following methods:
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

To specify the maximum concentration as an absolute value

1. From the Method column list box, select Concentration.

2. In the Max Conc column, type an absolute value.

To specify no maximum concentration

From the Method column list box, select None. 

Figure 30. Blank page

Table 33.  Blank parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.
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ISTD 

Use the ISTD page to review the response and retention time of internal standards (if 
available). The EnviroLab Forms application makes the evaluation by comparing the area and 
retention time results for each internal standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or you have not identified 
any compounds as internal standards, this page does not show any values. 

Figure 31. ISTD page

Method The evaluation process used for comparing the calculated 
concentration. You can specify no maximum, a specific 
concentration, or a percentage of the LOR, LOD, or LOQ. 

Percentage The percentage of the LOR, LOD, or LOQ if you are using the 
percentage approach. 

Max Conc The maximum concentration if you are using an absolute value. 

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 34. ISTD parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Table 33.  Blank parameters  (Sheet 2 of 2)

Parameter Description
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Min recovery (%) The minimum and maximum percent recoveries for the internal 
standards to define an acceptable range. For check standards, the 
EnviroLab Forms application compares the response of each internal 
standard in each sample to a range around the average of the 
responses of that compound in all of the calibration standards. For all 
other samples, the application calculates the comparison range 
around the check standard responses if a check standard is available in 
the batch. If no check standard is available, the application tests 
against the initial calibration.

Max recovery (%)

Min RT (–min) The minimum and maximum drift (in minutes) for the internal 
standards to define an acceptable range. For check standards, the 
EnviroLab Forms application compares the retention time of each 
internal standard in each sample to a range around the average of the 
retention times of that compound in all of the calibration standards. 
For all other samples, the application calculates the comparison range 
around the check standard retention times if a check standard is 
available in the batch. If no check standard is available, the 
application tests against the initial calibration.

Max RT (+min)

CV Test (%) Coefficient of Variation test.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention 
time column

Displays or hides the RT column in the compound list.

Delete compound 
from method

Removes the selected compound from the current master method.

Table 34. ISTD parameters  (Sheet 2 of 2)

Parameter Description
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Solvent Blank 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The evaluation is 
made by comparing the calculated response for each compound in the sample to the 
maximum response defined on this page. 

On the Solvent Blank report, the EnviroLab Forms application flags the calculated values for 
target compounds that exceed these limits. 

Figure 32. Solvent Blank page

Table 35. Solvent Blank parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Method The evaluation process to use as a response for the quan ion only 
(Quan Ion RT) or a summed response for the quan ion and any 
confirming ions (All Ion RT). To deactivate the solvent blank test 
for a specific compound, select None. 

Upper Limit Specifies an upper limit for each compound in the sample if an 
evaluation process is selected. These values are not concentrations; 
they are raw response values.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Surrogate

Use the Surrogates page to view or edit QC values for surrogate reporting. The EnviroLab 
Forms application makes the evaluation by comparing the calculated concentration for each 
surrogate compound in the sample to the range defined on this page.

On the Surrogate report, the application flags the calculated values for surrogate compounds 
that exceed these limits. 

Figure 33. Surrogate page

Table 36. Surrogate parameters

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Theo Conc Values for each surrogate compound that represent the expected 
theoretical concentration of that compound in the sample. You 
can apply or not apply the dilution factor for a sample to the 
calculated surrogate concentrations using the Correct Surrogates 
option on the Reports page. See “Specifying Report Flag Options” 
on page 142.

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that can be determined by 
comparing the observed calculated concentration in the analysis to 
the expected concentration. Each surrogate can have its own values 
for these fields, independent of other surrogates. 

Max recovery (%)

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.
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Matrix Spike 

Use the Matrix Spike page to view or edit QC values for matrix spike and matrix spike 
duplicate analyses. The EnviroLab Forms application makes the evaluation by comparing the 
calculated concentration for each compound in the sample (after subtracting the original 
sample value) to the theoretical concentration and range defined on this page. 

To evaluate matrix spike (MS) or matrix spike duplicate (MSD) compounds, prepare samples 
as MS or MSD. These represent samples to which you have added known concentrations of 
target analytes. To define a sample, its MS, and its MSD in the batch, select the appropriate 
Sample Type and a Sample ID. 

On the MS/MSD report, the EnviroLab Forms application flags the calculated values for 
spiked compounds that exceed these limits. 

Figure 34. Matrix Spike page

Note  Sample IDs must be unique. Duplicating Sample IDs can cause incorrect samples to 
be included in reports.

Table 37. Matrix Spike parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Compound The compound name.

Theo Conc Values for each surrogate compound that represent the expected 
theoretical concentration of that compound in the sample. You 
can apply or not apply the dilution factor for a sample to the 
calculated surrogate concentrations using the Method Options.

Min recovery (%) A range of the allowable minimum recovery percentage and the 
maximum recovery percentage that can be determined by 
comparing the observed calculated concentration in the analysis to 
the expected concentration. Each surrogate can have its own values 
for these fields, independent of other surrogates. 

Max recovery (%)

Max RPD Specify a maximum value for relative percent difference (RPD) 
between two spiked samples. 
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Tune 

Use the Tune page to specify mass spectral comparison criteria according to EPA tune 
methods. Your master method must include one (and only one) compound specified as an 
MSTune compound type. The QAQC evaluation compares the mass list of the compound to 
the values in the tune method.

An MSTune sample contains Decafluorotriphenylphosphine (DFTPP) or 
bromofluorobenzene  (BFB) and is handled differently from other samples in the master 
method. The EnviroLab Forms application handles it as a qualitative examination of the mass 
spectrum of a specific compound rather than evaluating it on a quantitative basis.

Follow these procedures:

• To select an EPA tune method

• To manually submit a mass spectrum for tune evaluation

To select an EPA tune method

1. Click Method and choose a method from the list.

• For some methods, the Use Only Selected Method option is available.

• For some methods, the Perform Background Subtraction option is available.

The EnviroLab Forms application displays the mass spectral reference for the method.

Shortcut menu

Copy down Copies the selected column value to all rows in that column. For 
detailed instructions about using the Copy Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Display retention time 
column

Displays or hides the RT column in the compound list.

Delete compound from 
method

Removes the selected compound from the current master method.

Table 37. Matrix Spike parameters  (Sheet 2 of 2)

Parameter Description
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2. (Optional) Select the Use Only Selected Method check box.

The EnviroLab Forms application uses only the specified EPA tune method for tune 
criteria testing. 

If this option is not selected and the tune spectrum fails against the specified tune criteria, 
the EnviroLab Forms application performs the comparison against other EPA tune 
method criteria. The Tune report displays the pass/fail status of the tune spectra against 
all methods used for comparison.

3. (Optional) Select the Perform Background Subtraction check box.

• The 8000 and CLP series methods require background subtraction. 

• The 500 and 600 series do not require background subtraction but you can choose to 
use it.

The Tune report displays the retention time and scan range of the spectrum.

4. (Optional) Click Max Stepoff and use the spin box to select a number or type a number 
in the box.

The Max Stepoff field defines the maximum number of scans as the range before/after the 
Tune compound peak that is to be used for background subtraction. For example, a 
maximum stepoff of 1 means that the background spectrum is taken one scan before the 
left edge of the tune peak or one scan after the right edge of the tune peak. If using the left 
edge background spectrum fails the tune test, the system automatically tries the right edge 
of the spectrum. A maximum stepoff of 2 tries up to four tests using four different 
background spectrum: two scans before the left edge, one scan before the left edge, one 
scan after the right edge, and two scans after the right edge. EPA guidelines assign a 
maximum stepoff value of 20. 

Note  This Max Stepoff value is not related to the Stepoff Value parameter on the 
General page of the master method. The Stepoff Value on the General page applies 
only to the reference spectrum set for the master method and does not affect the Tune 
method.
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To manually submit a mass spectrum for tune evaluation

1. Click Select File and Mass Spectrum.

2. In the browser, select a raw data file and click Open.

The Thermo Xcalibur Qual Browser opens.

3. In the Qual browser, do the following:

a. Select the tune compound peak you want to use.

b. Select the background subtraction parameters to use and generate the mass spectrum.

For detailed instructions, refer to the Qual Browser documentation.

c. When the process is complete, choose View > Spectrum List.

d. Right-click the spectrum list and choose Export > Clipboard.

e. In the LabForms Tune page, click Create Tune Report as PDF.
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Figure 35. Tune page

Table 38. Tune parameters  

Parameter Description

Tune parameter

Tune Compound Compound specified as a tune compound in the Identification 
page. See “Identification” on page 81.

Method Environmental Protection Agency (EPA) methods used for tuning.

Use only selected 
method

Specifies that the EnviroLab Forms application use only the 
specified EPA tune method for tune criteria testing. 

Perform background 
subtraction

Specifies that the EnviroLab Forms application average and 
subtract the mass spectra as specified in the background 
subtraction settings on the General page for the master method. 
See “To set automated background subtraction options” on 
page 72.

Max stepoff Specifies the maximum number of scans as the range before and 
after the Tune compound peak to be used for background 
subtraction.

Ad Hoc Tune Report

Select file and mass 
spectrum

Opens a browser where you can select a raw data file to use for the 
tune report.

Create tune report as 
PDF

Creates an ad hoc tune report using the mass spectrum data saved 
on the clipboard.
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Editing the Groups Page 

Use the Groups page of the Master Method View to organize compounds into functional or 
logical groups. You can use these groups for creating a subset of target compounds for 
quantitative processing or a list of non-quantitative compounds for breakdown processing.  
See “Groups page” on page 137.

For quantitative processing, the EnviroLab Forms application processes all compounds in the 
method and stores the complete result set, but only those in the selected group are visible in 
Production mode. Limiting the displayed compounds to those in the selected group can be 
useful when working with a master method containing a large list of compounds, only some 
of which are required for analysis in certain samples. In that case, the application requires only 
a single method and can reduce the results. To display only those compounds to be used in 
quantitative processing, select Quan Compounds from the Show list box. 

For non-quantitative processing, you can select the Breakdown and Native compounds that 
the EnviroLab Forms application uses for breakdown reporting. To view only those 
compounds to be used in non-quantitative processing, select Non Quan Compounds from 
the Show list box. 

You can create as many quantitative and non-quantitative groups as you want and the same 
compound can be included in multiple groups. 

To create a group

1. From the Show list box, select the type of compounds you want to view.

2. At the bottom of the Groups area, click Add Group.

The Add a New Group dialog box opens.

3. Type a name for the new group and click OK.

The new group appears in the Groups area.

4. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

5. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose from the shortcut menu.
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6. To remove a single compound, click the compound name in the group, right-click, and 
choose Remove from Group from the shortcut menu.

Figure 36. Groups page

Table 39. Groups parameters  

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a New Group dialog box where you can create a 
new group.

Shortcut menu

Empty group Removes all compounds from the selected group.

Rename group Changes the name of the selected group.

Delete group Removes the selected group and all the compounds in it.

Remove from group Removes the selected compound from its group.
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Editing the Reports Page

Use the Standard Reports and Custom Reports pages to specify how you want to save or print 
your reports. 

For the Quantitation Report type, you can modify quan report, user interface, quan flag, and 
surrogate correction options in the Report Options pane. 

This section includes instructions for the following tasks:

• Specifying Report Formats

• Specifying Report Flag Options

Specifying Report Formats

For each standard report you generate, you can create a hardcopy printout, a PDF file, or an 
XML file. In addition to the report type, you can specify a report title for each of your reports. 
The default report title is the report name.

For each custom report you generate, you can create a hardcopy printout or an XLS (.xlsm) 
file. You cannot specify a report title for a custom report. 

Follow these procedures:

• To specify standard report types and output formats

• To specify custom report types and output formats

To specify standard report types and output formats

1. Click the Standard Reports tab.

The Standard Reports page displays the Report Name, Report Title, and the options to 
create a hardcopy, a PDF file, or an XML file. See “Standard Reports page” on page 140.

2. To edit the Report Title, double-click the name and type your new name.

The EnviroLab Forms application uses this name for all reports that use this master 
method. You cannot edit the Report Title from other report views.

3. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

4. To duplicate the output type for all reports, click the cell to select it, then right-click and 
choose Copy Down from the shortcut menu.
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All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell.

By default, all report types are cleared.

To specify custom report types and output formats

1. Click the Custom Reports tab.

The Custom Reports page lists all the reports that are saved in the following folder:

..\Thermo\EnviroLab Forms\Templates\Reports

The Custom Reports page displays the Report Name and the options to create a hardcopy 
printout or XLS file. See “Custom Reports page” on page 141.

2. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

3. To duplicate the output type for all reports, right-click the cell and choose Copy Down 
from the shortcut menu. 

All check boxes in the column below the selected cell duplicate the selected or cleared 
state in the selected cell.
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Figure 37. Standard Reports page
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Figure 38. Custom Reports page

Table 40. Standard Reports parameters  

Parameter Description

Example Displays a sample of the report type.

Report Name The name of a report. 

Report Title The user-defined title to be used on a report. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 

Create XML Reports to be exported in XML format. 

Table 41. Custom Reports parameters

Parameter Description

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create XLS Reports to be exported in Excel spreadsheet (.xlsm) format. 
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Specifying Report Flag Options

Use the report options to choose parameters for flagging values and displaying information in 
standard report types.

Follow these procedures:

• To specify quantitation limits

• To specify user interface options

• To specify quantitation flag options

• To correct surrogates

• To track the use of the tune file

To specify quantitation limits

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
Concentration list box.

These concentration limits are defined in “Limits” on page 117. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal Places to be Reported box.

3. To include a chromatogram of the sample in the report, select the Show Chromatogram 
on Quantitation Report check box.

4. To display only valid compounds, select the Display Valid Compounds Only check box.
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To specify user interface options

1. To shade a compound row on any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade Row when Sample is Outside of Evaluation Criteria check 
box.

2. To separate the ion overlay pane from the confirming ion plots, select the Separate Ion 
Overlay Display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of 7 calibration standards, select the Use Alternate 
Calibration Report Format check box.

4. To display flags and a legend on high density reports, select the Display Quan Flags and 
Legend check box.

To specify quantitation flag options

Select the values you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear on a variety of reports and are defined in the Report options 
parameters table.
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To correct surrogates

Select the Correct Surrogates check box.

The EnviroLab Forms application applies the conversion factor (specified in the sample 
row in the batch) to the sample’s calculated concentrations for surrogates as the 
conversion factor is applied to target compounds.

To track the use of the tune file

1. Select the Enable Tune Time Tracking check box.

This option tracks the number of hours between the last instrument tune and each 
sample acquisition.

2. Click the Tune File Lifetime spin box and set the number of hours you want to allow 
between the last instrument tune and a sample acquisition. 

Any sample acquired outside this maximum allowable time is flagged on the Batch report. 

Figure 39. Report Options
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Table 42. Report options parameters  (Sheet 1 of 2)

Parameter Description

Quan Limits Flags

Report concentration Reports the concentration at all times or only when the quantified 
value exceeds either the limit of detection (LOD), the limit of 
quantitation (LOQ), or the limit of reporting (LOR). Report 
concentration: Always, >LOD, >LOQ, or >LOR.

Decimal places to be 
reported

Number of decimal places to be included in the report. Maximum 
value is 6.

Show chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample on the 
quantitation report. 

Display valid 
compounds only

Prints only the positive compounds in a sample. If a compound is 
valid within a sample and is above the specified Quan Flag 
Options limits, the EnviroLab Forms application reports the 
compound.

User Interface Options

Shade row when 
sample is outside of 
evaluation criteria

Shades a compound row on any of the reports if a value fails one of 
the criteria used for evaluation. 

Separate ion overlay 
display

Separates the ion overlay pane from the confirming ion plots in 
data review. 

Use alternate 
calibration report 
format

Uses an alternate format for the Calibration Report that is 
designed to print more concisely (this report is limited to a 
maximum of 7 calibration standards). 

Display Quan flags and 
legend

Displays manual flags, confirming manual flags, quan flags, and a 
legend on high density reports.

Quan Flag Options
Values that are above or below limits defined on the Limits page. 
These flags appear on a variety of reports. 

Flag values below LOD Flags values below the limit of detection (LOD).

Flag values below LOQ Flags values below the limit of quantitation (LOQ).

Flag values above LOR Flags values above the limit of reporting (LOR).

Flag values above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag values above 
Carryover

Flags values above the carryover limit.

Flag values between 
LOD and LOQ

Flags values between the limit of detection and the limit of 
quantitation known as the J flag.
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Surrogate Correction 
Option

Correct surrogates Applies the conversion factor (specified in the sample row in the 
batch) to the sample’s calculated concentrations for surrogates as 
the conversion factor is applied to target compounds. For example, 
if you added surrogates to the sample as part of sample preparation 
and you require a dilution for analysis, the EnviroLab Forms 
application dilutes the surrogates and target compounds and 
applies a dilution correction to correct for this dilution. However, 
if you added surrogates after a dilution has occurred, then you can 
leave the option cleared, so that while the target compounds are 
corrected for the dilution, the surrogates are reported ‘as is.’ 

Tune Time Tracking 
Options

Enable tune time 
tracking

Tracks the number of hours between the last instrument tune and 
each sample acquisition.

Tune file lifetime Specifies the maximum number of hours between the last 
instrument tune and a sample acquisition. Any sample acquired 
outside this maximum allowable time is flagged on the Batch 
report.

Table 42. Report options parameters  (Sheet 2 of 2)

Parameter Description
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Creating a Method Template

In the EnviroLab Forms application, you can create a processing method using a method 
template that contains the basic settings as defined by a user in the role of Manager or 
Supervisor. 

Follow these procedures:

• To create a method template

• To specify peak criteria

• To choose a library

• To specify confirming ions

• To calibrate the compounds

• To enter a note for the method

• To save the method template

To create a method template

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click Method View in the navigation pane.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens. See “Method Template Editor” on page 152.
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To specify peak criteria

1. In the Find the Peaks area, choose a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The High (ICIS) peak detection algorithm is designed for MS data and has superior 
peak detection efficiency at low MS signal levels. 

• The Standard (Genesis) peak detection algorithm is provided for backward 
compatibility with Xcalibur 1.0 studies. 

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that will result in compound selection, select the Enable Peak Threshold 
check box.

To consider a peak for a processing method, the EnviroLab Forms application uses the 
Enable Peak Threshold filter to determine which peaks meet the specified percentage of 
the largest peak.

4. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and choose the number of peaks to display.
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To choose a library

1. In the Use these Libraries box, select the libraries you want to search.

All libraries loaded on your instrument are displayed in the Use these Libraries box. 

2. To limit the number of hits returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, choose a value from the Best Match Method 
list box.

To specify confirming ions

1. To set the number of confirming ions, select the Include Confirming Ions check box 
and set a value in the Number of Confirming Ions box.

This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. This value defaults to 2 because you typically perform a 3-ion experiment 
with one quan mass and two confirming ions. 

The system selects the most intense ion to use as the quantitation mass and uses this mass 
for the mathematical operations. 
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2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
Default Ion Ratio Ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming ion peak 
and the quantification ion peak, set a value in the Ion Coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

Use this setting to perform a spectra comparison in Production mode. 

To calibrate the compounds

1. From the Calibration method list, select Internal or External.

2. From the Curve type list, select one of the following:

• Linear: All other settings are available with this exception: When Include is selected 
in the Origin list, all weighting values are unavailable except for Equal.

• Quadratic: All other settings are available with this exception: When Include is 
selected in the Origin list, all weighting values are unavailable except for Equal.

• Average RF: No selections in the Weighting or Origin lists are available. The 
Weighting list is set to Equal, and the Origin list is set to Ignore. 

3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.
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4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response via list, choose Area or Height.

• Area: Specifies that the EnviroLab Forms application use this area value in response 
calculations.

• Height: Specifies that the EnviroLab Forms application use this height value in 
response calculations. 

To enter a note for the method

Type in the Notes box, or paste text from another application using CTRL-V.

You can add a note to your method template so that there is a record of what makes this 
template unique. 

To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

• Type a new name for the master method and click OK.

–Or–

• Select a method name to overwrite and click Overwrite.

The EnviroLab Forms application saves the new method template in the following folder:

..\Thermo\EnviroLab Forms\Templates\Methods 
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Figure 40. Method Template Editor
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Table 43. Method Template Editor parameters  (Sheet 1 of 3)

Parameter Description

Find the peaks

Sensitivity Defines how extensively the peak detector algorithm searches for 
low-level peaks. 

Limit the retention time 
range

Min RT specifies the beginning of the range. Max RT specifies 
the end of the range. 

Enable peak threshold Specifies whether to select peaks by relative height or area and 
the percentage of the highest peak that will result in compound 
selection.

Only select top peaks Displays a specific number of the largest peaks by height or area.

Identify the peaks

Use these libraries Lists the libraries you can search.

Limit library hits Specifies the number of hits returned when the system searches a 
spectrum against the selected libraries.

Best match method Specifies how to sort the library searches.  
Valid values: Search Index, Reverse Search Index, Match 
Probability

Handle confirming ions

Include confirming ions/ 
Number of confirming 
ions

Specifies the number of confirming ions, which are other ions in 
the spectrum whose ratio is compared to the quantitation ion to 
identify the compound.

This value defaults to 2 because you typically perform a 3-ion 
experiment with one quan mass and two confirming ions.

Specify default ion ratio 
ranges

Enables the ion ratio range features.

Ion coelution specifies the maximum difference in retention time 
between a confirming ion peak and the quantification ion peak. 

Window type specifies an Absolute or Relative calculation 
approach for determining the acceptable ion ratio range.

Window (+/-%) specifies the acceptable ion ratio range.

Include compound peak 
spectrum as reference 
spectrum

Includes the peak spectrum in the processing method. Use this 
setting to perform a spectra comparison in Production. 

Calibrate the compounds

Calibration method Specifies an internal or external calibration method.

Curve type Specifies a linear, quadratic, or average RF curve type.
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Origin Specifies that the origin is ignored, forced, or included in the 
generated calibration curve.

• Ignore: Specifies that the origin is not included as a valid 
point in the calibration curve when the curve is generated. 
When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the 
origin of the data point plot when the calibration curve is 
generated.

• Include: Specifies that the origin is included as a single data 
point in the calculation of the calibration curve. When you 
select Include, the calibration curve might or might not pass 
through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data 

point in the calculation of the calibration curve. When you 
select Equal, the calibration curve might or might not pass 
through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data 
points during the least-squares regression calculation of the 
calibration curve. Calibrants are weighted by the inverse of 
the square of their response (or response ratio). 

Response via Specifies if the EnviroLab Forms application uses area or height 
in response calculations.

• Area: Specifies that the application use this peak area value in 
response calculations.

• Height: Specifies that the application use this peak height 
value in response calculations. 

Table 43. Method Template Editor parameters  (Sheet 2 of 3)

Parameter Description
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Qualitative Peak 
Processing

ISTD matching  
(+/- min)

Excludes all the target compounds found in the method and does 
not list these compounds in the TIC Report or in the Qual 
Mode view in the Data Review.

Exclude matching quan 
peaks

Compares the retention time of the internal standard in the 
method to the found retention time of the internal standard in 
the library search and excludes peaks outside the range.

Table 43. Method Template Editor parameters  (Sheet 3 of 3)

Parameter Description
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Exporting SRM Data

In the EnviroLab Forms application, you can export your selected reaction monitoring (SRM) 
data to an XML file.

To export SRM data to an XML file

1. Open the master method from which you want to export SRM data.

2. From the Method View task pane, click Export SRM Data. 

The EnviroLab Forms application writes the data in the SRM table to the following file:

..\Thermo\EnviroLab Forms\Methods\methodname.xml

The data in this file matches the TSQ .xml data and can be used in the instrument 
method editor when you use the TSQ application.

Note  This command is available only when you check the Enable Compound 
Datastore option on the General page on the Application Configuration view. See 
“Application Configuration” on page 35.

SRM TSQ Quantum™ example
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Working with Instrument Methods
An instrument method is a set of experiment parameters that define the operating settings for 
an autosampler, gas chromatograph (GC), mass spectrometer, and so on. Instrument methods 
are saved as file type .meth.

Follow these procedures:

• To open the Instrument View

• To create a new instrument method

• To open an instrument method

To open the Instrument View

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. Click the Instrument View task pane.

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration tool while 
the EnviroLab Forms application is running.
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To create a new instrument method

1. Click New Instrument Method in the Instrument View task pane.

The Thermo Xcalibur Instrument Setup opens.

This example instrument setup shows multiple configured instruments.

2. Click the icon for the instrument you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu on Thermo Xcalibur Instrument Setup, choose File > Save As.

The Save As dialog box opens.
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5. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

6. (Optional) Type a comment about the new instrument method.

7. Click OK.

The EnviroLab Forms application saves the new instrument method in the following 
folder:

..\Xcalibur\methods
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To open an instrument method

1. Click Open Instrument Method on the Instrument View task pane.

An instrument method browser opens.

2. In the browser, select an instrument method from the list and open the file.

The selected method opens in the Thermo Xcalibur Instrument Setup. You can edit this 
method and save the changes, or you can save this method to another name.

This example instrument setup shows multiple configured instruments.

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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Working with Development Batches 
In the Development Batch view, you can test your instrument method in real time by creating 
and acquiring test samples. Development batches let you test different instrument methods 
and optimize parameters, such as MS source parameters and autosampler variables, to find the 
best conditions for a master method. Development batches are not designed for high 
throughput in everyday analysis.

This section includes instructions for the following tasks:

• Creating a Development Batch

• Editing Samples in a Development Batch

• Acquiring Samples in a Development Batch

Creating a Development Batch

You create a development batch to test your instrument method and use it to acquire samples 
only once. You cannot save a development batch. 

Follow these procedures: 

• To open the Development Batch view

• To specify a location for development batch data

• To add samples to the development batch

• To insert samples into the development batch

• To copy a sample

To open the Development Batch view

1. Click Method Development from the dashboard or the navigation pane.

The Method Development navigation pane opens.

2. In the Method Development navigation pane, click Development Batch.

The Development Batch view opens a new, empty batch.
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To specify a location for development batch data

1. To specify a location for the files, click Select Batch Location in the Development Batch 
task pane.

By default, the EnviroLab Forms application writes the temporary files, raw data files, and 
.sld method file to the following folder:

../Thermo/EnviroLab Forms/Temp

2. In the browser, do one of the following:

• Locate the folder you want to use for the development batch files and click OK.

–Or–

• Do the following:

a. Locate and select the folder where you want to create a new folder for the batch 
files.

b. Click Make New Folder.

The EnviroLab Forms application creates a new folder in the selected folder.

c. Right-click the New Folder filename and choose Rename from the shortcut 
menu.

d. Type the name for the folder.

e. Click OK.

The EnviroLab Forms application creates all development batch files in the specified 
folder.

To add samples to the development batch

Do one of the following:

• Right-click and choose Add Sample from the shortcut menu.

–Or–

• Use the spin box to select the number of rows and click the Add Sample icon to add 
multiple sample rows.

New, empty samples appear at the end of the sample list.
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To insert samples into the development batch

1. Select the sample above which you want to insert empty samples.

2. Do one of the following:

• Right-click and choose Insert Sample from the shortcut menu.

–Or–

• Use the spin box to select the number of rows and click the Insert Sample icon to 
insert multiple sample rows.

The EnviroLab Forms application inserts new, empty samples above the selected sample.

Note  You cannot insert samples into an empty batch. You must have at least one 
sample to select before you can use this icon.

To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The EnviroLab Forms application adds a copy of the sample above the selected sample. 

Figure 41. Completed Development Batch
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Editing Samples in a Development Batch

A development batch requires fewer parameters than a real batch, but the mechanism for 
managing the information is the same.

For detailed instructions about using the Copy Down or Fill Down commands to enter 
column values, see Appendix B, “Using Copy Down and Fill Down.” 

Follow these procedures:

• To enter column values

• To resize or reorganize the columns

• To remove selected samples from the list

• To remove all samples from the list

To enter column values

1. Double-click the Filename column and type a file name for the raw data file.

2. (Optional) Enter values for the Sample Name, Sample ID, or Comment columns.

3. Enter a vial position for each sample.

4. Enter an injection volume for each sample.

The minimum injection volume value allowed is 0.05 μL.

5. To enter an instrument method for each sample, click the down arrow in the Instrument 
Method column and select a method from the list.

This list contains all the available instrument methods.

To resize or reorganize the columns

1. To resize a column, drag the header separator on the right side of the column.

2. To move a column, drag the column header.

You cannot move the Filename column.
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To remove selected samples from the list

1. Select the samples you want to remove.

Ensure that the first column indicates that the samples are selected.

Selected samples

2. Right-click and choose Remove Selected Samples from the shortcut menu.

To remove all samples from the list

1. Click New Sample List in the Development Batch task pane.

2. One of the following happens:

• If the samples in the current batch have all been acquired, the list is cleared.

• If the samples in the current list have not been acquired, a message confirms that you 
want to clear them and start a new list. 

3. To create a new empty list, click Yes.

Note  You cannot save a development batch when you create a new one; you can only 
create, acquire, and discard each batch after you use it. The EnviroLab Forms 
application saves only the generated raw files in the specified batch location.
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Acquiring Samples in a Development Batch

In a development batch, you can submit the entire batch for acquisition or submit only 
selected samples.

Follow these procedures:

• To acquire selected samples

• To acquire the batch

• To open the Qual Browser

To acquire selected samples

1. Select the samples you want to acquire.

2. Right-click and choose Submit Selected Samples from the shortcut menu, or click the 
 
Submit Selected Samples icon, .

The EnviroLab Forms application creates a raw data file for each selected sample. It writes 
the raw files and all temporary working files to the following folder:

../Thermo/EnviroLab Forms/Temp

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.

To acquire the batch

Right-click and choose Submit Batch from the shortcut menu, or click the Submit 
Batch icon, .

The EnviroLab Forms application creates a raw data file for each sample in the batch and 
a .sld method file. The EnviroLab Forms application writes the raw data files, the .sld 
method file, and all temporary working files to the specified folder.

When the acquisition is complete, the application deletes all the temporary working files. 
Only the raw files and a MethodDevelopment.sld file remain in the folder.

If a sample is acquired more than once, the subsequent raw data files are time-stamped 
with the acquisition time.
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To open the Qual Browser

In the Development Batch task pane, click Open Qual Browser.

The Thermo Xcalibur Qual Browser opens.

For detailed instructions about using the Qual Browser, refer to the Qual Browser Help. 
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Using the Production Mode 

This chapter includes instructions for using the features of the Production mode.

From the Production mode, you can create and review batches, review batch data and reports, 
and edit local methods.

To access the Production mode

Click Production from the dashboard or the navigation pane.

The Production navigation pane opens. 

Contents

• Working in Batch View

• Working in Data Review

• Working in Report View

• Working in the Local Method View
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Figure 42. Production navigation pane

Table 44. Production navigation pane functions  

Functions Description

Batch View See “Working in Batch View” on page 171.

New batch Opens a new, unnamed batch with one Unknown sample. See 
“Creating a New Batch” on page 171.

Open batch Opens the Open Batch dialog box where you can select a saved 
batch to edit. “Editing a Batch” on page 176.

Recent Files Displays recently saved batches.

Data Review See “Working in Data Review” on page 207.

Report View See “Working in Report View” on page 239.

Local Method See “Working in the Local Method View” on page 258.
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Working in Batch View
From the Batch view, you can manually create and edit a new batch or open and edit a 
previously saved batch. You can also use a batch wizard to define a sequence of various sample 
types to be assembled into a batch of samples. When you submit a batch, you can acquire, 
process, or create reports for the submitted samples. 

This section contains information about the following tasks:

• Creating a New Batch

• Editing a Batch

• Submitting a Batch

• Using a Batch Template

• Creating a Batch Using the Batch Wizard

• Specifying Sample Types

Creating a New Batch

From Batch view, you can create a new batch.

Follow these procedures:

• To create a batch

• To add samples to the list

• To insert samples into the list

• To import samples into the list

• To copy a sample

• To re-inject a sample

• To edit column values

• To rearrange the columns

• To remove samples from the list
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To create a batch

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. In the Batch View task pane, choose New Batch or choose File > New > Batch.

A new, unnamed batch opens with one Unknown sample. You must choose a master 
method before you can save your new batch.

3. Choose a master method from the Method list. 

4. Choose File > Save > Batch.

The Batch Save dialog box opens.

5. Select a project and a subproject and enter a name for your new batch.

Tip  To enable the Save button, you must select a subproject and enter a unique batch 
name. If the Save button is not enabled, either you have entered a name that is already 
used or you have not selected a subproject.

6. Click Save.

To add samples to the list

Right-click the sample list pane and choose Add Sample from the shortcut menu, or use 
the Add Sample icon to add multiple sample rows.

Add Sample icon

The EnviroLab Forms application adds the specified number of new, empty samples to 
the end of the sample list.
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To insert samples into the list

1. Select the sample above which you want to insert empty samples.

2. Right-click the sample list pane and choose Insert Sample from the shortcut menu, or 
use the Insert Sample icon to insert multiple sample rows.

Insert Sample icon

The new, Unknown samples are inserted above the selected sample.

To import samples into the list

1. Click Import.

The Sample Import Tool dialog box opens.

From this dialog box, you can import samples from a .csv file or .xml file.

2. Click Browse and select a .csv or .xml file that contains the samples you want to import.

3. From the Imported Samples Will be list, select Appended to the End of the List or 
Inserted at the Selected Row.

4. Click Import.

The Sample Import Tool dialog box closes and the EnviroLab Forms application adds the 
specified samples to the Samples list. 
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To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The EnviroLab Forms application inserts the copy above the selected sample.

To re-inject a sample

1. From the Samples list, select the sample you want to re-inject.

2. Right-click and choose Reinject this Sample from the shortcut menu.

The EnviroLab Forms application creates a copy of the selected sample and appends 
INJ001 to the file name. Additional re-injections of the same sample are numbered 
INJ002, INJ003, and so forth.

The EnviroLab Forms application copies all parameter values from the original sample.

To edit column values

1. For each sample, double-click the Filename column (or right-click and choose Browse in 
Raw File from the shortcut menu) and locate the raw data file to use for the sample. 

You can also browse in multiple raw data files to create multiple samples.

2. For each added sample, click the Sample Type column and select a sample type from the 
list.

Available ELF sample types

3. For each Cal Std or Chk Std sample, click in the Sample Level cell and select a level from 
the list.

The sample levels were defined in the master method. If there is nothing to select in the 
Sample Level list, do the following:
a. Return to the Method Development mode.
b. Open the method.
c. Click the Compounds tab.
d. Click the Calibration Levels tab.
e. Add the levels.
f. Save the method.
g. Return to the Production mode, and begin this batch again.

You must close your original batch without saving and start a new batch. For detailed 
instructions, see Chapter 4, “Using the Method Development Mode.” 

Matrix Blank Solvent MS MDL

Cal Std Breakdown MSD Unknown

Chk Std Tune Tune/Breakdown Unknown/TIC

LCS LCSD Meth Val
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4. Enter or edit the values for the remaining columns.

When you use the scroll bar at the bottom of the Samples list, the Status and Filename 
columns remains fixed and only the other columns scroll right and left. 

For instructions on automatically copying or filling values in these columns, see 
Appendix B, “Using Copy Down and Fill Down.” 

To rearrange the columns

Do one of the following:

• To resize a column, drag the header separator on the right side of the column.

• To move a column, drag the column header.

When you close the EnviroLab Forms application, it saves the new column order and 
width.

Note  The Status and Filename columns can be swapped with each other, but they 
cannot be moved to any other location in the table.

To remove samples from the list

1. Select the samples you want to remove.

Ensure that the first column indicates that the samples are selected.

Selected samples

2. Right-click and choose Remove Selected Samples from the shortcut menu, or click the 
Remove Samples icon, .
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Editing a Batch

In Batch view, you can open a saved batch and edit the list of samples. You can add, edit, or 
remove samples. If the batch has already been acquired, you can select specific samples for 
re-injection. 

Follow these procedures:

• To open a saved batch

• To edit column values

• To re-inject a sample from a previously acquired batch

• To submit all samples in the batch

• To submit selected samples

To open a saved batch

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. In the Batch View task pane, click Open Batch or choose File > Open > Batch.

The Open Batch dialog box opens where you can select a saved batch.

3. Select either Open ELF 3.0 Batches or Open ELF 2.5 Batches.

• To open a ELF 3.0 batch, go to Step 4.

• To open a ELF 2.5 batch, go to Step 5.

4. To open a ELF 3.0 batch, do the following:

a. Select a project from the list of projects.

b. Select a subproject from the list of subprojects.
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c. Select a batch from the list of batches.

d. Click Open.

5. To open an ELF 2.5 batch, do the following:

a. Select a batch from the list of batches.

b. Click Open.

c. Edit the batch as you would any other batch.

You cannot submit the batch for processing until you save it.

d. To save the batch, choose File > Save > Batch or click the Save icon, .

A text message informs you that the master method and instrument method for the 
batch will also be imported.

e. Click OK to dismiss the text message and continue saving the batch, or click Cancel 
to terminate the Save process.

The Batch Save dialog box opens.
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f. Select a project and subproject where you will save the batch.

g. Type a name for the batch.

h. Do one of the following:

• Type a new name for the batch and click OK.

       –Or–

• Select a batch name to overwrite and click Overwrite.

To open a batch from the Recent Files list

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

When you save a batch, it is added to the Recent Files list. The Recent Files list displays a 
list of your most recently saved batches.

2. Click the batch name in the Recent Files list. Do not double-click.

The selected batch opens in the Batch View.

To edit column values

1. Type a file name in the Filename column for each sample, or right-click and choose 
Browse in Raw File from the shortcut menu. 
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You can also browse in multiple raw data files to create multiple samples.

2. Select a sample type from the Sample Type list box for each sample. 

Available ELF sample types

For a detailed description of sample types, see “Specifying Sample Types” on page 205.

3. For each Cal Std or Chk Std sample, select a level from the Sample Level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample Level list, ask a user with Supervisor or Manager permissions to edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

4. Type a vial position in the Vial Position column for the new sample. 

5. Type a volume in the Injection Volume column for the new sample. 

The minimum injection volume value allowed is 0.05 μL.

To re-inject a sample from a previously acquired batch

1. From the Samples list, select the sample you want to re-inject.

2. Right-click and choose Reinject this Sample from the shortcut menu.

The EnviroLab Forms application creates a copy of the selected sample and appends 
INJ001 to the file name. Additional re-injections of the same sample are numbered 
INJ002, INJ003, and so forth.

The EnviroLab Forms application copies all parameter values from the original sample.

Previously acquired samples are indicated with a green status indicator (acquired and 
processed) and are grayed out. Samples created for re-injection are indicated with a blue 
status indicator (not acquired).

3. To save this batch with the new samples for re-injection, choose File > Save > Batch from 
the main menu.

Matrix Blank Solvent MS Unknown

Cal Std Breakdown MSD LCS

Unknown/TIC Tune Tune/Breakdown MDL

Chk Std LCSD Meth Val
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Figure 43. Batch View page

 

Table 45. Batch View parameters  (Sheet 1 of 2)

Parameter Description

Method Method to use for acquiring or processing the batch.

Instrument Instrument specified in the method used for the batch.

Column values

Status • Orange for samples that are currently acquiring
• Blue for samples that have not been acquired
• Yellow for samples that have been acquired and not 

processed
• Green for samples that have been acquired and processed

Filename Name of the raw data file that contains the sample data.

Sample type Defines how the EnviroLab Forms application processes the 
sample data. Each sample is classified as one of the following 
sample types: Matrix Blank, MDL, Solvent, Cal Std, MSD, 
Breakdown, Unknown, Unknown/TIC, Chk Std, MS, LCS, 
LCSD, Meth Val, Tune, or Tune/Breakdown

Sample level The level defined for a calibration sample or quality control 
sample.

Sample ID A user-defined alphanumeric string that identifies a sample.

Sample name A user-defined name that identifies a sample.

Vial Position The tray vial number used for the autosampler acquisition.
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Injection volume The injection volume in microliters of sample to be injected. 

Minimum value: 0.05

When you are using an autosampler, you can set the default 
injection volume in the autosampler dialog box in the 
Instrument View. The minimum and maximum injection 
volumes that you can use depend on the autosampler you 
configure. The usable range depends on the injection mode and 
might be smaller than the range displayed.

Conv Factor Adjustment made to the injected concentration.

Comment A user-defined comment for the sample.

Shortcut menu 
commands

Add sample Adds a single empty row to the sample grid.

Insert sample Inserts a single empty row to the sample grid above the selected 
row.

Insert copy sample Copies the currently selected row and inserts a copy above the 
row.

Reinject this sample Creates a copy of the selected sample and appends INJ001 to the 
file name. Additional re-injections of the same sample are 
numbered INJ002, INJ003, and so forth.

Remove selected samples Removes selected samples from the sample grid.

Import samples Opens the Sample Import Tool. Follow the instructions “To 
import samples into the list” on page 173.

Submit selected samples Submits all selected samples to be acquired or processed.

Submit batch Submits all samples in the batch to be acquired or processed.

Browse in raw file Opens a dialog box where you can select a raw data file to use for 
the selected sample row. You can also browse in multiple raw 
data files to create multiple samples.

Table 45. Batch View parameters  (Sheet 2 of 2)

Parameter Description
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Submitting a Batch

In Batch view, you can submit an entire batch or only selected samples in the batch. When 
you submit a batch, you can choose to acquire, process, or create reports for the submitted 
samples.

To submit all samples in the batch

1. Do one of the following:

• Right-click and choose Submit Batch from the shortcut menu.

–Or–

• Click the Submit Batch icon, .

2. From the Submit Options dialog box, select if you want to process data and create reports 
in addition to acquiring the samples.

• You can choose to process samples that have already been acquired. 

• You can choose to acquire and process unacquired samples (including re-injections).

• You can choose to create reports for all submitted samples. 

3. Click OK. 

To submit selected samples

1. Select the samples you want to submit.

2. Do one of the following:

• Right-click and choose Submit Selected Samples from the shortcut menu.

–Or–

• Click the Submit Selected Samples icon, .

3. From the Submit Options dialog box, select if you want to process data and create reports 
in addition to acquiring the samples. 

• You can choose to process samples that have already been acquired. 

• You can choose to acquire and process unacquired samples (including re-injections).

• You can choose to create reports for all submitted samples.

4. Click OK.
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Observing the Real-time Display

You can access the real-time display from the dashboard and from any mode in the EnviroLab 
Forms application.

To access the real-time display from the dashboard

Click Real Time Status.

The real-time status displays at the bottom of the dashboard.

To access the real-time display from any of the modes

Click Real time status.

The real-time status displays at the bottom of the current view.

The real-time status display has four additional pages of information:

• Acquisition Page

• Instrument Page

• Devices Page

• Queues Page 
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Figure 44. Acquisition page

Figure 45. Instrument page

Table 46. Acquisition Queue functions  

Function Description

Start button starts an acquisition. 

Stop button stops the acquisition for the current sample and 
begins the next sample in the batch.

Pause button pauses the batch queue. Use the Start button to 
restart a paused acquisition.
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Figure 46. Devices page

Figure 47. Queues page
Thermo Scientific EnviroLab Forms 3.0 User Guide         185



5  Using the Production Mode
Working in Batch View
Using a Batch Template

Batches are created as a routine operation and, because the nature and types of batches are 
often similar (in some cases specified by laboratory operating procedure), you can define a 
batch template that supplies the basic structure of a batch. 

To create a new batch template

1. Choose New > Batch Template from the application menu.

The Open Method dialog box opens where you can select a master method to use for 
your template.
PF

2. Select a master method and open the file.

The Batch Template Editor opens. See “Batch Template Editor” on page 190.

The editor uses the selected master method for the template.

To open a batch template

1. Choose File > Open > Batch Template from the main menu.

The Open Batch Template dialog box opens.

2. Select the set of batch templates you want to use.

The EnviroLab Forms 3.0 application lets you use LabForms 2.5 batch templates. 
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3. Select a batch template and open the file.

The Batch Template Editor opens. See “Batch Template Editor” on page 190. 

To specify template information

1. From the Project list, select a project name.

2. From the Subproject list, select a subproject name.

Tip  If there are no projects or subprojects to choose, go to the Project Administration 
view of the Configuration mode and create a new subproject. See “Project 
Administration” on page 26.

3. To change the current method, click Select Method and select a new method.

To add a sample to the list

Right-click the sample list pane and choose Add Sample from the shortcut menu, or click 
the Add Sample icon, . 

The EnviroLab Forms application adds a new, Unknown sample to the end of the 
Samples list. 

To insert a sample into the list

1. Select the sample above which you want to insert a new, Unknown sample.

2. Right-click the Samples list pane and choose Insert Sample from the shortcut menu.

The new, Unknown sample is inserted above the selected sample.

Inserted 
sample

To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The EnviroLab Forms application inserts the copy above the selected sample.
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To remove samples from the list

1. Select the sample you want to remove.

Use the Shift or Ctrl keys to select multiple samples.

2. Right-click and choose Remove Selected Samples from the shortcut menu, or click the 
Remove Sample icon, .

The EnviroLab Forms application removes the selected samples from the Samples list.

To edit sample values

1. For each sample, click the Sample Type column and select a sample type from the list.

Available ELF sample types

2. For each Cal Std or Chk Std sample, click in the Sample Level cell and select a level from 
the list.

The sample levels were defined in the master method. If there is nothing to select in the 
Sample Level list, do the following:

a. Return to the Method Development mode.

b. Open the method.

c. Click the Compounds tab.

d. Click the Calibration Levels tab.

e. Add the levels.

f. Save the method.

g. Return to the Production mode, and begin this batch again.

You must close your original batch without saving and start a new batch. For detailed 
instructions, see Chapter 4, “Using the Method Development Mode.” 

3. (Optional) Type a sample ID, sample name, or comment.

To add multiple samples of the same type

In the Repeat Sample Count column, type the number of samples you want to create for 
this sample type.

When you use this template to create a batch, the batch will contain this number of 
individual samples of the specified type.

Matrix Blank Solvent MS Unknown

Cal Std Breakdown MSD LCS

Unknown/TIC Tune Tune/Breakdown MDL

Chk Std LCSD Meth Val
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To specify report options

1. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

2. To duplicate the output type for all reports, click the cell to select it, then right-click and 
choose Copy Down from the shortcut menu.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell.

By default, all report output types are cleared.

To specify active compounds

1. In the sample table, click anywhere in the sample row to select the sample for which you 
want to specify active compounds.

Compound selections are specific to a sample. You can select different compounds for 
each of the samples even if they are the same sample type. 

2. In the Compound Active Status area, select the Active check box for each compound you 
want to identify in the selected sample.

If you have created compound groups, you can make the entire group active or inactive. 
Right-click and choose the group from the list.

Inactive groups Active groups
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Figure 48. Batch Template Editor

Table 47. Batch Template Editor parameters  (Sheet 1 of 2)

Parameter Description

Template Method 
Information

Project The top-level project for the batch.

Subproject The lower-level project for the batch.

Method The master method to use for the batch. The Select Method 
button opens the Open Method dialog box where you can select 
a master method for the batch template.
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Assay Type The name for the analysis type to be targeted by the method. 
The assay type associates the method with the analysis of a 
compound or specific class of compounds (for example, an assay 
type of PAH might be used for the analysis of Polynuclear 
Aromatic Hydrocarbons). The EnviroLab Forms application uses 
this assay type in the batch template. You can also select an 
appropriate combination of method and batch template. 

Column values

Sample type Defines how the EnviroLab Forms application processes the 
sample data. Each sample is classified as one of the following 
sample types: Matrix Blank, MDL, Solvent, Cal Std, MSD, 
Breakdown, Unknown, Unknown/TIC, Chk Std, MS, LCS, 
LCSD, Meth Val, Tune, or Tune/Breakdown

Sample level The level defined for a calibration sample or quality control 
sample.

Sample ID A user-defined alphanumeric string that identifies a sample.

Sample name A user-defined name that identifies a sample.

Comment A user-defined comment for the sample.

Repeat sample count Number of samples to create for this sample type.

Standard 

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create PDF Reports to be saved as PDF files. 

Create XML Reports to be exported in XML format. 

Custom 

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create XLS Reports to be exported in XLS format. 

Batch Level

Report Name The name of a report. 

Print Reports to be sent to the printer. 

Create XLS Reports to be exported in XLS format. 

Compound Active Status

Compound name List of all compounds for the method.

Active Identifies compounds to identify in the selected sample.

Table 47. Batch Template Editor parameters  (Sheet 2 of 2)

Parameter Description
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Creating a Batch Using the Batch Wizard

Using the Batch Wizard, you can define a sequence composed of various sample types to be 
assembled into a batch of samples. The batch wizard requires a batch template and a master 
method to compile a standardized sample batch.

Before you can create a batch with the Batch Wizard, you must have a master method and a 
batch template. See “Creating a New Master Method” on page 51 and “Using a Batch 
Template” on page 186.

Use the following procedures in the Batch Wizard to create and submit a batch:

• Selecting a Batch Template

• Specifying a Batch

• Submitting the Batch

• (Optional) Selecting Calibration Files and Compounds

The Batch Wizard includes the following pages:

To open the Batch Wizard

Choose File > New > Batch Using Wizard from the main menu.

The Batch Template Selection page of the Batch Wizard opens. See “Batch Template 
Selection page” on page 194.

Batch Template Selection

Calibration and 
Compound Selection

Finish

Batch Specification
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Selecting a Batch Template

From the Batch Template Selection page, you can create a list of samples to acquire or process.

To create a sample list

1. From the Project list, select a project.

2. From the Subproject list, select a subproject.

The Available Templates area lists all the templates in the specified subproject.

3. Select a starting vial position. 

The default is vial position 1, but you can choose to start your acquisition at any vial 
position.

4. (Optional) To simplify the sample list, select the Quick Mode check box.

Quick Mode limits the columns of information in the Batch Specification page to the 
following:

• Sample Type

• Sample ID

• Injection Volume

• Conversion factor

5. From the Available Templates list, select a template that defines the layout you want to 
use.

The Template Layout area displays sample information in the selected batch template and 
a list of methods that use the same assay type as your template.

6. Select an available method.

By default, the method used to create the batch template is selected, but you can choose 
any method in the Available Methods list.

7. To go to the next wizard page, click Next.

From the Batch Specification page of the wizard, you can customize the batch. 
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Figure 49. Batch Template Selection page

Table 48. Batch Template Selection parameters  (Sheet 1 of 2)

Parameter Description

Starting vial number The vial position at which you want to begin acquiring samples. 
Default: 1

Total batch rows The number of sample rows in the batch template.

Assay type The assay type specified in the master method used to create the 
batch template.

Quick mode Limits the columns of information in the Batch Specification 
page to the following:

• Sample Type
• Sample ID
• Injection Volume
• Conversion Factor

Available Templates All batch templates saved in the  
..\Thermo\EnviroLab Forms\Templates\Batches folder.

Template Layout Displays sample information in the selected batch template.

Available Methods Lists all master methods created with the same assay type as the 
selected batch template.
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Specifying a Batch

From the Batch Specification page, you must enter either a sample ID, sample name, or 
comment. You can also add or remove samples from the sample list or edit the column values 
for the samples. The batch template might contain many samples that you do not want to use 
for your batch. If you do not enter a sample ID, sample name, or comment for these samples, 
the EnviroLab Forms application discards them when you save the batch.

To enter a sample ID, sample name, or comment

1. In the Sample ID column, type an identifier.

The identifier can be any text string.

2. In the Sample Name column, type a name.

The name can be any text string.

3. In the Comment column, type a comment.

The comment can be any text string.

Note  The EnviroLab Forms application requires at least one of these fields to acquire a 
sample. When the batch begins acquisition, it discards any sample that does not have a 
value in at least one of these fields. 

Follow these procedures:

• To simplify the sample list

• To add samples to the batch

• To remove samples from the batch

• To insert samples into the batch

• To copy a sample

• To move a sample up or down in the sample list

• To browse in a raw data file

Next Returns you to the Batch Specification page where you can enter 
a sample ID, a sample name, or comment. You can also add or 
remove samples from the sample list or edit the column values 
for the samples. See “Specifying a Batch” on page 195.

Cancel Immediately exits the Batch Wizard and does not save the batch. 
There is no confirming message.

Table 48. Batch Template Selection parameters  (Sheet 2 of 2)

Parameter Description
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To simplify the sample list

Select the Quick Mode check box.

In Quick Mode, the Batch Specification page displays only the following columns:

• Sample Type

• Sample ID

• Injection Volume

• Conversion Factor

Note  The shortcut menu and its functions are not available when Quick Mode is 
selected.

To add samples to the batch

1. Right-click and choose Add Sample from the shortcut menu, or click the add sample 
icon, .

The EnviroLab Forms application adds a new, Unknown sample to the end of the sample 
list.

2. In the Filename column for each sample, type a file name.

Note  Alternately, you can right-click and choose Browse in Raw File from the 
shortcut menu. Follow the instructions “To browse in a raw data file” on page 198.

3. Select a sample type from the Sample Type list box for each sample. 

Available ELF sample types

For a detailed description of sample types, see “Specifying Sample Types” on page 205.

4. For each Cal Std or Chk Std sample, select a level from the Sample Level list.

The sample levels are defined in the master method. If there are no levels to select from 
the Sample Level list, a user with Supervisor or Manager permissions must edit the 
method and specify the levels. 

For detailed instructions about defining sample levels, see Chapter 4, “Using the Method 
Development Mode.” 

Matrix Blank Solvent MS Unknown

Cal Std Breakdown MSD LCS

Unknown/TIC Tune Tune/Breakdown MDL

Chk Std LCSD Meth Val
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5. In the Vial Position column for the new sample, type a vial position.

6. In the Injection Volume column for the new sample, type a volume.

The minimum allowed injection volume value is 0.05 μL.

7. (Optional) Type or edit the values for the remaining columns.

Note  This function is not available when Quick Mode is selected.

To remove samples from the batch

1. Select the samples you want to remove.

2. Right-click and choose Remove Selected Samples from the shortcut menu, or click the 
remove samples icon, .

The EnviroLab Forms application removes the selected samples from the sample list.

Note  This function is not available when Quick Mode is selected.

To insert samples into the batch

1. Select the sample above which you want to insert a new sample.

2. Right-click and choose Insert Sample from the shortcut menu.

The EnviroLab Forms application inserts a new, Unknown sample above the selected 
sample.

Note  This function is not available when Quick Mode is selected.

To copy a sample

1. Select the sample you want to copy.

2. Right-click and choose Insert Copy Sample from the shortcut menu.

The EnviroLab Forms application inserts the copy above the selected sample.

Note  This function is not available when Quick Mode is selected.

To move a sample up or down in the sample list

1. Select the sample you want to move.

2. Right-click and choose Move Sample Up or Move Sample Down from the shortcut 
menu.

The EnviroLab Forms application moves the selected sample up or down one row in the 
sample list.

Note  This function is not available when Quick Mode is selected.
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To browse in a raw data file

1. Double-click the Filename column, or right-click and choose Browse in Raw File from 
the shortcut menu.

A dialog box opens where you can select a raw data file to use for the sample. You can also 
browse in multiple raw data files to create multiple samples.

2. Locate the raw data file to use for the sample and click Open. 

Note  This function is not available when Quick Mode is selected.

Figure 50. Batch Specification page
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Table 49. Batch Specification parameters  (Sheet 1 of 2)

Parameter Description

Batch Template 
Master Method 
Batch File 
Calibration File

Displays the path names of the batch template, master method, 
batch file, and calibration file used to create this batch. 

Adds a new, Unknown sample to the end of the sample list. 
This function is not available when Quick Mode is selected.

Removes the selected sample. 
This function is not available when Quick Mode is selected.

Quick mode Limits the columns of information in the Batch Specification 
page to the following:

• Sample Type
• Sample ID
• Injection Volume
• Conversion Factor

In Quick Mode, the shortcut menu and add/remove sample 
icons are unavailable.

Back Returns you to the Batch Template Selection page where you can 
choose a different batch template, master method, or starting vial 
position.

Next Takes you to the Finish page where you can submit the batch for 
acquisition or processing. See “Submitting the Batch” on 
page 200.

Cancel Immediately exits the Batch Wizard and does not save the batch. 
There is no confirming message.

Shortcut Menu

Add sample Adds a single empty row to the sample list.

Insert sample Inserts a new, Unknown sample above the selected row.

Insert copy sample Copies the currently selected row and inserts a copy above the 
row.

Remove selected samples Removes selected samples from the sample list.

Move sample up Moves the selected sample up one row in the sample list.

Move sample down Moves the selected sample down one row in the sample list.
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Submitting the Batch

From the Finish page, you can change the name of the batch, access the Calibration and 
Compound Selection page to edit the calibration file or edit the list of compounds to identify, 
or save the batch and open it in Batch View. 

Follow these procedures:

• To change the name of the batch

• To save the batch

• To edit the calibration file

• To identify specific compounds or groups of compounds

To change the name of the batch

Edit the name in the Batch Name box.

If you enter a name for a batch that already exists, when you click Finish, the Batch Save 
dialog box asks you to enter another name. You cannot overwrite an existing batch name.

To save the batch

Click Finish.

The EnviroLab Forms application saves the batch and displays it in Batch View. From 
Batch View, you can submit the batch for acquisition, processing, or report generation. 
See “Submitting a Batch” on page 182.

To edit the calibration file 

1. Select the Modify Calibrations or Active Compounds by Group check box.

The EnviroLab Forms application replaces the Finish button with a Next button.

2. Click Next. 

The Calibration and Compound Selection page opens. See “Selecting Calibration Files 
and Compounds” on page 202.

Browse in raw file Opens a dialog box where you can select a raw data file to use for 
the sample row. You can also browse in multiple raw data files to 
create multiple samples.

Fill down Enters sequential values in the column starting with the value in 
the selected row and ending with the last row in the column. For 
detailed instructions about using the Fill Down command, see 
Appendix B, “Using Copy Down and Fill Down.” 

Table 49. Batch Specification parameters  (Sheet 2 of 2)

Parameter Description
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To identify specific compounds or groups of compounds

1. Select the Modify Calibrations or Active Compounds by Group check box.

The EnviroLab Forms application replaces the Finish button with a Next button.

2. Click Next. 

The Calibration and Compound Selection page opens. See “Selecting Calibration Files 
and Compounds” on page 202. 

Figure 51. Finish page

Table 50.  Finish parameters  (Sheet 1 of 2)

Parameter Description

Modify Calibrations or 
Active Compounds by 
Group

Enables the Next button that lets you access the Calibration and 
Compound Selection page.

If you have already used the Calibration and Compound 
Selection page, this option is not available.

Batch name Name of the current batch in the form:

MasterMethodName_MMDDYYYY_
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Selecting Calibration Files and Compounds

From the Calibration and Compound Selection page, you can edit the calibration file or edit 
the list of compounds you want to identify.

Follow these procedures:

• To add calibration data to the calibration file

• To identify specific compounds or groups of compounds

To add calibration data to the calibration file

1. To add calibration data from another batch to the current calibration file, click Extend 
Calibrations.

The Select a Calibration File to Use dialog box opens. The dialog box lists only 
calibration batches that use the same master method as the current batch.

Back Returns you to the Batch Specification page where you can enter 
a sample ID, sample name, or comment. You can also add or 
remove samples from the sample list or edit the column values 
for the samples. See “Specifying a Batch” on page 195.

Finish Saves the batch and displays it in Batch View. From Batch View, 
you can submit the batch for acquisition, processing, or report 
generation. See “Submitting a Batch” on page 182.

Next Opens the Calibration and Compound Selection page where you 
can edit the calibration file or edit the list of compounds you 
want to identify.

Available only when Modify Calibrations or Active Compounds 
by Group is checked. 

Cancel Immediately exits the Batch Wizard and does not save the batch. 
There is no confirming message.

Table 50.  Finish parameters  (Sheet 2 of 2)

Parameter Description
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2. Select a calibration file to append to the current calibration file and click OK.

The EnviroLab Forms application appends the selected calibration file to the current file.

3. To save calibration data from both files into a single file for this batch, click Create New.

4. When you are finished with the Calibration and Compound Selection page, click Next.

The Finish page opens. See “Submitting the Batch” on page 200.

To identify specific compounds or groups of compounds

1. In the Compound Groups area, select the groups that include the compounds you want 
to identify in the samples.

2. In the Included Compounds area, select the Active check box for each compound that 
you want to identify in the samples.

3. When you are finished with the Calibration and Compound Selection page, click Next.

The Finish page opens. See “Submitting the Batch” on page 200. 

Figure 52. Calibration and Compound Selection Page
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Table 51.  Calibration and Compound Selection parameters

Parameter Description

Calibration File Name of the current batch in the form:

MasterMethodName_MMDDYYYY_

Create New Saves calibration data from all calibration files to the current 
calibration file.

Available only after you use Extend Calibrations to append 
calibration data from another calibration file.

Extend Calibrations Adds calibration data from the current batch to the selected 
calibration file.

Compound Groups Displays all available groups defined in the Groups page of the 
Master Method View. See “Editing the Groups Page” on 
page 136.

Included Compounds Displays all available compounds that you can identify in the 
samples. Compounds marked as Active are identified in the 
batch samples.

Back Returns you to the Batch Specification page where you can enter 
a sample ID, sample name, or comment. You can also add or 
remove samples from the sample list or edit the column values 
for the samples. See “Specifying a Batch” on page 195.

Next Opens the Finish page where you can change the name of the 
batch or save the batch to the Batch View. See “Submitting the 
Batch” on page 200.

Cancel Immediately exits the Batch Wizard and does not save the batch. 
There is no confirming message.
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Specifying Sample Types

The EnviroLab Forms application uses the following sample types in all sample definitions 
and reports. 

To view example standard reports specific to each sample type, see Appendix A, “Reports.” 

Table 52.  Sample type definitions  (Sheet 1 of 2) 

Sample type Definition

Matrix Blank Contains no target compounds but might contain an ISTD when 
you use the internal standard quantitative analysis technique. By 
analyzing a blank sample, you can confirm that there are no 
residual compounds in the solvent system that can cause erroneous 
results.

Cal Std (Calibration standard) Contains known amounts of all target 
compounds. The purpose of a calibration standard is to measure 
the response of the instrument to the target compounds so that the 
processing software can generate a calibration curve for each 
compound.

Chk Std (Check standard) Contains a known amount of one or more 
specific target compounds. The EnviroLab Forms application 
places check standard samples in the sequence so that it can test 
quantitative analysis results for quality assurance purposes. After 
the application analyzes the check standard sample, it compares 
the measured quantity with the expected value and an acceptability 
range. The quantitative analysis of a check standard sample is 
classified as passed if the difference between the observed and 
expected quantities is within the user-defined tolerance. A check 
standard sample is classified as failed if the difference between the 
observed and expected quantities is outside the user-defined 
tolerance.

LCS Lab control sample.

LCSD Lab control sample duplicate.

MDL Method detection limits sample.

Meth Val Method validation sample.

MS Matrix spike sample.

MSD Matrix spike duplicate sample.

Tune Verifies the tune of the system according to EPA guidelines.

Tune/Breakdown Verifies the tune of the system according to EPA guidelines, 
allowing for the degradation of compounds.

Breakdown Checks the degradation of compounds.
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Solvent Contains only solvent.

Unknown Used for quantitative analysis of samples.

Unknown/TIC Used for quantitative and qualitative analysis of samples.

Table 52.  Sample type definitions  (Sheet 2 of 2) 

Sample type Definition
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Working in Data Review
From the Data Review view, you can view the data generated by the master method. Use the 
Data Review view to verify the data for a sample-specific compound before you generate 
reports. You can use the functions in the Data Review view to investigate and edit the 
quantification values in a batch. 

To open the Data Review view

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. From the Production navigation pane, click Data Review (to open the Data Review 
view).

The Data Review view for the currently selected batch opens. 

Data Review Panes

The Data Review view uses a Samples list and one of two modes: Quan Mode or Qual Mode. 
The Qual Mode is available only for Unknown/TIC sample types. When you view the data 
for one of these sample types, you can toggle between Qual Mode and Quan Mode. 

• Use the Samples list to select a particular sample.  Status indicators for each sample 
indicate if the sample is unacquired, acquired, acquiring, or processed. See “Samples List” 
on page 209.
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• Use the Quan Mode and the associated Compounds pane to view quantitative 
information to complement the textual information for the selected sample. See “Quan 
Mode” on page 214.

• Use the Qual Mode and the associated Peaks pane to view qualitative information that 
complements the textual information for the selected Unknown/TIC sample. See “Qual 
Mode” on page 229.
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Samples List

The Samples list is the same in both Quan Mode and Qual Mode and displays all the 
quantitative data for the samples of a batch.  

• In Quan Mode, the Samples list works with the Compounds pane to select a unique 
sample and compound combination, which then has its textual and graphical values 
displayed in the Quan Mode pane.  The list of compounds that are available for a specific 
method is displayed in the Compounds pane.

From the Samples list, you can make a compound active or inactive. Switching a 
compound to inactive status does not remove its data and calculated values from the 
result set. Instead, the EnviroLab Forms application masks off the appearance of that 
compound for that particular sample and grays the compounds in the Compounds list. 
For a calibration standard, the application no longer uses the data file’s calibration point 
for the calibration and removes it from the graphical view of the calibration curve 
displayed in the Qualification pane. It is no longer part of the result set. 

• In Qual Mode, the Samples list works with the Peaks pane to select a unique sample and 
peak combination, which then has its textual and graphical values displayed in the Qual 
Mode pane.

The Flags column in the Samples list displays a caution flag if the sample is not in compliance 
with the method criteria. 

To open a dialog box with a list of problems found in the sample, click the caution flag. The 
dialog box does not list compounds that are not found in Unknown sample types. 

Status Indicators

Status indicators show the current status of each sample during the acquisition and 
processing:

• Orange for samples that are currently acquiring
• Blue for samples that have not been acquired
• Yellow for samples that have been acquired and not processed
• Green for samples that have been acquired and processed

Status indicators

Sample flags
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Sample Flags 

Sample flags are displayed when compounds within the samples have an error. 

• Sample caution flags remain static when you switch between compounds for 
chromatogram review until a change is completed, for example, when a compound is 
manually integrated and no longer falls outside the accepted criteria.

• Sample caution flags list a summary of all compound indicator messages within the 
sample when you pause the cursor over the flag. The Tooltip does not list compounds 
that are not found in Unknown sample types.
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Figure 53. Samples List pane

Cells in the Samples list that should not have a value, such as theoretical concentration for an 
Unknown sample, are shaded and empty. Cells that should have a value, but none exists, 
report N/A (not available). Results for compounds that are not detected display N/F (not 
found).

Table 53. Samples List parameters  (Sheet 1 of 3)

Parameter Description

Status • Orange for samples that are currently acquiring
• Blue for samples that have not been acquired
• Yellow for samples that have been acquired and not processed
• Green for samples that have been acquired and processed

Flags Displayed only when a compound within the sample has an error. 
Sample flags are always red.

Filename Name of the raw data file that contains the sample data.
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Sample type Defines how the EnviroLab Forms application processes the 
sample data. Each sample is classified as one of the following 
sample types: Matrix Blank, MDL, Solvent, Cal Std, MSD, 
Breakdown, Unknown, Unknown/TIC, Chk Std, MS, LCS, 
LCSD, Meth Val, Tune, or Tune/Breakdown

Sample level The level defined for a calibration sample or quality control 
sample.

Sample ID A user-defined alphanumeric string that identifies a sample.

Sample name A user-defined name that identifies a sample.

Comment A user-defined comment for the sample.

Vial Position The tray vial number used for the autosampler acquisition.

Injection volume The injection volume in microliters of sample to be injected. 

Minimum value: 0.05

When you are using an autosampler, you can set the default 
injection volume in the autosampler dialog box in the Instrument 
View. The minimum and maximum injection volumes that you 
can use depend on the autosampler you configure. The usable 
range depends on the injection mode and might be smaller than 
the range displayed.

Integration mode Indicates whether the peaks have been manually integrated or 
integrated from the original method.

Height The distance from the peak maximum to the peak base, measured 
perpendicular to the ordinate. When the Resp Ratio is specified as 
Height, this column is indicated with an asterisk (*Height).

Area The area obtained by integrating peak intensities from the start to 
the end of the peak. When the Resp Ratio is specified as Area, this 
column is indicated with an asterisk (*Area).

Actual RT Actual retention time for the compound. Retention time is the 
time after injection at which a compound elutes and the total time 
that the compound is retained on the GC column.

Expected RT Expected retention time for the compound.

Calc Amt The amount present in the sample, as determined using the 
calibration curve and the response ratio.

Theo Amt Theoretical amount of the compound expected in the sample. 

Table 53. Samples List parameters  (Sheet 2 of 3)

Parameter Description
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Resp ratio The ratio of the Response value to the IS Response value. If the 
Response is specified as Area in the processing method, the units of 
both Response and IS Response are counts-sec. If the Response is 
specified as Height in the processing method, the units of both 
Response and IS Response are counts.

IS Amt Amount of internal standard.

IS Resp Response of the internal standard.

Active Displays or hides a compound for a particular sample. When a 
calibration standard is marked inactive, the EnviroLab Forms 
application no longer uses the data file’s calibration point for the 
calibration and removes it from the graphical view of the 
calibration curve displayed in the Qualification pane. It is no 
longer part of the result set. 

Excluded Turns a compound on or off in the Calibration curve of the 
Qualification pane. 

%Diff The calculated amount minus the expected amount, divided by 
the expected amount, and then multiplied by 100.

%RSD Standard deviation of the multiple samples of one level, multiplied 
by 100, and then divided by the average of the multiple samples of 
that level. This calculation is based on the calculated amounts.

%CV Coefficient of Variation. Standard deviation of the multiple 
samples of one level, multiplied by 100, and then divided by the 
average of the multiple samples of that level. This calculation is 
based on either the area or height of the peaks.

Table 53. Samples List parameters  (Sheet 3 of 3)

Parameter Description
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Quan Mode

The Quan Mode displays quan peak and confirming ion information for selected compounds 
that are found in the processed samples.

In addition to the Samples List, the Quan Mode view uses the following panes:

• Compounds Pane

• Quantification Peak Pane

• Qualification Pane

Compounds Pane

In Quan Mode, the Samples list works with the Compounds pane to select a unique sample 
and compound combination, which then has its textual and graphical values displayed in the 
Quan Mode pane.  The list of compounds that are available for a specific method is displayed 
in the Compounds pane.

The Compounds pane works with the Samples list to display textual and graphical values for a 
unique file and compound combination.

Samples List Compounds pan

Quantification Peak pane Qualification pane
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Use the  Compounds pane to select a particular compound within that sample’s result set. 
When you select a file and compound, the values displayed in the data grid reflect the 
quantification data for that unique combination. 

From the Samples list, you can make a compound active or inactive. Switching a compound 
to inactive status does not remove its data and calculated values from the result set; instead, 
the EnviroLab Forms application masks off the appearance of that compound for that 
particular sample and grays the compounds in the Compounds list. For a calibration standard, 
the application no longer uses the data file’s calibration point for the calibration and removes 
it from the graphical view of the calibration curve displayed in the Qualification pane. It is no 
longer part of the result set. 

Compound Flags

When are flags displayed?

The EnviroLab Forms application displays compound flags for any of the following 
conditions:

• When a compound has violated (or is activated by) any of the values set in the method. 
See “Editing the QAQC Page” on page 117. 

• For compounds that are not found in Cal Std, Chk Std, and Surrogate sample types.

• For compounds that are outside the specified ion ratio range.

• For compounds that are not found. 

These criteria do not apply to Matrix Blank sample types when the compound is an internal 
standard.

Compound flags
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What do the flag colors mean?

The EnviroLab Forms application defines the colors of the compound flags as follows:

• Red flags for compounds that have ion ratio failures, method validation failures, or have 
values above the ULOL or carryover limits.

• Orange flags for compounds that are below the LOQ, below the LOD, or between the 
LOD and LOQ values specified in the method.

• Green flags for compounds that are over the LOR amount specified in the method.

• Yellow flags for compounds that are below the LOR amount specified in the method.

• No flag for compounds that have no errors or where there were no report options 
selected.

Follow these procedures:

• To display peaks for a specific compound

• To change the sort order

• To display the compound nonconformance

• To make a compound active or inactive

• To exclude a calibration point

To display peaks for a specific compound

1. From the Samples list, select the sample.

The Compounds pane lists all compounds specified in the method.

2. From the Compounds pane, select the compound in the sample.

The Quan peak pane displays the peaks for the selected compound and its internal 
standard. 

To change the sort order

Right-click the Compounds pane and choose one of the following from the shortcut 
menu:

– Sort by Flag and Alphabetical (the default)

– Sort by Flag and Retention Time

– Sort by Alphabetical

– Sort by Retention Time

To display the compound nonconformance

Pause the cursor over the compound or compound flag.

The EnviroLab Forms application displays the error condition.
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To make a compound active or inactive

1. Select the sample from the Samples list.

All compounds in that sample are displayed in the Compounds pane. The status of a 
compound in a sample is determined by the Component Active Status pane in the Batch 
View for the batch. Inactive compounds are grayed out.

2. From the Compounds pane, select the compound you want to make inactive.

3. From the Samples list, select or clear the Active check box.

Use the horizontal scroll bar at the bottom of the table to scroll to the Active column.

Inactive

To exclude a calibration point

From the Samples list, select the Excluded check box for the sample.

When a value is no longer used for calibration, it remains part of the calibration dataset 
and is displayed in the graphical view of the calibration curve. 

Quantification Peak Pane

The Quantification Peak pane displays the compound selected in the Samples list and 
Compounds panes. You can store two peak value sets (method and manual integration 
settings) with each compound in each file. These settings can result in a different set of stored 
values. The method values were originally calculated based on the processing method 
parameters. The manual values are a result of what has been viewed or altered. 

When the sample contains an internal standard, the chromatogram shows both the analyte 
and the internal standard in side-by-side panes.

Follow these procedures:

• To zoom in on a peak

• To manually integrate a quantification or qualification ion

• To manually add a peak

• To remove a manually created peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

• To modify the peak detection settings
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To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

To manually integrate a quantification or qualification ion

1. Place the cursor over one of the two peak delimiter tags in the Quantification Peak pane.

When the tag can be selected, the cursor changes to a crosshair style cursor. You can zoom 
in on the baseline to make it easier to select the tag. 

2. Drag the tag to another location, and release the cursor to place the peak delimiter tag at 
its new location and automatically update the peak values (area, height, and so forth) into 
the result set. 

Both the Quantification Peak pane and the Integration Mode column in the 
Quantification data pane reflect the change between method and manual modes. The 
generated reports for these data identify the manual modifications.

To manually add a peak

1. Right-click anywhere in the Quantification Peak pane, and choose Add Peak from the 
shortcut menu.

2. Click to indicate the left and right base points for the peak. 

The EnviroLab Forms application places the peak delimiter tags at these locations and 
automatically updates the peak values (area, height, and so forth) in the result set. 

Manually added 
base points

To remove a manually created peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The EnviroLab Forms application removes the manually added peak.
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To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration Settings or Manual 
Integration Settings from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical and when you select one mode it does not affect the saved result set. 
However, when manual data are available, the chromatogram plots and the result set 
update as you switch between method and manual modes. 

As you switch between modes, the changes are reflected in each pane. The generated 
reports for this data identify the manual modifications.

To change the displayed information for detected peaks

1. Right-click the quantification chromatogram plot and pause the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quan peaks, confirming peaks, and internal standard 
peaks. 

Note  The labels do not always update on all peak displays. To update all labels, select 
a different compound, and then reselect the compound whose labels you changed.

To modify the peak detection settings

1. Right-click the chromatogram view and choose Peak Detection Settings from the 
shortcut menu. 

The Peak Detection Setting dialog box opens. This dialog box contains the detection 
settings defined in the method.
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2. Edit any of the detection settings.

For a detailed description of all detection settings, see “Detection” on page 83.

3. To save your changes to this compound in all samples in this batch, click Apply to All. 

Table 54. Quantification Peak shortcut menu  (Sheet 1 of 2)

Command Description

Method integration settings Displays method integration settings.

Manual integration settings Displays manual integration settings.

Add peak - Remove peak - 
Cancel add peak

Adds a peak, removes a peak, or cancels an add peak 
operation in progress.
220         EnviroLab Forms 3.0 User Guide Thermo Scientific



 5  Using the Production Mode
Working in Data Review
Confirming ion list Selects the confirming ions to be viewed.

Peak labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Show peak info Displays peak information for the selected compound. 
For example:

Reset scaling Resets the original scaling after a zoom operation.

Peak detection settings Opens the Peak Detection Settings dialog box for the 
selected compound. See “Peak Detection Settings” on 
page 222.

Table 54. Quantification Peak shortcut menu  (Sheet 2 of 2)

Command Description
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Peak Detection Settings

Use the Peak Detection Settings dialog box to adjust detection settings that were specified in 
the method.

For a detailed description of all peak detection settings, see “Detection” on page 83.

Qualification Pane

The Qualification pane displays the compound selected in the Quantification data pane and 
Compounds pane. 

The Qualification pane consists of five pages: 

• Calibration Curve 

• Spectra 

• Confirming Ions 

• Ion Overlay 
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Calibration Curve

The Calibration curve page displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of the calibration. 

To manually exclude a calibration point

From the Samples list, select the Excluded check box for the sample.

To zoom in on an area

1. In the Calibration curve plot, drag the cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the calibration curve plot and choose 
Reset Scaling from the shortcut menu. 

Changes to the calibration settings are immediately applied to the entire results set, but 
they are saved only when you save the batch.  

Table 55. Calibration Curve shortcut menu  (Sheet 1 of 2)

Command Description

Standard type Sets the standard type to External or Internal. 

Calibration curve type Sets the calibration curve type to Linear, Quadratic, or Average 
RF. 

• Linear: Allows all settings with this exception: When Origin 
is set to Include, all Weighting values are grayed out and 
Weighting is set to Equal.

• Quadratic: Allows all settings with this exception: When 
Origin is set to Include, all Weighting values are grayed out 
and Weighting is set to Equal.

• Average RF: Allows no Weighting or Origin selections. All 
Weighting and Origin values are grayed out. Weighting is set 
to Equal, and Origin is set to Ignore. 
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Spectra 

The Spectra page displays a comparison of the spectra found in the data and the method 
reference. 

To zoom in on an area

1. Drag the cursor to delineate a rectangle around an area. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the spectra plot and choose Reset Scaling 
from the shortcut menu.  

Response via Sets the response via to Area or Height.

Weighting Sets the weighting to equal, 1/X, 1/X^2, 1/Y, or 1/Y^2.

Origin Sets the origin to Ignore, Force, or Include.

Units Sets the units.

Done with settings Closes the shortcut menu.

Reset scaling Resets the original scale in the calibration curve pane.

Table 55. Calibration Curve shortcut menu  (Sheet 2 of 2)

Command Description
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Confirming Ions

The Confirming Ions page displays a graphical view of all qualifying/confirming ions for the 
selected sample and compound and displays calculated ion ratios and ion ratio acceptance 
windows. A red border indicates that an ion ratio is outside of its window. Depending on the 
method option settings, another ion view is available on the Ion Overlay page. See “Ion 
Overlay” on page 228.

A red border indicates that an ion ratio is outside of its window.

Follow these procedures:

• To manually add a peak

• To remove a manually created peak

• To zoom in on a peak

• To change the displayed information for detected peaks

• To display the peak information window
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To manually add a peak

1. Right-click the chromatogram plot and select Add Peak from the shortcut menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

The EnviroLab Forms application places the peak delimiter tags at these locations and 
automatically updates the peak values (area, height, and so forth) in the result set. 

Manually added 
base points

To remove a manually created peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The EnviroLab Forms application removes the manually added peak.

To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
Scaling from the shortcut menu. 

To change the displayed information for detected peaks

1. Right-click the chromatogram plot and pause the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to quan peaks, confirming peaks, and internal standard 
peaks. 

Note  The labels do not always update on all peak displays. To update all labels, select 
a different compound, then reselect the compound whose labels you changed.
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To display the peak information window

1. Right-click the quantification and confirming ion chromatogram plots.

2. Choose Show Peak Info from the shortcut menu.

Information in this window includes the data stream processed for this ion, consisting of 
a particular detector, filter (if applicable), and trace. For example, an MS detector might 
show a filter of “+ c Full ms [35.00-500.00]” and a Mass Range trace. 

This window also shows the peak area and height, along with the retention times of the 
peak integration and the peak apex. 

Table 56. Confirming Ions shortcut menu  (Sheet 1 of 2)

Command Description

Method integration settings Displays method integration settings.

Manual integration settings Displays manual integration settings.

Add peak - Remove peak - 
Cancel add peak

Adds a peak, removes a manually added peak, or cancels an 
add peak operation in progress.

Range Calc method: Manual Selects the method used to calculate the ion ratio range 
windows: Manual, Average, Weighted Average, or Level 

Range calc level Specifies the range based on the calibration level.

Target ratio: Specifies the theoretical ratio of the confirming ion’s 
response to the quantification ion’s response. 

Window type: Specifies the Absolute or Relative calculation approach for 
determining the acceptable ion ratio range. 

Window: % Specifies the acceptable ion ratio range. 

Peak labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Show peak info Displays peak information for the selected compound. For 
example:
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Ion Overlay 

The Ion Overlay page represents an overlay of the entire ion set—quantification and 
qualifying/confirming—for the selected sample and compound. Use this page to graphically 
review the peak apex alignment and co-eluting peak profiles. 

To zoom in on a peak

1. Drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view. 

2. To restore the method default view, right-click the chromatogram plot and choose Reset 
Scaling from the shortcut menu. 

Reset scaling Resets the original scaling after a zoom operation.

Peak detection settings Opens the Peak Detection Settings dialog box for the 
selected compound. See “Peak Detection Settings” on 
page 222.

Table 56. Confirming Ions shortcut menu  (Sheet 2 of 2)

Command Description
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Qual Mode

The Qual Mode displays detected peaks for the selected sample and lets you manually add 
peaks.

In addition to the Samples List, the Qual Mode view displays data in the following panes:

• Peaks Pane

• Chromatogram Navigation Pane

• Qual Peak Pane

• Spectra Pane (reference and selected)

• Ranking Pane

Samples List Peaks pane

Chromatogram 
navigation pane

Qual Peak pane  Spectra pane  Ranking pane

Tip  To resize the panes, drag the separators that divide the panes.
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Peaks Pane

The Peaks pane works with the Samples list to display graphical values for a unique sample 
and peak combination.

To display peaks for a specific compound

1. From the Samples list, select a sample. 

Note  When you choose a calibration sample, the EnviroLab Forms application 
returns you to Quan Mode. The Peaks pane is not displayed in Quan Mode.

The Peaks pane lists the retention time for peaks identified in the selected sample, the 
values for the best match methods for each peak, and the compound match.

The number of peaks that are listed is specified in the method. You can change the 
number of identified peaks in the Method Template Editor. See “Identify the peaks” on 
page 153.

2. From the Peaks pane, select a peak in the sample.

The EnviroLab Forms application displays the selected peak in the Qual Peak pane.

The EnviroLab Forms application displays the spectra data for the peak and the reference 
spectra for the identified library compound in the Spectra pane.
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The EnviroLab Forms application locates the selected peak in the navigation 
chromatogram.

To remove a peak

1. Select a peak in the Peaks pane.

2. Right-click and choose Remove Selected Peak from the shortcut menu.

The EnviroLab Forms application removes the selected peak from the peaks list.

Note  There is no undo for this action, but you can manually add a peak to redefine a 
removed peak. See “Chromatogram Navigation Pane” on page 232.

Figure 54. Peaks pane
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Chromatogram Navigation Pane

The chromatogram navigation pane displays all peaks in the selected sample. The peak 
selected in the Peaks pane is indicated with a red marker.

Follow these procedures:

• To zoom in on a peak

• To manually add a peak

To zoom in on a peak

1. In the chromatogram navigation pane, drag the cursor to delineate a rectangle around the 
peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the default view, right-click the chromatogram navigation pane and choose 
Reset Scaling from the shortcut menu. 

To manually add a peak

1. Zoom in to make it easier to identify the peak you want to add to the results set.

Table 57. Peaks pane parameters

Command Description

Filter Filter used to identify the peaks. Specified in the raw data 
file or the master method.

Peak RT (min) Peak retention time. The time after injection at which the 
compound elutes. The total time that the compound is 
retained on the GC column. 

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Library entry Library compound that matches the identified peak.

Remove selected peak Shortcut menu command that removes the selected peak 
from the peaks list.
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2. Right-click the chromatogram navigation pane, and choose Add Peak from the shortcut 
menu.

3. Click to indicate the left and right base points for the peak. 

The EnviroLab Forms application marks the peak in the chromatogram navigation pane.

The EnviroLab Forms application places the peak delimiter tags at the base point 
locations and automatically updates the peak values in the Peaks pane and Qual Peak 
pane. 

Manually added 
base points
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Figure 55. Navigation Chromatogram pane
 

Qual Peak Pane

The Qual Peak pane displays the selected peak.

Follow these procedures:

• To zoom in on a peak

• To manually add a peak

• To remove a peak

• To switch between method and manual integration modes

• To change the displayed information for detected peaks

To zoom in on a peak

1. In the chromatogram plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

To manually add a peak

1. Right-click anywhere in the Qual Peak pane, and choose Add Peak from the shortcut 
menu.

If a peak is already detected, the Add Peak command is not enabled. 

2. Click to indicate the left and right base points for the peak. 

Table 58. Navigation Chromatogram shortcut menu

Command Description

Add peak Lets you manually add a peak.

Reset scaling Resets the original scaling after a zoom operation.
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The EnviroLab Forms application places the peak delimiter tags at these locations and 
automatically updates the peak values (area, height, and so forth) in the result set. 

Manually added 
base points

To remove a peak

Right-click the chromatogram plot, and choose Remove Peak from the shortcut menu.

The EnviroLab Forms application removes the peak displayed in the Qual Peak pane. All 
data for this peak is removed from the Qual Mode panes.

To switch between method and manual integration modes

Right-click the chromatogram view and choose Method Integration or Manual 
Integration from the shortcut menu. 

Initially, the method and manual integration settings that are stored for a compound and 
file are identical and when you select one mode it does not affect the saved result set. 
However, when manual data are available, the chromatogram plots and the result set 
update as you switch between method and manual modes. 

As you switch between modes, the changes are reflected in each pane. The generated 
reports for this data identify the manual modifications.

To change the displayed information for detected peaks

1. Right-click the chromatogram plot and pause the cursor over Peak Labels.

2. Choose to display labels for the peak retention time, peak height, peak area, or signal to 
noise.

The label types in the list are selected for displayed labels and cleared for labels that are 
not displayed.

3. To remove a label, select the label type again and clear it.

Label settings are globally applied to qual peaks, confirming peaks, and internal standard 
peaks. 

Note  The labels do not always update on all peak displays. To update all labels, select 
a different compound, and then reselect the compound whose labels you changed.
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Table 59. Qual peak shortcut menu

Command Description

Reset scaling Resets the original scaling after a zoom operation.

Method integration Displays method integration settings.

Manual integration Displays manual integration settings.

Peak labels Displays or hides the peak labels (Label Area, Label 
Retention Time, Label Height, or Label Signal to Noise).

Remove peak Removes the peak displayed in the Qual pane. 
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Spectra Pane (reference and selected)

The Spectra pane displays the reference spectra and the spectra for the selected sample. The 
top pane displays the reference spectra for the identified compound from the library; the 
bottom pane displays the spectra for the selected peak.

To zoom in on a peak

1. In the spectra plot, drag the cursor to delineate a rectangle around the peak. 

The delineated area expands to fill the view to help you examine the peak limits for 
enhanced review and confirmation.

2. To restore the default view, right-click the chromatogram plot and choose Reset Scaling 
from the shortcut menu. 

Reference 
spectra for 
Acenaphthene.

Actual spectra 
for selected 
peak.
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Ranking Pane

This pane displays the three best library matches for the selected peak. Use this pane to select 
a different library entry for the peak.

To change the library entry for a selected peak

1. In the Ranking pane, select the check box for the library entry you want to use to identify 
the selected peak.

• In the Spectra pane, the reference spectra changes to show the spectra for the selected 
library entry.

• In the Peaks pane, the SI, RSI, MP, and Library Entry values update to reflect the 
selected library entry.

Table 60. Ranking pane parameters

Command Description

<Check box column> Lets you choose a library entry for the selected peak.

Rank Indicates the order of best matches between the selected 
peak and library entries.

SI Search index method used to search the NIST library.

RSI Reverse search index method used to search the NIST 
library.

MP Match probability.

Library entry Library compound that matches the identified peak.
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Working in Report View
Use the Report View to display the reports for the batch currently selected in the Data Review 
view or to display the Active View for the reports.

To open the Report View

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. From the Production navigation pane, click Report View.

From the Report View, you can access the following pages:

• Displaying the Report View Page

• Displaying the Active View Page

Displaying the Report View Page

Use the Report View page to select a report and navigate the report display.

To display the Report View page

Click the Report View tab.

The Report View page is the default page.

To display a report

1. Select a report type from the Select a Report list.

Only the report types created for the current batch are displayed in the list. 

2. (Optional) When the report type includes separate reports for each sample, select a 
sample file.

Note  All report types create separate reports for each sample except the standard Batch 
Report and custom reports that are specified as batch-level reports. See “Custom Reports” 
on page 44.
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To print a report

1. Select the report you want to print from the Select a Report list.

2. Do one of the following:

Choose File > Print Batch from the main menu.

The EnviroLab Forms application immediately sends all reports for the batch to your 
default printer. There is no dialog box or confirmation message.

–Or–

a. Click the Print Report icon, .

The Print dialog box for your default printer opens.

b. Follow the typical procedure to print from your printer.

Landscape reports are automatically rotated to fit the paper.

To export a report

1. Select the report you want to print from the Select a Report list.

2. Click the Export Report icon, .

The Export Report dialog box opens.

3. Locate the folder where you want to write the report file and click Save.

The EnviroLab Forms application writes the Crystal Reports (.rpt) or custom reports file 
to the specified folder.

To search for text in a report

1. Select a report from the Select a Report list.

2. Click the Find Text icon, .

The Find Text dialog box opens.

3. Enter your text and click Find Next.

When the EnviroLab Forms application locates the text, it encloses the text in a red box.
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To enlarge the report text

1. Select a report from the Select a Report list.

2. Click the Zoom icon, , and select a zoom scale.
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Figure 56. Report View page

Table 61. Report View parameters

Command Description

Select a report Displays the report types created for the current batch.

Export Report Writes the Crystal Reports (.rpt) or custom reports file to a 
specified folder.

Print Report Sends all reports for the batch to your default printer. There 
is no dialog box or confirmation message.

Find Text Locates the specified text and encloses the text in a red box.

 Zoom Enlarges the report text by the specified scale factor.
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Displaying the Active View Page

Use the Active View page to view quantitative data for each sample in a report. Data in Active 
View are labeled with flag information. These flags are based on a comparison of the batch 
data to criteria defined in the master method.

To display the Active View page

Click the Active View tab.

The Active View page displays quantitative data and QAQC error flags for each sample. 
See “Active View page” on page 244. 

To display a report

1. Select a report type from the Select a Report list.

Only the report types created for the current batch are displayed in the list. 

2. (Optional) When the report type includes separate reports for each sample, select a 
sample file.

To filter which compounds to display

Toggle the Showing button to display either all compounds or only compounds that are 
flagged for failing a QAQC test.
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Figure 57. Active View page

Table 62. Active View parameters  (Sheet 1 of 4)

Parameter Description

Display selection

Select a report Displays the report types created for the current batch. 

Sample file Used when the report type includes separate reports for each 
sample.

Showing Lists the available compound types to display in Active View: 
Quan, Non quan, Target, Internal Standards, or Surrogates.
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Column headings

Status The status of the reported compound. 

• A yellow warning flag indicates one of the following 
conditions:

– The compound was manually integrated

– Any of the confirming peaks was manually integrated.

– The compound has quan flags. 

• A red warning flag indicates that the QAQC checks failed.

• A green flag indicates that none of these conditions exist.

When the compound is an internal standard, warning flags are 
displayed only on the internal standard report. 

The Status column is blank for Manual Integration reports.

Compound Name Alphanumeric name assigned to the compound.

Compound Type Target Compound, Internal Standard, or Surrogate.

QAQC Flags Indicates that the QAQC check for the sample failed.

The QAQC column is not used for Manual Integration reports.

Quan Flags Quantification flags include:
• Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of 

quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to the following sample types: Cal Std, 
Chk Std, Matrix Blank, or Solvent.

The Quan Flag column is not used for Manual Integration reports.

Manual Flags Indicates manually integrated peaks.  
• M indicates a manually integrated quan peak.
• m indicates a manually integrated confirming peak.

Depending on the selected report, the active view page contains any or all of the following 
parameters:

Quan peak m/z Mass-to-charge ratio for the selected quantitation peak.

Total response The sum of all Quan Peak Response values for the compound.

Quan peak response Response of the quan peak.

Table 62. Active View parameters  (Sheet 2 of 4)

Parameter Description
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Quan peak RT Retention time for the quan peak.

Theoretical amount Theoretical amount of the compound. Reports N/A when not 
applicable.

Concentration

Confirming n Mass Mass of the confirming peak.

Confirming n 
Response

Response of the confirming peak.

Confirming n Manual 
Flag

Indicates a manually integrated confirming peak.

Confirming n Ion 
Ratio Flag

Indicates that the ion ratio is out of range.

Confirming n Ion 
Ratio

Actual ratio of the confirming ion response to the quan ion 
response.

Confirming n Range Acceptable range for the confirming ion.

Retention Time The time after injection at which the compound elutes. The total 
time that the compound is retained on the GC column. 

Quan mass The mass-to-charge ratio used to determine the peak area and peak 
height of the compound.

Response Sum of all Quan Peak Response values for the compound.

Injection 
concentration

Calculated amount as the sample was injected, with no conversion 
applied.

Injection Units Injection units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

Sample Concentration The injected concentration multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

QIon Mass range for the quan peak.

RT Retention time. The time after injection at which the compound 
elutes. The total time that the compound is retained on the GC 
column. 

Manual Integration 
reports

m/z Mass-to-charge ratio for the quan peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height of the method-integrated peak.

Table 62. Active View parameters  (Sheet 3 of 4)

Parameter Description
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Method Peak Area Area of the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Internal Standard 
reports

Std Response Average of the internal standard’s response as found in the 
calibration file.

Minimum Response Minimum response time as specified on the ISTD page in Method 
Development mode. See “ISTD” on page 127.

Maximum Response Maximum response time as specified on the ISTD page in Method 
Development mode. See “ISTD” on page 127.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in Method 
Development mode. See “ISTD” on page 127.

Max RT Maximum retention time as specified on the ISTD page in Method 
Development mode. See “ISTD” on page 127.

Sample RT Retention time found in the sample.

Graphical data

Quan Peak 1

Calibration curve Displays a graphical view of the calibration curve for the selected 
compound and key statistical values for evaluating the quality of 
the calibration. 

Spectra Displays a comparison of the spectra found in the data and the 
method reference. 

Confirming Ions Displays a graphical view of all qualifying/confirming ions for the 
selected sample and compound and displays calculated ion ratios 
and ion ratio acceptance windows.

Table 62. Active View parameters  (Sheet 4 of 4)

Parameter Description
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Active View Report Contents

Each standard report that uses the Active View displays values that are common to all reports:

• Common Active View report values

In addition to the common values, the following reports display additional active view 
features:

• Blank Report Active View values

• High Density 1 and High Density 1 Long Report Active View values

• High Density 2 and High Density 2 Long Report Active View values

• High Density 3 and High Density 3 Long Report Active View values

• Internal Standard Report Active View values

• Ion Ratio Failure Report Active View values

• LCSLCSD Report Active View values

• Manual Integration Report Active View values

• Method Detection Limit Report Active View values

• Method Validation Report Active View values

• MSMSD Report Active View values

• QC Report Active View values

• Quantitation Report Active View values

• Sample Report and Sample Report Long Active View values

• Solvent Blank Report Active View values
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Table 63. Common Active View report values

Column Description

Status The status of the reported compound. 

• A yellow caution sign indicates one of the following 
conditions:

– The compound was manually integrated

– Any of the confirming peaks was manually integrated.

– The compound has quan flags. 

– The compound has a QAQC failure.

• A green check mark indicates that none of these conditions 
exist.

When the compound is an internal standard, warning flags are 
displayed only on the internal standard report. 

Compound name Alphanumeric name assigned to the compound.

Compound type Target Compound, Internal Standard, or Surrogate.

QAQC flags Indicates that the QAQC check for the sample failed. 

This column is not included on the Method Validation and 
MDL reports.

Quan flags • Quan flags include Limit of Detection (LOD)
• Limit of Quantitation (LOQ)
• Limit of Reporting (LOR)
• Values between the limit of detection and the limit of 

quantitation, known as the J flag
• Upper Limit of Linearity (ULOL)

Quan flags do not apply to the following sample types: Cal Std, 
Chk Std, Matrix Blank, or Solvent.

This column is not included on the Calibration report.

This column is not included on the Method Validation, Method 
Detection Limit, or LCSLCSD reports.

Manual flags Indicates manually integrated peaks.  
• M indicates a manually integrated quan peak.
• m indicates a manually integrated confirming peak.
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Table 64.  Blank Report Active View values

Column Description

Retention Time Retention time for the quan mass. The time after injection at 
which the compound elutes. The total time that the compound 
is retained on the GC column. 

Quan Mass Mass range for the quan peak.

Response Sum of all Quan Peak Response values for the compound.

Inj Conc Calculated amount as the sample was injected, with no 
conversion applied.

Inj Units Injection units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

Sample Conc Calculated amount multiplied by the conversion factor.

Sample Units Sample units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

Table 66. High Density 1 and High Density 1 Long Report Active View values

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response The sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when not 
applicable.

Conc Calculated (injected) amount.

Table 67. High Density 2 and High Density 2 Long Report Active View values

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when 
not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.
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Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 1 Range Acceptable range for the confirming ion.

Table 68. High Density 3 and High Density 3 Long Report Active View values

Column Description

m/z Mass-to-charge ratio for the quan peak.

Total Response Sum of all Quan Peak Response values for the compound.

Quan Peak Response Response of the quan peak.

Quan Peak RT Retention time for the quan peak.

T Amount Theoretical amount of the compound. Reports N/A when 
not applicable.

Conc Calculated (injected) amount.

Confirming 1 Mass Mass of the confirming peak.

Confirming 1 Response Response of the confirming peak.

Confirming 1 Manual Flag Indicates a manually integrated confirming peak.

Confirming 1 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 1 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 1 Range Acceptable range for the confirming ion.

Confirming 2 Mass Mass of the confirming peak.

Confirming 2 Response Response of the confirming peak.

Confirming 2 Manual Flag Indicates a manually integrated confirming peak.

Confirming 2 Ion Ratio Flag Indicates that the ion ratio is out of range.

Confirming 2 Ion Ratio Actual ratio of the confirming ion response to the quan ion 
response.

Confirming 2 Range Acceptable range for the confirming ion.

Table 67. High Density 2 and High Density 2 Long Report Active View values

Column Description
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Table 69.  Internal Standard Report Active View values

Column Description

Std Response Average of the internal standard’s response as found in the 
calibration file.

Minimum Response Minimum response time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 127.

Maximum Response Maximum response time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 127.

Sample Response Area found in the sample.

Std RT Average retention time as found in the calibration file.

Min RT Minimum retention time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 127.

Max RT Maximum retention time as specified on the ISTD page in 
Method Development mode. See “ISTD” on page 127.

Sample RT Retention time found in the sample.

Table 70.  Ion Ratio Failure Report Active View values

Column Description

Quan Ion The ion for quan peak.

Qual Ion The ion for the confirming peak.

Quan Ion Response Response of the quan ion.

Qual Ion Response Response of the qual ion.

Ratio The ratio of the confirming ion response to the quan ion 
response.

Range The acceptable range.

Table 71.  LCSLCSD Report Active View values

Column Description

Spike Amount Lab control theoretical concentration.

LCS Concentration Lab control spike concentration.

LCS % Received Lab control concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See 
the Limits section in “Editing the QAQC Page” on 
page 117. 
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Upper Limit % Recovery upper limit as specified in the master method. See 
the Limits section in “Editing the QAQC Page” on 
page 117.

LCSD Concentration Lab control spike duplicate concentration

LCSD % Received Lab control duplicate concentration percentage

RPD Lab control relative percentage difference 

Max RPD Lab control spike maximum relative percentage difference 
(set in method)

Number of Rec Failures Number of recovery failures for lab control spike 
concentration and lab control spike concentration 
duplicate.

Number of RPD Failures Number of relative percentage difference failures for lab 
control spike concentration and lab control spike 
concentration duplicate.

Note  For LCSLCSD batch reports, the active view peak graphics are shown only when 
you click a field pertaining to a sample, such as LCS or LCSD concentration fields. 

Table 72. Manual Integration Report Active View values

Column Description

m/z Mass-to-charge ratio for the quan peak.

Method RT Apex retention time for the method-integrated peak.

Method Peak Height Height for the method-integrated peak.

Method Peak Area Area for the method-integrated peak.

Manual RT Apex retention time for the manually integrated peak.

Manual Peak Height Height of the manually integrated peak.

Manual Peak Area Area of the manually integrated peak.

Table 71.  LCSLCSD Report Active View values

Column Description
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Table 73.  Method Detection Limit Report Active View values

Column Description

Avg Conc The average of the concentration for the compound across 
all samples.

Std Dev The standard deviation of the concentration.

t-stat The t-statistic value defined as the ratio of a coefficient to its 
standard error. 

% RSD %RSD of concentrations

MDL Method detection limits. The calculated limit of detection.

Note  For Method Detection Limit batch reports, the active view peak graphics are shown 
only when you click a field pertaining to a sample. These numbered fields are to the right 
of the MDL column.

Table 74.  Method Validation Report Active View values

Column Description

Avg Conc The average of the concentration for the compound across 
all samples.

Theo Conc Values for each compound that represent the expected 
theoretical concentration of that compound in the sample 
as defined in the master method. See the Meth Val section 
in “Editing the QAQC Page” on page 117.

% Diff The percentage difference calculated as 
((MethodValidationMeanValue minus the Theo Conc) 
divided by the Theo Conc) multiplied by 100.

Min Conc Calculated by (Min recovery percent * Theo Conc) divided 
by 100.

Max Conc Calculated by (Max recovery percent * Theo Conc) divided 
by 100.

% RSD %RSD of concentrations

Max % RSD The maximum relative standard deviation (RSD) of the set 
of observed concentrations for a component across the set 
of method validation samples (when in average RF mode) as 
defined in the master method. See the Meth Val section in 
“Editing the QAQC Page” on page 117. 

Calculated Amount <Sample 
Name>

This field will be reproduced for every Method Val sample.
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Table 75.  MSMSD Report Active View values

Column Description

Unknown Concentration Concentration of the unknown sample.

Spike Amount Matrix spike theoretical concentration.

MS Concentration Matrix spike concentration.

MS % Received Matrix spike concentration percentage.

Lower Limit % Recovery lower limit as specified in the master method. See 
the Limits section in “Editing the QAQC Page” on 
page 117. 

Upper Limit % Recovery upper limit as specified in the master method. See 
the Limits section in “Editing the QAQC Page” on 
page 117.

MSD Concentration Matrix spike duplicate concentration.

MSD % Received Matrix spike duplicate concentration percentage.

RPD Matrix spike relative percentage difference.

Max RPD Maximum relative percentage difference as specified in the 
master method. See the Lab Control section in “Editing the 
QAQC Page” on page 117.

Number of Rec Failures Number of matrix spike and matrix spike duplicate failures.

Number of RPD Failures Number of relative percentage difference failures.

Note  For MSMSD batch reports, the active view peak graphics are shown only when you 
click a field pertaining to a sample, such as Unknown, MS, or MSD concentration fields. 

Table 76.  QC Report Active View values  (Sheet 1 of 2)

Column Description

Curve Type L - Linear 
A - Average RF 
Q - Quadratic

Daily RF The response factor value for Average RF curve types. For 
all other curve types, this column is blank.

Mean RF The average response factor as found in the calibration file. 
Displayed for Average RF curve types. For all other curve 
types, this column is blank.

Min RF Minimum QC response factor as found on the QC Check 
page in the method.
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RF % D Percent difference between daily and average response 
factor.

Max RF Diff (%) Maximum QC response factor as found on the QC Check 
page in the method.

QC Amount The amount defined by the level for the compound.

Calculated Amount Reportable amount of concentration.

Amount % Difference Percentage difference between the calculated amount and 
the QC amount. Use the injected concentration to calculate 
this value.

Max Amount % Difference Maximum allowed percentage difference between the 
calculated amount and the QC amount. 

Table 77.  Quantitation Report Active View values  (Sheet 1 of 2)

Column Description

RT Retention time for the peak. The time after injection at 
which the compound elutes. The total time that the 
compound is retained on the GC column. 

QIon Mass range for the quan peak.

Response Sum of all quan peak response values for the compound.

Injected Concentration 
(DE2999)

Calculated amount as the sample was injected, with no 
conversion applied. 

Note: As each additional sample is processed, calibration 
data changes; therefore, except for the final sample in a 
batch, a report in active view or report view will show 
different values from a physical (PDF, XML, or printed) 
report created at the end of processing. To avoid this 
discrepancy, do one of the following:

• For the standard Quantitation Report or Quantitation 
Report - 2, observe the active or report view for only 
the last sample in the batch.

• For the custom Quantitation Report, make the report a 
batch-level report.

Injected units Injection units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

Table 76.  QC Report Active View values  (Sheet 2 of 2)

Column Description
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Sample Conc Calculated injection amount multiplied by the conversion 
factor. Refer to the note in the Injected Concentration 
description.

Sample units Sample units specified on the Calibration page in Method 
Development mode. See “Calibration” on page 111.

Table 78.  Sample Report and Sample Report Long Active View values

Column Description

RT Retention time for the peak. The time after injection at 
which the compound elutes. The total time that the 
compound is retained on the GC column. 

Ion Mass The mass range for the ion.

Response The total response time (the sum of all quan peak response 
times for the compound).

Calibration Amount

Target Range

Ratio The ratio of the confirming ion response to the quan ion 
response.

Table 79. Solvent Blank Report Active View values

Column Description

RT Retention time for the quan peak. The time after injection at 
which the compound elutes. The total time that the compound 
is retained on the GC column. 

QIon Mass range for the quan peak.

Response Sum of all Quan Peak Response values for the compound.

Method Method of evaluation defined in the method.

Upper Limit Defined in the method.

Table 77.  Quantitation Report Active View values  (Sheet 2 of 2)

Column Description
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Working in the Local Method View
A local method is a copy of a master method associated with a batch. From the Local Method 
View, you can edit a local method or create a method template.

Follow these procedures:

• To open the Local Method View

• To create a method template

To open the Local Method View

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. From the Production navigation pane, click Local Method.

The Local Method View for the currently selected batch opens. Local methods are named 
BatchName_MasterMethodName.

You can edit many of the method parameters in a local method just as you would edit a 
master method. See “Editing a Master Method” on page 68.

3. Enter any local changes to the method.

4. Choose File > Save.

5. To process the batch or create new reports with the edited local method, return to the 
Batch View and submit the batch. 
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Figure 58. Local Method View page

To create a method template

1. Click Production from the dashboard or the navigation pane.

The Production navigation pane opens.

2. From the Production navigation pane, click Local Method.

The Local Method View for the currently selected batch opens. Local methods are named 
BatchName_MasterMethodName.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens. 

Beginning with Step 3, follow the instructions “To create a method template” on 
page 147. 
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Reports

This appendix contains information about standard and custom reports.

The report engine can generate several different types of reports designed to meet the needs of 
the laboratory, the laboratory's customers, and key regulatory agencies that might review the 
results. The following types of reports meet the requirements of various methods and 
worldwide regulatory agencies and are designed to help track the performance of the system 
and method. The EnviroLab Forms application can produce both standard reports and 
custom reports.

Specifying Reports
As an IT Administrator or Manager, you can configure a list of reports that are available for 
Method Development or Production modes. 

For detailed information about configuring reports in the Configuration mode, see 
“Specifying the Reports Configuration” on page 40.

For detailed information about specifying reports when you create a method in the Method 
Development mode, see “Editing the Reports Page” on page 138.

For detailed information about viewing batch reports in the Production mode, see “Working 
in Report View” on page 239.

Contents

• Specifying Reports

• Report Flags

• Sample Standard Reports
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Standard Reports

For each standard report you generate, you can create a hardcopy print, a PDF (.pdf ), or an 
XML (.xml) output format. In addition to the report type, you can specify a report title for 
each of your reports. The default report title is the report name.

The EnviroLab Forms application can generate the following types of standard reports:
• Batch Report 
• Blank Report 
• Breakdown Report 
• Calibration Report 
• Check Standard Report 
• Chromatogram Report 
• Compound Calibration Report 
• Confirmation Report 
• Confirmation Report  2
• High Density Internal Standard Report
• High Density Internal Standard Report Long
• High Density Sample Report 1 
• High Density Sample Report 1 Long
• High Density Sample Report 2 
• High Density Sample Report 2  Long 
• High Density Sample Report 3 
• High Density Sample Report 3  Long
• Internal Standard Summary Report 
• Ion Ratio Failure Report 
• LCSLCSD Report 
• Manual Integration Report 
• Method Detection Limit Report 
• Method Report 
• Method Validation Report
• MSMSD Report 
• Quantitation Report 
• Quantitation Report - 2
• Solvent Blank Report 
• Surrogate Recovery Report 
• TIC Report 
• TIC Summary Report 
• Tune Report

To view an example of each type of standard report, see “Sample Standard Reports” on 
page 266.

Example PDFs of standard report formats are also located in the following folder:

C:\Thermo\Shared\ExampleReports
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Custom Reports

For each custom report you generate, you can create a hardcopy printout or an XLS (.xlsm) 
output file. The default report title is the report name. 

A user in the role of IT Administrator or Manager can configure custom reports to generate a 
single report for an entire batch or to create separate reports for each sample. Rather than 
creating separate reports for each sample, this method uses data from only the last sample to 
create a single report for the entire batch.

The EnviroLab Forms application includes the following custom reports: 

• AltCalibrationReport
• BatchReport
• BlankReport 
• CalibrationDensityReport 
• CalibrationReport 
• CheckStandardReport 
• CompoundCalibrationReport 
• ConfirmationReport 
• ConfirmationReport2
• HighDensitySampleReport1Long
• HighDensitySampleReport2Long
• HighDensitySampleReport3Long 
• QuantitationReport
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Report Flags
When generating or viewing a report, you might see one of the following quantification or 
calibration flags listed on the page. 

A QAQC failure is identified by an asterisk (*), a shaded row, or the word Fail.

Table 80. Quantification flags

Flag Definition

b Compound was observed at a concentration in a Matrix Blank sample above the 
specified limit. 

s Compound was observed at a response in a solvent blank sample above the specified 
limit. 

J Compound was observed at a concentration above the limit of detection, but below 
the limit of quantitation. 

I or * Confirming/qualifying ion ratio for a compound was observed outside the target 
ratio range or the coelution between quantification and confirming/qualifying ion 
was larger than acceptable limit. 

C Compound was observed at a concentration above the specified carryover limit. 

? Compound was observed at a concentration above the specified linearity limit. 

D Compound was observed at a concentration below the specified limit of detection. 

Q Compound was observed at a concentration below the specified limit of 
quantitation. 

POS Compound was observed at a concentration above the specified cutoff. 

Table 81. Calibration flags

Flag Definition

D Calibration for this compound exceeded the specified maximum percent relative 
standard deviation (%RSD). 

F Response factor for this compound was below the specified minimum response 
factor (Min RF). 

R Calibration for this compound was below the specified minimum correlation 
coefficient (r2). 

A Back calculation of the calibration points for this compound exceeded the 
specified maximum percent difference (Max %D). 

X Calibration point for this compound was excluded from the overall calibration 
by manual selection. 

X(ISNF) Calibration point for this compound was excluded from the overall calibration 
because its associated internal standard was not found. 
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Values on a report that are the result of a manual integration will use an uppercase M to 
signify a manually integrated quantification ion and a lowercase m to signify a manually 
integrated qualifying/confirming ion. On alternative reports, manual integration are signified 
by a black box around the value. 
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Sample Standard Reports
This section shows samples of the following standard report types:

• Batch Report

• Blank Report

• Breakdown Report

• Calibration Report

• Check Standard Report

• Chromatogram Report

• Compound Calibration Report

• Confirmation Report

• Confirmation Report 2

• High Density Calibration Report

• High Density Internal Standard Report

• High Density Internal Standard Report Long

• High Density Sample Report 1

• High Density Sample Report 1 Long

• High Density Sample Report 2

• High Density Sample Report 2 Long

• High Density Sample Report 3

• High Density Sample Report 3 Long

• Internal Standard Summary Report

• Ion Ratio Failure Report

• LCSLCSD Report

• Manual Integration Report

• Method Detection Limit Report

• Method Report

• Method Validation Report

• MSMSD Report

• Quantitation Report

• Quantitation Report - 2

• Solvent Blank Report

• Surrogate Recovery Report

• TIC Report

• TIC Summary Report

• Tune Report

Tip  To easily view reports in landscape format, choose View > Rotate View > Clockwise 
from the Adobe Acrobat viewer menu.
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 A  Reports
Sample Standard Reports
Breakdown Report 
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A  Reports
Sample Standard Reports
Calibration Report 
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 A  Reports
Sample Standard Reports
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A  Reports
Sample Standard Reports
Check Standard Report 
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 A  Reports
Sample Standard Reports
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A  Reports
Sample Standard Reports
Chromatogram Report 
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 A  Reports
Sample Standard Reports
Compound Calibration Report 
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Sample Standard Reports
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 A  Reports
Sample Standard Reports
Confirmation Report 
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A  Reports
Sample Standard Reports
Confirmation Report 2
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 A  Reports
Sample Standard Reports
High Density Calibration Report
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 A  Reports
Sample Standard Reports
High Density Sample Report 2 Long
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A  Reports
Sample Standard Reports
High Density Sample Report 3 
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 A  Reports
Sample Standard Reports
High Density Sample Report 3 Long
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A  Reports
Sample Standard Reports
Internal Standard Summary Report
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 A  Reports
Sample Standard Reports
Ion Ratio Failure Report 
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A  Reports
Sample Standard Reports
LCSLCSD Report 
IMPORTANT  When the Sample ID is the same for an unknown sample and an LCS or LCSD sample, the unknown 
sample is included in the LCSLCSD report. The report information for the unknown sample displays as zeros.
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 A  Reports
Sample Standard Reports
Manual Integration Report 
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A  Reports
Sample Standard Reports
Method Detection Limit Report 
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 A  Reports
Sample Standard Reports
Quantitation Report 
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 A  Reports
Sample Standard Reports
Solvent Blank Report 
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Surrogate Recovery Report 
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 A  Reports
Sample Standard Reports
TIC Report
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A  Reports
Sample Standard Reports
TIC Summary Report
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 A  Reports
Sample Standard Reports
Tune Report
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B

Using Copy Down and Fill Down

This appendix describes the Copy Down and Fill Down commands that you can use to make 
entering column values easier.

You can use the Fill Down command for the Sample Name, Sample ID, Vial Position, and 
Sample Level columns.

You can use the Copy Down command for the Sample Type, Vial Position, Injection Volume, 
Conv Factor, and Sample Level columns.

Follow these procedures

• To automatically enter sequential column values

• To automatically copy column values

• To use Copy Down or Fill Down for a range of samples

To automatically enter sequential column values

1. Enter a value for the first row of the fill down sequence.

This does not have to be the first sample row. You can begin the fill down procedure from 
any row in the sequence.

2. Select the cell whose value is the first in the fill down sequence.

Observe that this cell is selected. 

Selected 

Not selected 

You can repeatedly use the Fill Down command to create multiple sequences. See 
“Example 1” on page 325.

3. Right-click and choose Fill Down from the shortcut menu.

The application enters sequential column values starting with the value in the selected 
row and ending with the last row in the column. 
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B  Using Copy Down and Fill Down
Note  If you use the Fill Down command for the Vial Position column and you have 
an autosampler configured, the EnviroLab Forms application knows the number of 
vial positions configured in your autosampler and numbers the positions accordingly. 
See “Example 2” on page 325.

To automatically copy column values

1. Select the cell whose value you want to copy to all cells below it.

Observe that this cell is selected. 

Selected 

Not selected 

2. Right-click and choose Copy Down from the shortcut menu.

The value is copied to all rows below the selected row. 

To use Copy Down or Fill Down for a range of samples

1. To select a range of sample values, do one of the following:

• Drag your cursor to select a contiguous group of sample values. 
 
–Or–

• Hold down the SHIFT key to select a contiguous group of sample values.

2. Right-click and choose the appropriate command from the shortcut menu.

The column values are copied or entered sequentially starting with the value in the first 
selected row and ending with the last selected row. 
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 B  Using Copy Down and Fill Down
Example 1

You can repeatedly use the Fill Down command to create multiple sequences.

Example 2

The EnviroLab Forms application knows the number of vial positions configured in your 
autosampler and numbers the positions accordingly.
Thermo Scientific EnviroLab Forms 3.0 User Guide        325





C

Using Filter Criteria

The filter criteria tool is available from the compound datastore in the Configuration mode 
and the acquisition list in the Method Development mode. 

To filter the compound list

1. To display only a filtered list of compounds, click the funnel icon, , in the column 
header.

For each column, a list of filterable criteria is displayed. On all columns, your filter choice 
are All, Blanks, and NonBlanks. Other filter criteria is specific to the individual columns.

2. To create a custom filter based on compound values in a specific column, choose Custom 
from the column list box.

The Enter Filter Criteria dialog box opens. See “Enter Filter Criteria” on page 328.

3. From the Operator list box, select an operator.

4. From the Operand list box, select an operand.

5. When all conditions are defined, click OK.

The complete filter string is displayed at the bottom of the dialog box. For example:

chemical formula = Blanks 
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C  Using Filter Criteria
Enter Filter Criteria
Enter Filter Criteria
The Enter Filter Criteria dialog box is specifically named for the column on which you are 
filtering. In this example, the selected column is the Compound Name column.

Figure 59. Enter Filter Criteria dialog box

Table 82. Enter Filter Criteria parameters

Parameter Description

And 
conditions

Requires that all filter criteria must be met.

Or 
conditions

Requires that any of the specified filter criteria be met.

Add a 
condition

Adds a new, empty condition to the filter criteria.

Delete 
condition

Deletes the selected condition. Click the box at the left of the row to select 
the condition.

Operator The mathematical function applied to the operand.

Operand The arguments to which the operator is applied.
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I

Index
Symbols
.csv, defined  2
.meth, defined  2
.pmd, defined  2
.raw, defined  2
.xml, defined  2
# background scans parameter  99
% Test parameter  116

A
Account Number parameter  21
Acquire a new raw data file parameter  59
Acquisition List page, Master Method View  77
Active parameter

Breakdown  125
Identification  82

Active View page  243
Add a condition parameter  328
Add a mass as new confirming ion command  109
Add Compound command  30
Add Folder parameter  32
Add Group command  137
Add this mass to existing quan mass ranges command  108
Add to CDS command  61
Add Transition Information command  30
Add user parameter  22
Amount parameter  111
And conditions parameter  328
Application Configuration view  35
Area noise factor parameter  101
Area scan window parameter  103
Area tail extension parameter  103
Assay type parameter

Batch Wizard  194
General page  75

Associate a Raw Data File dialog box  63
Associate a Raw Data File parameter  63
automated background subtraction options  72

Automatically create the master method parameter  58
Available Methods parameter  194
Available Templates parameter  194

B
background subtraction options  72
Background subtraction range option parameter  76
Baseline window parameter  101
Batch Level Report parameter  44
Batch view  171
batches

development batch  161
Production mode  171

Best match method parameter  153
Blank page, Master Method View  126
Breakdown method parameter, General page  75
Breakdown page, Master Method View  125
Breakdown sample type, defined  205

C
cal1-caln parameter  113
Calibration Curve page, Peak detection settings  223
Calibration Levels page, Master Method View  112
Calibration method parameter  153
Calibration page, Master Method View  111
Calibration page, QAQC page, Master Method View  119
calibration standard (Cal Std) sample type

definition  205
Cancel changes parameter  22
Carryover limit parameter  118
CAS No parameter  82
Category parameter

Acquisition List  79
Compound datastore  33

caution flags  210
check standard (Chk Std) sample

definition  205
Chemical Formula parameter
Thermo Scientific EnviroLab Forms 3.0 User Guide          329



Index: C
Acquisition List  79
Compound datastore  33

Chk Std page, Master Method View  120
Chromatogram Intensity Scale parameter  39
Collision Energy parameter, precursor

Acquisition List  80
Compound datastore  34

color coding, Compound Datastore  34
comma separated values, defined  2
commands

Add a mass as new confirming ion  109
Add Compound  30
Add Group  137
Add this mass to existing quan mass ranges  108
Add to CDS  61
Add Transition Information  30
Configuration  14
Continue to Method  62
Copy down  323
Delete compound from method

Blank page  127
Calibration page  119
ISTD page  128
Lab Control page  122
Limits page  118
Matrix Spike page  132
Meth Val page  124
QC Check page  120
Solvent Blank page  129
Surrogate page  130

Display retention time column
Blank page  127
Calibration page  119
ISTD page  128
Lab Control page  122
Limits page  118
Matrix Spike page  132
Meth Val page  124
QC Check page  120
Solvent Blank page  129
Surrogate page  130

Enable User Security  36
Exit EnviroLab Forms  9
Fill down  323
Help, dashboard  14
Import Compounds  29
Load Compound Datastore  29
Log Off  14
Methods  14
New Compound Datastore  29
Production  14
Real Time Status  14
Reset scaling  109

Save As Compound Datastore  31
Save Compound Datastore  31
Set this mass as a new quan peak  109
Set this mass as quan mass  108
Update confirming ion ratios with this spectrum  108

Compound Datastore
administration  28
color coding  34

Compound Datastore selection parameter  39
Compound Datastore view  28
compound flags  215
Compound Name parameter

Acquisition List  79
Compound datastore  33

Compound parameter
Calibration  111
Calibration levels  113
Calibration page  119
Identification  82
ISTD page  127
Lab Control page  121
Limits page  117
Matrix Blank page  126
Matrix Spike page  131
Meth Val page  123
QC Check page  120
QC levels  116
Solvent Blank page  129
Surrogate page  130

Compound type parameter
Calibration  111
Identification  82

compound types
internal standards  81
non quan  81
quan  81
surrogates  81
target  81

Compounds for group parameter  125
Compounds page, Master Method View  77
Compounds parameter

Save Compound Datastore dialog box  32
Compounds That are Missing Quans dialog box  31
Configuration command  14
Configuration navigation pane  16
Confirming Ions page, Peak detection settings  225
Confirming n Ion Ratio Flag parameter  246
Confirming n Ion Ratio parameter  246
Confirming n Manual Flag parameter  246
Confirming n Mass parameter  246
Confirming n Range parameter  246
Confirming n Response parameter  246
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Index: D
Constrain peak width parameter
Genesis  97
ICIS  101

Continue to Method command  62
Copy down command  323
Correct surrogates parameter  146
Create Master Method dialog box  52
Create method parameter  48
Create PDF parameter

Batch Template Editor  191
standard reports  141

Create tune report as PDF parameter  135
Create XLS parameter  141
Create XML parameter  191

Batch Template Editor  191
standard reports  141

Curve type parameter
Calibration  111
Method Template Editor  153

custom reports, list of  5
CV Test (%) parameter  128

D
dashboard parameters  14
Data Review view  207
Decimal places to be reported parameter  145
Default parameter  32
Delete compound from method command

Blank page  127
Calibration page  119
ISTD page  128
Lab Control page  122
Limits page  118
Matrix Spike page  132
Meth Val page  124
QC Check page  120
Solvent Blank page  129
Surrogate page  130

Delete condition parameter  328
Detection method parameter

Genesis  97
ICIS  101

Detection page, Master Method View  83
Detector parameter, Detection  94
Development Batch view  161
dialog boxes

Add Library  11
Associate a Raw Data File  63
Compounds That are Missing Quans  31
Create Master Method  52
Edit Compound Dependent Parameters  61
Import an Xcalibur Method  60

Open Chromatograph Reference Sample  73
Open Compound Datastore  29
Save Compound Datastore  32
Select Compound Datastore  36
Select Compounds to Add  66
Thermo Library Manager  11
Thermo Xcalibur Instrument Setup  71
Thermo Xcalibur Roadmap  10

Display Mass Precision parameter  39
Display Quan flags and legend parameter  145
Display retention time column command

Blank page  127
Calibration page  119
ISTD page  128
Lab Control page  122
Limits page  118
Matrix Spike page  132
Meth Val page  124
QC Check page  120
Solvent Blank page  129
Surrogate page  130

Display valid compounds only parameter  145
Displayed Reports parameter (custom)  45
Displayed Reports parameter (standard)  42

E
Edit Compound Dependent Parameters dialog box  61
Edit user parameter  22
Email Address parameter  21
Enable peak threshold parameter  153
Enable tune time tracking parameter  146
Enable User Security command  36
Enable valley detection parameter  97
Enabled parameter  21
Energy Ramp parameter

Acquisition List  80
Compound datastore  34

Example parameter  141
Exclude matching quan peaks parameter  155
Exit EnviroLab Forms command  9
Expected RT parameter, Detection  93
Expected width parameter  97
Export SRM data parameter  49
Extend Calibrations parameter  204

F
feature summary  3
File Name parameter

Save Compound Datastore dialog box  32
file types, supported  2
Fill down command  323
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Index: G
Filter parameter, Detection  94
Flag values above Carryover parameter  145
Flag values above LOR parameter  145
Flag values above ULOL parameter  145
Flag values below LOD parameter  145
Flag values below LOQ parameter  145
Flag values between LOD and LOQ parameter  145
Full name parameter  21

G
General page

Background subtraction range option  76
Breakdown method parameter  75
editing  70
Injection volume parameter  75
Instrument method parameter  75
Ion range calc method parameter  75
Number of scans to subtract parameter  76
Qualitative peak processing template parameter  75
Set chromatogram reference sample parameter  76
Set Reference sample parameter  76
Stepoff value parameter  76

General page, Master Method View  70
Groups page, Master Method View  136
Groups parameter, Breakdown page  125

H
Help command, dashboard  14

I
Identification page, Master Method View  81
Import an Xcalibur Method dialog box  60
Import Compounds command  29
Import parameter (custom)  46
Import parameter (standard)  43
Import Xcalibur Processing Method parameter  60
Include compound peak spectrum as reference spectrum 
parameter  153

Include confirming ions parameter  153
Injection amount parameter  59
Injection concentration parameter  246
Injection Units parameter  246
Injection volume parameter  75
Installed Reports parameter (custom)  45
Installed Reports parameter (standard)  42
installing

EnviroLab Forms  8
NIST and QED libraries  10

Instrument method parameter

General page  75
Method Forge  59

Instrument Name parameter  39
Instrument view  157
instruments, supported  vii
Ion Overlay page  228
Ion Overlay page, Peak detection settings  228
Ion range calc method parameter  75
Ionization parameter

Acquisition List  79
Compound datastore  33

ISTD matching (+/- min) parameter  155
ISTD page, Master Method View  127
ISTD parameter  111
IT Administrator role  23

L
lab control (LCS) sample type, defined  205
lab control duplicate (LCSD) sample type, defined  205
Lab Control page, Master Method View  121
Lab name parameter  75
Laboratory Name parameter  39
Lens parameter

Acquisition List  80
Compound datastore  34

Level parameter  116
Limit library hits parameter  153
Limit the retention time range parameter  153
Limits page, Master Method View  117
Load Compound Datastore command  29
Local Method view  258
LOD (Detection limit) parameter  118
Log Off command  14
logging on to EnviroLab Forms  8
Login parameter  9
logon screen  9
LOQ (Quantitation limit) parameter  118
LOR (Reporting limit) parameter  118

M
m/z parameter, Detection  95
Manager role  23
Manual Flags parameter  245
Manual injection parameter  59
Master Method View

Acquisition List page  77
Blank page  126
Breakdown page  125
Calibration Levels page  112
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Calibration page  111
Chk Std page  120
Compounds page  77
Detection page  83
General page  70
Groups page  136
Identification page  81
ISTD page  127
Lab Control page  121
Limits page  117
Matrix Spike page  131
Meth Val page  123
QAQC page  117
QAQC page, Calibration page  119
QC Levels page  114
Ratios page  109
Reports page  138
Solvent Blank page  129
Spectrum page  104
Surrogate page  130
Tune page  132

Matrix Blank sample type, defined  205
Matrix Spike page, Master Method View  131
Max % breakdown parameter  125
Max Amt Diff (%) parameter  119
Max Conc parameter  127
Max recovery (%) parameter

ISTD page  128
Lab Control page  121
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Max RF Diff (%) parameter  120
Max RPD parameter

Lab Control page  121
Matrix Spike page  131

Max RSD (%) parameter
Calibration page  119
Meth Val page  123

Max RT (+min) parameter, ISTD page  128
Max stepoff parameter  135
MDL (method detection limits) sample type, defined  205
Meth Val (method validation) sample type, defined  205
Meth Val page, Master Method View  123
Method parameter

Matrix Blank page  127
Solvent Blank page  129

Method Template Editor  152
Method view  51
methods

importing Xcalibur  60
instrument  157

local  258
master  50
Method Template Editor  152

Methods command  14
Min peak height (S/N) parameter

Genesis  98
ICIS  102

Min peak width parameter  102
Min recovery (%) parameter

ISTD page  128
Lab Control page  121
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Min RT (-min) parameter  128
modes

choosing  13
defined  14

Modify Calibrations or Active Compounds by Group 
parameter  201

MS (matrix spike) sample type, defined  205
MSD (matrix spike duplicate) sample type, defined  205
Multiplet resolution parameter  102

N
Name the master method parameter  58
New Compound Datastore command  29
New instrument method parameter  49
New sample list parameter  49
NIST library, installing  10
Noise method parameter  102
Number of Scans to Subtract parameter  72
Number of scans to subtract parameter  76

O
Only select top peaks parameter  153
Open Chromatograph Reference Sample dialog box  73
Open Compound Datastore dialog box  29
Open instrument method parameter  49
Open method parameter  48
Open Qual Browser parameter  49
Operand parameter  328
Operator parameter  328
Or conditions parameter  328
Origin parameter

Calibration  111
Method Template Editor  154

Overwrite parameter  59
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P
parameters

# background scans  99
% Test  116
Account Number  21
Acquire a new raw data file  59
Active

Breakdown  125
Identification  82

Add a condition  328
Add user  22
Amount  111
And conditions  328
Area noise factor  101
Area scan window  103
Area tail extension  103
Assay type

Batch Wizard  194
General page  75

Associate a Raw Data File  63
Automatically create the master method  58
Available Methods  194
Available Templates  194
Background subtraction range option  76
Baseline window  101
Batch Level Report  44
Best match method  153
Breakdown method, General page  75
cal1-caln  113
Calibration method  153
Cancel changes  22
Carryover limit  118
CAS No  82
Category

Acquisition List  79
Compound datastore  33

Chemical Formula
Acquisition List  79
Compound datastore  33

Chromatogram Intensity Scale  39
Collision Energy, precursor

Acquisition List  80
Compound datastore  34

Compound
Calibration  111
Calibration levels  113
Calibration page  119
Identification  82
ISTD page  127
Lab Control page  121
Limits page  117
Matrix Blank page  126
Matrix Spike page  131

Meth Val page  123
QC Check page  120
QC levels  116
Solvent Blank page  129
Surrogate page  130

Compound Datastore selection  39
Compound Name

Acquisition List  79
Compound datastore  33

Compound type
Calibration  111
Identification  82

Compounds for group  125
Confirming n Ion Ratio  246
Confirming n Ion Ratio Flag  246
Confirming n Manual Flag  246
Confirming n Mass  246
Confirming n Range  246
Confirming n Response  246
Constrain peak width

Genesis  97
ICIS  101

Correct surrogates  146
Create method  48
Create PDF

Batch Template Editor  191
standard reports  141

Create tune report as PDF  135
Create XLS  141
Create XML  191

Batch Template Editor  191
standard reports  141

Curve type
Calibration  111
Method Template Editor  153

CV Test (%)  128
dashboard  14
Decimal places to be reported  145
Delete condition  328
Detection method

Genesis  97
ICIS  101

Detector, Detection  94
Display Mass Precision  39
Display Quan flags and legend  145
Display valid compounds only  145
Displayed Reports (custom)  45
Displayed Reports (standard)  42
Edit user  22
Email Address  21
Enable peak threshold  153
Enable tune time tracking  146
Enable valley detection  97
Enabled  21
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Energy Ramp
Acquisition List  80
Compound datastore  34

Example  141
Exclude matching quan peaks  155
Expected RT, Detection  93
Expected width  97
Export SRM data  49
Extend Calibrations  204
Filter, Detection  94
Flag values above Carryover  145
Flag values above LOR  145
Flag values above ULOL  145
Flag values below LOD  145
Flag values below LOQ  145
Flag values between LOD and LOQ  145
Full name  21
Groups, Breakdown page  125
Import (custom)  46
Import (standard)  43
Import Xcalibur Processing Method  60
Include compound peak spectrum as reference spectrum  

153
Include confirming ions  153
Injection amount  59
Injection concentration  246
Injection Units  246
Injection volume  75
Installed Reports (custom)  45
Installed Reports (standard)  42
Instrument method

General page  75
Method Forge  59

Instrument Name  39
Ion range calc method  75
Ionization

Acquisition List  79
Compound datastore  33

ISTD  111
ISTD matching (+/- min)  155
Lab name  75
Laboratory Name  39
Lens

Acquisition List  80
Compound datastore  34

Level  116
Limit library hits  153
Limit the retention time range  153
LOD (Detection limit)  118
Login  9
LOQ (Quantitation limit)  118
LOR (Reporting limit)  118
m/z, Detection  95
Manual Flags  245
Manual injection  59

Max % breakdown  125
Max Amt Diff (%)  119
Max Conc  127
Max recovery (%)

ISTD page  128
Lab Control page  121
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Max RF Diff (%)  120
Max RPD

Lab Control page  121
Matrix Spike page  131

Max RSD (%)
Calibration page  119
Meth Val page  123

Max RT (+min), ISTD page  128
Max stepoff  135
Method

Matrix Blank page  127
Solvent Blank page  129

Min peak height (S/N)
Genesis  98
ICIS  102

Min peak width  102
Min recovery (%)

ISTD page  128
Lab Control page  121
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Min RT (-min)  128
Modify Calibrations or Active Compounds by Group  201
Multiplet resolution  102
Name the master method  58
New instrument method  49
New sample list  49
Noise method  102
Number of Scans to Subtract  72
Number of scans to subtract  76
Only select top peaks  153
Open instrument method  49
Open method  48
Open Qual Browser  49
Operand  328
Operator  328
Or conditions  328
Origin

Calibration  111
Method Template Editor  154

Overwrite  59
Password

logon screen  9
user administration  21

Path  59
Thermo Scientific EnviroLab Forms 3.0 User Guide         335



Index: P
Peak height (%)
Genesis  98
ICIS  102

Peak noise factor  101
Peak S/N cutoff  98
Percentage  127
Perform background subtraction  135
Phone Number  21
Polarity

Acquisition List  80
Compound datastore  34

Precursor Mass
Acquisition List  80
Compound datastore  34

Print
Batch Template Editor  191
custom reports  141
standard reports  141

Product Mass
Acquisition List  80
Compound datastore  34

QAQC Flags  245
QC1-QCn  116
QIon  246
Qualitative peak processing template  75
Quan Flags  245
Quan mass  246
Quan peak m/z  245
Quan peak response  245
Quan peak RT  246
Quick mode  194
R^2 threshold  119
Ranges

Detection  95
Raw filename  59
Recent Files (master methods)  49
Reference compound  82
Remove user  22
Report concentration  145
Report Name

Batch Template Editor  191
custom reports  141
standard reports  141

Report noise as  99
Report Title

standard reports  141
Response  246
Response via

Calibration  111
Method Template Editor  154

Retention Time  246
RMS  103
Role  21
RT

Acquisition List  80
Calibration  111
Calibration levels  113
Calibration page  119
Compound datastore  34
Identification  82
ISTD page  127
Lab Control page  121
Limits page  117
Matrix Blank page  126
Matrix Spike page  131
Meth Val page  123
QC Check page  120
QC levels page  116
Solvent Blank page  129
Surrogate page  130

S/N threshold  97
Sample comment  59
Sample Concentration  246
Sample file  244
Sample Units  246
Save changes  22
Select a custom template  58
Select a report  244
Select batch location  49
Select Compounds from CDS  66
Select file and mass spectrum  135
Sensitivity

Genesis  97
ICIS  101

sensitivity  153
Separate ion overlay display  145
Set Chromatogram Reference Sample  73
Set chromatogram reference sample  76
Set Reference sample  76
Shade row when sample is outside of evaluation criteria  

145
Show chromatogram on Quantitation Report  145
Showing  244
Smoothing

Genesis  97
ICIS  101

Specify default ion ratio ranges  153
Standard type  111
Starting vial number  194
Status  245
Stepoff value  76
Tailing factor

Genesis  98
ICIS  102

Technology selection  38
Template Layout  194
Theo Conc

Lab Control page  121
336         EnviroLab Forms 3.0 User Guide  Thermo Scientific



Index: Q
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Theoretical amount  246
Total batch rows  194
Total response  245
Trace, Detection  94
Tune Compound  135
Tune file lifetime  146
ULOL (Linearity limit)  118
Units  111
Upper Limit  129
Use alternate calibration report format  145
Use an existing raw data file  59
Use as RT Reference  82
Use autosampler  59
Use Method Forge  52
Use only selected method  135
Use the default template  58
Use these libraries  153
User Security  38
Username  9, 21
Valley rise (%)  99
Valley S/N  99
Vial position  59
View width, Detection  93
Weighting

Calibration  111
Method Template Editor  154

Window
Acquisition List  80
Compound datastore  34
Detection  93

password
administrator  8

Password parameter
logon screen  9
user administration  21

Path parameter  59
Peak detection settings

Calibration Curve page  223
Confirming Ions page  225
Ion Overlay page  228
Spectra page  224

Peak height (%) parameter
Genesis  98
ICIS  102

Peak noise factor parameter  101
Peak S/N cutoff parameter  98
Percentage parameter  127
Perform background subtraction parameter  135
Phone Number parameter  21
Polarity parameter

Acquisition List  80

Compound datastore  34
Precursor Mass parameter

Acquisition List  80
Compound datastore  34

Print parameter
Batch Template Editor  191
custom reports  141
standard reports  141

Product Mass parameter
Acquisition List  80
Compound datastore  34

Production command  14
Project Administration view  26
projects and subprojects, creating  26

Q
QAQC Flags parameter  245
QAQC page

Master Method View  117
QAQC role  25
QC Levels page, Master Method View  114
QC1-QCn parameter  116
QED library, installing  10
QIon parameter  246
Qual Mode  207
Qualitative peak processing template parameter  75
Quan Flags parameter  245
Quan mass parameter  246
Quan Mode  207
Quan peak m/z parameter  245
Quan peak response parameter  245
Quan peak RT parameter  246
Quick mode parameter  194

R
R^2 threshold parameter  119
Ranges parameter

Detection  95
Ratios page, Master Method View  109
Raw filename parameter  59
Real Time Status command  14
real-time display  183
Recent Files parameter (master methods)  49
Reference compound parameter  82
reference spectra  237
Remove user parameter  22
Report concentration parameter  145
report flag options, specifying  142
report formats, specifying  138
Report Name parameter
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Batch Template Editor  191
custom reports  141
standard reports  141

Report noise as parameter  99
Report Title parameter

standard reports  141
Report View  239
reports

configuring  40
flags defined  264
listed  4
Production mode  239
sample PDFs  266
viewing landscape in PDF  266

Reports page
editing  138

Reports page, Master Method View  138
Reset scaling command  109
Response parameter  246
Response via parameter

Calibration  111
Method Template Editor  154

Retention Time parameter  246
RMS parameter  103
Role parameter  21
RT parameter

Acquisition List  80
Calibration  111
Calibration levels  113
Calibration page  119
Compound datastore  34
Identification  82
ISTD page  127
Lab Control page  121
Limits page  117
Matrix Blank page  126
Matrix Spike page  131
Meth Val page  123
QC Check page  120
QC levels page  116
Solvent Blank page  129
Surrogate page  130

S
S/N threshold parameter  97
Sample comment parameter  59
Sample Concentration parameter  246
Sample file parameter  244
sample types. defined  205
Sample Units parameter  246
Save As Compound Datastore command  31

Save changes parameter  22
Save Compound Datastore command  31
Save Compound Datastore dialog box  32
Select a custom template parameter  58
Select a report parameter  244
Select batch location parameter  49
Select Compound Datastore dialog box  36
Select Compounds from CDS parameter  66
Select Compounds to Add dialog box  66
Select file and mass spectrum parameter  135
Sensitivity parameter

Genesis  97
ICIS  101

sensitivity parameter  153
Separate ion overlay display parameter  145
Set Chromatogram Reference Sample parameter  73
Set chromatogram reference sample parameter  76
Set Reference sample parameter  76
Set this mass as a new quan peak command  109
Set this mass as quan mass command  108
Shade row when sample is outside of evaluation criteria 
parameter  145

Show chromatogram on Quantitation Report parameter  145
Showing parameter  244
Smoothing parameter

Genesis  97
ICIS  101

Solvent Blank page, Master Method View  129
Solvent sample type, defined  206
Specify default ion ratio ranges parameter  153
Spectra page  224
Spectra page, Peak detection settings  224
Spectrum page, Master Method View  104
SRM data, exporting  156
standard reports

listed  4
Standard type parameter  111
starting EnviroLab Forms  8
Starting vial number parameter  194
Status indicators  209
Status parameter  245
Stepoff value parameter  76
Supervisor role  24
supported file types, defined  2
supported software and hardware  vii
Surrogate page, Master Method View  130
system requirements  vii

T
Tailing factor parameter
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Genesis  98
ICIS  102

Technician role  24
Technology selection parameter  38
Template Layout parameter  194
templates

method  147
Theo Conc parameter

Lab Control page  121
Matrix Spike page  131
Meth Val page  123
Surrogate page  130

Theoretical amount parameter  246
Thermo Xcalibur Instrument Setup dialog box  71
Total batch rows parameter  194
Total response parameter  245
Trace parameter, Detection  94
Tune Compound parameter  135
Tune file lifetime parameter  146
Tune page, Master Method View  132
Tune sample type, defined  205
Tune/Breakdown sample type, defined  205

U
ULOL (Linearity limit) parameter  118
Units parameter  111
Unknown sample type, defined  206
Unknown/TIC sample type, defined  206
Update confirming ion ratios with this spectrum command  
108

Upper Limit parameter  129
Use alternate calibration report format parameter  145
Use an existing raw data file parameter  59
Use as RT Reference parameter  82
Use autosampler parameter  59
Use Method Forge parameter  52
Use only selected method parameter  135
Use the default template parameter  58
Use these libraries parameter  153
user accounts, creating  18
User Administration view  18
user roles and permissions  23
user roles, defined  23
User Security parameter  38
Username parameter  9, 21

V
Valley rise (%) parameter  99
Valley S/N parameter  99

Vial position parameter  59
View width parameter, Detection  93
views

Application Configuration  35
Batch  171
Compound Datastore  28
Data Review  207
Development Batch  161
Instrument  157
Local Method  258
Method  51
Project Administration  26
Report View  239
User Administration  18

W
Weighting parameter

Calibration  111
Method Template Editor  154

Window parameter
Acquisition List  80
Compound datastore  34
Detection  93

workflow
general  7
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